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Software License Agreement

Below you will find set out the conditions of the agreement for the use of Euro-Systems

Software by you, the end-user (hereinafter also called the Licensee). This legal document

is a legally valid contract between you, the end-user, and Euro-Systems S.à

r.l. (hereinafter also called the Licensor). With the installation, the first use or by opening

the disk package, you are agreeing to become bound by the terms of this agreement.

Therefore, please read the following text carefully and in full. If you do not agree to the

terms of this agreement, do not use the software open the disk package, promptly return

the unopened disk package and the other items (including all written documentations, ring

binders, if applicable dongle / copy protection or any other boxes) of the purchased

product to the place where you purchased them.

SINGLE USER / MAIN LICENSE - SECOND USER LICENSE(S) - ADDITONAL LICENSE

- DEMO LICENSE - TEST LICENSE - SCHOOL LICENSE / MULTI USER - COMPANY

LICENSE - ENTERPRISE LICENSE - SUBSCRIPTION LICENCE

1. Scope of the License Agreement

The agreement applies to computer programs and files stored on data carriers, computer

programs and files made available online, by data transfer or by installation on the

computer of the Licensee, the program description and operating instructions and any

other related written material and hardware, hereinafter also called Software. The Licensor

is entitled to implement program-internal protection measures into the software in order to

secure his protective rights. This also applies to future updates / upgrades of the program

provided to the Licensee. The Licensor points out that the present level of technology does

not allow computer software to be produced in such a way that it works perfectly in all

applications and combinations. Thus, the agreement is only applicable to software which is

basically usable in accordance with the program description and the user operating

instructions.

2. Granting of License

Important Note: If the copy protection (Dongle) gets lost, the license also expires!

Single User / Main License

The Licensor grants you the right to use the copy of the Software on only one terminal
connected to a single computer. It is prohibited to network the software beyond the scope

of the software. You are not allowed to use the Software on more than one computer or
computer terminal in any way or at any time whatsoever unless the Licensee additionally

possesses so called Second-User Licenses or Additional Licenses.

Second User License

A Second-User License as well is only valid in combination with a Single-User or Main
License. It is protected in the same way as the Single User / Main License. The functions

of a Second-User License are the same as those of a Main License. A maximum of two

additional Second User Licenses may be acquired for each Single User / Main License. If

more than three licenses are required in a multi user environment, it is first of all necessary

to acquire a further Single User / Main License. This license can then be used to acquire
two more Second User Licenses. Beyond - extra licenses are to be agreed individually and

in writing with the Licensor.
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Additional License
An Additional License authorizes the Licensee to use the copy of the software provided by

the Licensor on an additional computer. It is copy-protected in the same way as the Single

User / Main License. The functional scope of an Additional License is identical to that of a

Main License.

Demo License

The Demo License authorizes the Licensee to test the software in its scope of functions

(functionally partly limited), in particular to check whether the user value expected by the

Licensee can be achieved with the software and / or compatibility with its current computer

system. It is expressly forbidden to use the Software for commercial purposes, to transmit

it to third parties or to copy it without explicit written consent of the Licensor.

Test License

The Test License authorizes the Licensee to test the software in its scope of functions

(limited in time), in particular to check whether the user value expected by the Licensee

can be achieved with the software and / or compatibility with its current computer system.

Redistribution or reproduction without the express written permission of the licensor is

prohibited. The trial period begins with the creation of the trial license. The licensor

reserves the right to deactivate the test license in case of misuse, with the consequence

that the software can no longer be used.

School License / Multi User License

A School License consists out of a Main License for one teacher workplace and a so

called Multi User license for student's workplaces. The Multi User license is a functionally

restricted version of the software. Usage is allowed on multiple workplaces / computers in

the offices of the Single User / Main Licensee.

Company License

The Company License authorizes the Licensee to use a copy of the software provided by

the Licensor on several computers and / or multiple output devices on a company site. The

number of licenses must be agreed individually and in writing with the Licensor. If a

company has several locations, the Company License must be purchased separately for

each location. The Licensee is not allowed to transfer the licenses of one location to

another. If a company has several locations, an Enterprise License must be obtained

Enterprise License

The Enterprise License authorizes the Licensee to use the copy of the software provided
by the Licensor on several computers and / or multiple output devices at multiple company

locations. The number of licenses must be agreed in writing with the Licensor.

Subscription License

Euro-Systems S.à r.l. authorizes RCS Systemsteuerungen GmbH to distribute subscription
licenses. Euro-Systems grants the licensee a time-limited, simple, non-transferable right to

use the software for the intended use against payment of the remuneration to RCS

Systemsteuerungen GmbH or an authorized seller. The licensee has the right to use the

provided copy of the software on a single terminal connected to a single computer. You

may not network the Software beyond the scope provided in the Software. You may not
use the Software in any other manner at any time on more than one computer or computer
terminal unless Licensee has so-called Additional Licenses.

Software License Agreement
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3. Copyright
The Software is the property of the Licensor and is protected against copying by laws on

copyright, international agreements and other national regulations. If the Software does

not have a device to protect it from being copied you may either make one copy as backup

or for your records or copy it to a hard disk as long as the original copy is to be stored

exclusively as backup or for your records. You are not permitted to delete the reference to

copyright in the Software or the registration or serial code or dongle numbers. It is

expressly forbidden to copy the Software and the written material such as manuals either

in full or in part or to reproduce them in any way.

4. Special Restrictions

As Licensee you are not permitted

* to transfer, assign, rent, lease or otherwise dispose of the Software or related material to

a third party without the prior written consent of the Licensor. But you are allowed to

permanently assign the rights from this License Agreement to another person, provided

that you transfer the License Agreement together with all copies of the Software and the

accompanying hardware and the recipient consents to be bound by the terms of the

agreement. The transfer must include the latest update and all earlier versions and the

Licensor must be notified in writing.

* to transfer subscription licenses to a third party

* to modify, translate, reverse engineer decompile or disassemble the Software without the

prior written consent of the Licensor.

* to create derivative works based on the Software or reproduce the written material.

* to translate or modify the written material or produce derivative material.

5. Ownership of Rights

With the purchase of the product you only possess the physical data carrier on which the
Software is recorded or fixed. A purchase of rights of the Software is not connected with

it. In particular, the Licensor reserves all rights to publish, copy, edit and exploit the
Software.

6. Duration of the Contract

This License is effective indefinitely. This license will terminate automatically without notice

from EUROSYSTEMS if you fail to comply with any provision of the License. Upon

termination you are obliged to destroy the original data carriers as well as all copies of the

Software, modified copies including the written materials. You must return the hardware

and dongle to the manufacturer.

In the case of subscription licenses, the term is limited to the period specified when the

contract is concluded. The subscription license is automatically extended if the contract is

not terminated by the licensee in due time.

7. Damages for Non-Compliance with the Agreement
The Licensor points out that you are liable for any damage resulting from breach of
copyright incurred by the Licensor on account of your non-compliance with the terms of

this agreement.

Software License Agreement
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8. Modifications and Updates
The Licensor may create updated versions of the Software at its own discretion. The

Licensor is not bound to make such updates available to Licensees who have not properly

registered the Software by registration card or online form or have not paid the update fee.

For subscription licenses, software updates are provided throughout the subscription

period - subject to payment of the subscription fee.

9. Limited Warranty and Disclaimer of Warranty

The Licensor assumes no liability for the Software being free of errors. In particular, the

Licensor does not warrant that the Software will meet the requirements and purposes of

the licensee or will work together with other programs selected by the acquirer. The

responsibility for the correct selection and the consequences of the use of the software as

well as the results intended or achieved with it is borne by the acquirer. The same applies

to the written material accompanying the software. If the software is not fundamentally

usable, the acquirer has the right to cancel the contract.

The Licensor is not liable for damage unless the damage was caused deliberately or

through gross negligence on the part of the Licensor. Any liability for gross negligence

towards dealers is excluded. Liability due to properties maybe warranted by the

Licensor remains unaffected. Liability for consequential harms caused by a defect that is

not included in the warranty is excluded.

10. Traders

If the Licensee is a trader, this agreement shall be subject to the law of Luxembourg and

the jurisdiction of national and federal courts located in Luxembourg.

11. Data Transmission

* 1: The Licensee authorizes the Licensor to store and process his customer data

communicated in connection with the business relationship.

* 2: The Licensee agrees to the transfer of software data to the Licensor for the protection
of legitimate interests, such as to ensure copy protection, license verification and the

provision of Live Update functionality.

* 3: The Licensee agrees that any data sent by the Software online to the Licensor for the

provision of online services (online support, driver download, license purchase, provision

of production macros, and the like) shall be stored and processed from the Licensor.

* 4: The Licensee agrees that data that serves the needs-based development of the

Software are transmitted to the Licensor and stored and processed by him.

* 5: The Licensee agrees that data will be sent to the Software to inform the Licensee

about updates / upgrades, product news and important support information.

LIMITED WARRANTY

* Limited Warranty - The Licensor guarantees that the Software functions largely in
accordance with the accompanying product manual for a period of 90 days from receipt.

Software License Agreement
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This guarantee is given by the Licensor in its capacity as producer; it does not replace or
restrict any possible legal claims regarding warranty or liability which may be made on the

distributor from whom you purchased your copy of the Software.

* Customer's Rights - The Licensor's entire liability and your sole right consists in a refund

of the price paid or the repair or replacement of the Software which is inadequate under

the terms of the Licensor's' limited warranty and which has been returned to the

Licensor together with a copy of the invoice. This limited warranty does not apply when the

non-functioning of the Software or hardware is due to an accident, improper use or

incorrect application.

* No Further Guarantee - The Licensor excludes any further warranty for the Software,

accompanying manuals and written materials or the accompanying hardware.

* No Liability for Consequential Damage - Neither the Licensor nor the distributors of the

Licensor are liable for any damages (unlimited included are damages for loss of business

profits, business interruption, loss of

business information or data or from other financial loss) arising out of the use or inability

to use such product even if the Licensor has been advised of the possibility of such

damage. The Licensor is not liable for damages, as far as the Licensee could have

prevented their occurrence by means of reasonable measures - in particular program and

data backup. In any case the Licensor's liability is confined to the amount actually paid for

the product. This disclaimer does not apply to damage caused deliberately or by gross

negligence on the part of the Licensor. Neither does it affect any rights based on legal

regulations concerning product liability.

* When outputting data to connected devices (locally connected to the computer or in a

network (LAN / WAN) the safety instructions of the machine manufacturer must be strictly

observed in any case.

If you have questions about this contract, please contact the Licensor: Euro-Systems S.à

r.l, Villa Machera, 1 Rue Kummert, L-6743 Grevenmacher, Luxembourg
© Euro-Systems 2024

Software License Agreement

5



Software License Agreement

6



Important Information for CoCut Clients

Please check the merchandise after the reception upon completeness and announce

possible absence of single parts immediately to your trader.

CoCut is available in two different versions: CoCut Professional, CoCut Standard

The single versions differ in the complexity of functions.

The scope of delivery of a CoCut version includes:

- Program CD (apart from download version)

- Manual on CD or as PDF file

Code number

The sticker is on the inner side of the manual cover. In case of online buy code number is

delivered via email.

System requirements

Pentium 4 or newer with min. 1 GB RAM•   

Windows 7 / 8 / 10 / 11•   

Minimum graphic resolution: 1024 x 768 pixels•   

Host program: CorelDRAW Version from X3, alternatively Illustrator, InDesign,

CorelDesigner, AutoCAD or Inkscape

•   

Restriction of Warranty

We have given the greatest effort with the illustrations and while writing the texts.
Nevertheless, mistakes for this manual and the corresponding programs can not be

entirely excluded. No guarantee is taken for the correctness of the content of this manual,
its translation, its completeness and exactness.

We expel the liability for all losses which appear by the use of the CoCut or its

documentation. The content of this manual can be changed without announcement and is

not to be considered as an obligation of EUROSYSTEMS S.à r.l.

The authors cannot take over any responsibility or liability for incorrect information and
their consequences.

Trademark

Possibly found trademarks are used without their usability can be guaranteed.

The following programs were applied among other things: CorelDRAW, Postscript,
Microsoft, Windows, Illustrator, InDesign, Freehand and AutoCAD. These trademarks are

owned by the respective producer.
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Support And Sales Information

Dear user,

in order to guarantee the direct communication with your competent contact person in

case of problems and questions and in order to avoid or shorten waiting times on the

phone we offer the service of the technical hotline.

This service is available from:

Monday - Friday from 9:00 a.m. until 12:00 noon MET

Phone: ++49 6502-9288-11

Further helpful information as well as tips and tricks are on our website:

www.eurosystems.lu

under the category Support / FAQ

Our support staff members only give information to registered users. Therefore, please

give following information upon each call:

- Version-No.: e.g.  CoCut Professional 21.002

- Dongle or serial number of respective product

Thank you for your understanding that inqueries by phone can only be handled by using

this phone number. Other direct dialling numbers that may be known to you are reserved

for purchase and sales department.

In order to guarantee a smooth and competent support for yourself and others, we kindly

ask you to get registered. Immediately after the reception of your registration card, your
registration per fax or online, you will be added to our user-database.

RCS Systemsteuerungen GmbH

Generaldistributor für EUROSYSTEMS-Produkte.

PS.: For written inquiries or the fast registration per fax or online, please use the following

number or address:

Fax:  ++49 6502-9288-15

Web Site: www.eurosystems.lu

Imprint

Comment to the production:

This manual was created with our own document system. Modifications and errors
reserved.

Support And Sales Information
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Used font family: Arial

English version:

Heidi Hansen, Peter Bettendorf

RCS Systemsteuerungen GmbH

Date: 04/10/24

Imprint
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Imprint
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Copyright

Copyright © 2024 by Euro-Systems S.à.r.l. - All rights reserved.

Any duplication of this manual as well as the computer software CoCut for Windows will be

prosecuted.

The rights for the documentation to CoCut lie with

Euro-Systems S.à r.l., Villa Machera, 1 Rue Kummert, L-6743 Grevenmacher,

Luxembourg

Typeset and composition: Peter Bettendorf

Text: Peter Bettendorf, Frank Thömmes

The legitimate acquisition via data carrier or download allows the use of the program,

analogously to the use of a book. According to the impossibility that a book is read at the

same time in different places by several persons the software program CoCut may not be

used at the same time from different persons in different places and on different devices.

Copies may be created only for the purpose of data backup.

CoCut uses the OpenCV

(Open Source Computer Vision Library)

IMPORTANT: READ BEFORE DOWNLOADING, COPYING, INSTALLING OR USING.

By downloading, copying, installing or using the software you agree to this license. If you

do not agree to this license, do not download, install, copy or use the software.

Intel License Agreement

For Open Source Computer Vision Library

Copyright (C) 2000, 2001, Intel Corporation, all rights reserved.

Third party copyrights are property of their respective owners.  Redistribution and use in

source and binary forms, with or without modification, are permitted provided that the

following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of

conditions and the following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of

conditions and the following disclaimer in the documentation and/or other materials
provided with the distribution.

* The name of Intel Corporation may not be used to endorse or promote products derived
from this software without specific prior written permission.
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This software is provided by the copyright holders and contributors 'as is' and any express
or implied warranties, including, but not limited to, the implied warranties of merchantability

and fitness for a particular purpose are disclaimed.

In no event shall the Intel Corporation or contributors be liable for any direct, indirect,

incidental, special, exemplary, or consequential damages (including, but not limited to,

procurement of substitute goods or services; loss of use, data, or profits; or business

interruption) however caused and on any theory of liability, whether in contract, strict

liability, or tort (including negligence or otherwise) arising in any way out of the use of this

software, even if advised of the possibility of such damage.

CoCut uses NLog

NLog is a free logging platform for .NET, Silverlight and Windows Phone with rich log

routing and management capabilities. It makes it easy to produce and manage high-quality

logs for your application regardless of its size or complexity.

Copyright (c) 2004-2011 Jaroslaw Kowalski

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are

permitted provided that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of

conditions and the following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of

conditions and the following disclaimer in the documentation and/or other materials

provided with the distribution.

* Neither the name of Jaroslaw Kowalski nor the names of its contributors may be used to
endorse or promote products derived from this software without specific prior written

permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND

CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES,

INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF

MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE

DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS

BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR

CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT

OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF

LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING

NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

CoCut uses the OpenCV
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CoCut Weed-Ex

Weed-Ex is a product from Witpac GmbH and the product as well as the application have

been applied for patent in the Netherlands and is not disclosed yet.

CoCut Weed-Ex
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CoCut Weed-Ex
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About This Manual

With this manual you receive CoCut. This manual is divided in 8 chapters.

In the first chapter „Quickstart and installation“ the installation of CoCut on your

Windows computer will be explained. Please follow the installation instruction carefully as

the correct installation is the basic for the smooth usage of CoCut.

The second chapter „How to work with CoCut?“ is an introduction in handling, tools and

functions. The functional principle will be concretized by means of practical examples.

In chapter „Reference part“ all menus and their menu items in their chronological order

are explained. This chapter is thought of as reference book and should be used in case of

doubts about the exact functioning of a command.

In chapter „Reference part display preview” all menus and their menu items in the

display preview in their chronological order are explained. As chapter "Reference part" it is

thought of as reference book and should be used in case of doubts about the exact

functioning of a command.

In next chapter „Toolbars” are described. Toolbars contain important tools that are

placed in a freely movable toolbar. 

In the next chapter functioning of the „Tools” is explained in detail.

In the chapter „The Sidebar” the side toolbar with tabs (similar to the so-called dockers in

CorelDRAW) is described in detail in its functioning. Summarized are layer editing, cliparts,

object manager and file management. The selection of the various functional areas is

implemented via so-called tabs.

In the following chapter „Add Ons” are described in detail. Add Ons are programs or
program parts that are separated from the main program. Usually, they are made available

by a user-defined installation.

In chapter „Tips and Tricks - Trouble Shooting“ we have explained a selection of daily

problems from our hotline and support experience and give you information for dealing

with technical problems.
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Typographical Orientation Guides

Display Meaning

Bold Headlines

Italic Indications, accentuations

Bold, italic Menus, fields, options e.g. new-command

CAPITAL

LETTERS

Name of keys on the keyboard e.g. INS, CTRL, …

KEY1+KEY2 The plus (+) between the key names means that the first key must be

kept pressed while pressing the second key. Afterwards, let go the two

keys.

KEY1,KEY2 A comma (,) between the key names means that you press the keys one

after the other and let them go.

Shortcuts and hotkeys

… Three dots after menu entries and commands always mean that, when

activating, a dialog window will be opened.

Typographical Orientation Guides
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1 Quickstart and Installation

1.1 Copy Protection / Dongle

1.1.1 Copy Protection

CoCut is a copy protected program. Various licensing types are used for the protection of

rights.

1.1.1.1 Dongle

For licensing, a hardware copy protection (dongle) is used in conjunction with a code

number.

1.1.1.2 Soft Code

A soft code with the following format is used for licensing.

Example: CCPXT-0000-0000-0000-0000-0000

1.1.1.3 Activation Key

An activation key is used for licensing. Unlike the soft code, the license is additionally

activated on a license server.

Example: CCPXT:00000-00000-00000-00000-00000

1.2 Licensing

1.2.1 Online Activation / Deactivation

1.2.1.1 Differences to the soft code method

Instead of the previously used serial numbers, activation keys are now used. After

installation, the license must be activated on our license server.
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Fig. 1.2-1: Licensing dialog

1.2.1.2 Activation

Note: Activation or deactivation is also possible offline; there is no online
constraint.

If the customer's computer has access to the Internet, the activation or deactivation of
the license on our server takes place automatically. At the first start of the software, the

customer must enter his activation key.

Important note: Only after the acceptance of the privacy policy, the software will be
activated by clicking on the Activate license button.

Alternatively, the licensing can also be done by means of a license file (*.ECFN). A click

on the License file button opens the Import license file dialog.

please refer to 1.2.4: Licensing using ECFN file

1.2.1.3 Deactivation

Note: The deactivation of the license is done with the same activation key.

In order to get to the Deactivate license button of the Licensing dialog, the License…
button must be clicked via the Help / About… menu item. Then you can deactivate the

license by clicking the License deactivate button.

1.2.1 Online Activation / Deactivation
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Note: Before activating on a new computer, the old license must be deactivated.

1.2.1.4 License Info

A click on the Info button provides detailed information about the status of the license,

namely the validity of the license, computer ID, computer name, activation time and list of

computers where the license is activated.

Fig. 1.2-2: Info button

1.2.2 Offline Activation / Deactivation

1.2.2.1 Activation

If no Internet access is available on the customer's computer, the software automatically

switches to offline activation. After clicking on the Activate Software button, a QR code
is displayed.

Fig. 1.2-3: QR code for offline activation of the license

After scanning the smartphone code, a so-called computer key for this computer is

displayed on the mobile phone.

Note: The computer key is only valid on the computer in use.

Alternatively, the activation can also be done via a web page from another computer.
Follow the information in the window and on the website.

1.2.1 Online Activation / Deactivation
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1.2.2.2 Deactivation

Deactivation requires a deactivation key that confirms the deactivation of the license to

the license server. After scanning the QR code, the activation key is released again at our

license server. This allows the activation key to be used again for activation on another

computer.

To get to the Deactivate license button of the licensing dialog, you have to click on the

License… button via the Help / About… menu item. Then you can deactivate the

license by clicking the Deactivate license button.

Alternatively, the deactivation can be done via a web page from another computer. Follow

instructions in the window and on the website.

Important note: If the computer is defective, please contact your dealer or send an
e-mail to support@eurosystems.lu.

1.2.3 Conversion Trial Version to Full Version

Note: No reinstallation necessary!

Enter the license data via the menu - Help / About… / . A click on the license button
opens the licensing window.

1.2.4 Licensing using ECFN file

As an alternative to entering the license data manually, licensing can also be carried out

by means of a license file. A double click on the *.ECFN file is confirmed by the message

"Your license has been installed". The ECFN file has been copied into the program folder

of CoCut Professional XT and the licensing dialog will be pre-filled the next time the

program is started. Now the license can be activated by clicking on the Activate License
button.

Note: Activating the license is only possible if the privacy policy is accepted.

1.3 Quickstart

1.3.1 How to Install CoCut?

1.3.1.1 Step 1: Connection

Cutter control via USB

Install cutter USB drivers, which were delivered by the cutter manufacturer. Please use the
instructions given by cutter manual.

1.2.2 Offline Activation / Deactivation

20



Cutter control via COM port (serial)

Make sure, that cutter and serial Windows port are configured identically.

You´ll find this port configuration in the system Control Panel under:

System/Hardware/Device Manager/Ports/Communications Port. Select via double click the

respective port (e. g. COM1) and activate Port Settings.

Default settings are: Bits per second: 9600 or 19200, Data bits: 8, Parity: None, Stop bits:

1, Flow control: Hardware

Check also Resources: COM 1: I/O Range 03F8 and IRQ 4 and COM 2:
I/O Range 02F8 and IRQ 3 respectively

1.3.1.2 Step 2: Installation

Insert the CoCut installation CD. With the Autorun function switched on following dialog

opens. If the Autorun function is deactivated open the Windows Explorer and start the file

install.exe in the main directory of the CD. Select product CoCut Professional XT and

start installation.

Fig. 1.3-1: Autorun window

Note: Installation process is done again for each selected application.

1.3.1 How to Install CoCut?
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Fig. 1.3-2: EUROSYSTEMS Software License Agreement

In this dialog the installation folder for CoCut Professional XT is chosen. By default

the folder C:\Program Files\EUROSYSTEMS\CoCut Professional XT is suggested.

If CoCut should be installed to another folder, please click Browse button and select the

desired destination folder.

1.3.1 How to Install CoCut?
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Fig. 1.3-3: Selection of destination folder

Hint: To install additional drivers select custom setup.

1.3.1 How to Install CoCut?

23



Fig. 1.3-4: Selection of setup type

Default program folder in the start menu is EUROSYSTEMS\CoCut Professional XT.

1.3.1 How to Install CoCut?

24



Fig. 1.3-5: Position in start menu

1.3.1 How to Install CoCut?
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1.4 The Cut Marks Toolbar

All object functions of the Cut Marks Toolbar act directly on the host program's

(CorelDRAW or Illustrator) objects. This extends host program's functionality with these

tools so that the whole Print & Cut workflow can be prepared and given out with

CorelDRAW or Illustrator. Of course, CoCut Professional XT can be started without a host

program. The described tools are also available in the standalone version.

Important note: The functionality described here is only possible with CorelDRAW
X3-X8 & 2017-2024 and Illustrator CS3-CS6 & CC!

1.4.1 The Cut Marks Workflow

The following graphic illustrates the Print & Cut workflow (Cut Marks Workflow) inside the

host program (CorelDRAW or Illustrator).

Starting point of the Cut Marks Workflow is a bitmap, which gets contoured as first step. In

the second step multiple copies are generated. In the next step suitable register marks are

placed around the copies.

This Job must be printed on a suitable printer and is finished with a cutting plotter (cutter)

equipped with an optical sensor. The so called registration - Cut Marks recognition -

corrects the prints deviations and the job is cutted. The results of this process are exactly

cutted copies in any number and size.

1.4.2 The Cut Marks Toolbar in CorelDRAW X3-X8 and 2017-2024

Fig. 1.4-1: Toolbar in CorelDRAW X3-X8 and 2017-2024

The buttons were so arranged from left to right that the Cut Marks Workflow can be

performed perfectly.

1.4 The Cut Marks Toolbar
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1.4.3 The File Menu Entries in Illustrator CS3-CS6 and CC

Fig. 1.4-2: Illustrator sub menu CoCut Professional XT

The menu entries are arranged from top to bottom in a way that the Cut Marks Workflow

can be performed perfectly.

1.4.3.1 Buttons of the Cut Marks Toolbar

Important note: The following descriptions are valid also for Illustrator!

1 The Create Contour Button

Fig. 1.4-3: Create Contour Icon

please refer to 6.9: The Contour (Line) Function

2 The Multi Copy Button

Fig. 1.4-4: Multi Copy Icon

please refer to 5.4: The Object Parameter Toolbar

3 The Set Jog Marks Button

Fig. 1.4-5: Set Jog Marks Icon

please refer to 2.9.2: Jog Marks for Optical Recognition Systems

1.4.3 The File Menu Entries in Illustrator CS3-CS6 and CC
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4 The Cut Button

Fig. 1.4-6: Cut Icon

please refer to 2.10: Cutting - Milling - Creasing - Drawing …

5 The Direct Cutting Button

Fig. 1.4-7: Direct cutting Icon

Activating this button ensures that no window appears before the data output. The output

data is sent directly to the connected device.

6 The Export Button

Fig. 1.4-8: Export Icon

Activating this button ensures that the selected data is exported into the specified folder

(see Settings dialog).

Note: In CorelDRAW, the data are saved in the CMX file format, otherwise in PDF
format.

7 The Create Outline Button

Fig. 1.4-9: Create Outline Icon

please refer to 6.2: The Outline Function

8 The Create Outline Layer Button

Fig. 1.4-10: Create Outline Layer Icon

After activating this button the object attribute is changed and a spot color for the selected

contour, which was not generated with the CoCut Professional XT button, is assigned.

1.4.3 The File Menu Entries in Illustrator CS3-CS6 and CC
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9 The Welding Button

Fig. 1.4-11: Welding Icon

Activating this button welds the selected objects.

please refer to 6.7: The Welding Tool

10 The Settings Button

Fig. 1.4-12: Settings Icon

A click on the Settings Button opens the Settings window.

1.4.3.2 The Settings Dialog

Eurosystems Software Field

Fig. 1.4-13: 2 Point Icon

A click on the 2 point button enables the selected program and allows changing of Settings

parameters.

1.4.3 The File Menu Entries in Illustrator CS3-CS6 and CC
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Jog Marks Field

Fig. 1.4-14: 2 Point Icon

A click on the 2 point button opens the Setup - Jog Marks dialog. It allows the selection of

the appropriate cut marks for the plotter, in case your cutter has an optical sensor and its

driver supports this feature.

please refer to 2.9: Label Production with Cutters with Optical Sensor

Export Field

Fig. 1.4-15: 2 Point Icon

A click on the 2-point button opens the Search folder dialog. It allows the selection of the
export folder where the exported file should be saved.

Name of Layer for Jog Marks Option

This option enables the assignment of an individual layer name. Then this jog marks layer
can be identified at any time and the jog marks can be selected. Preset is Regmark.

Name of Layer for Outline Option

This option enables the assignment of an individual layer name. Then this outline layer
can be identified at any time and the outline(s) can be selected. Preset is Outline.

1.4.3 The File Menu Entries in Illustrator CS3-CS6 and CC
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The Output Parameters… Button

Activating the Output Parameters button opens the cutting dialog and allows you to set

individual settings when cutting.

Show Always Contour and Outline Settings Option

If this option is enabled then the dialogs which allow the parameter definition are always

displayed, when the appropriate button was activated.

During the Cut Process only Transfer 'Regmark' and 'Outline' layer Option

If this option is activated then only the objects are transferred to CoCut Professional XT to

which this two layers have been assigned: regardless of the current selection!

Create New File While Cutting Option

If this option is enabled then after pressing the Cut button a new window in CoCut

Professional XT is opened and all or all selected objects are copied into the new window.

Open Output Dialog While Cutting Option

If this option is activated then after pressing the Cut button the Output dialog is opened.

1.5 Autoexport - Scripts

Autoexport means that data from external programs (CorelDRAW, CorelDesigner,

Illustrator, Freehand, Inkscape, InDesign or AutoCAD) are imported automatically into
CoCut - quasi at the push of a button. To do this the scripts are either integrated into the

external program's menu structure or toolbar.

1.5.1 Corun Installer

With the Corun Installer you can install CoCut the plugins. In the Name column all host

programs are listed, in which the plug-ins can be implemented. In the Plugin path column

is displayed in which the folder the plug-in files are located after installation. In the

Eurosystem software list all programs are listed that have a plug-in functionality. Select the

appropriate program from the list. Activating the Install button starts the process.

Note: The Corun Installer is required if the host application was installed BEFORE
the EUROSYSTEMS program or if plugins must be re-installed.

1.5 Autoexport - Scripts
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Fig. 1.5-1: Corun Installer dialog window with detected host programs and path indicators.

1.5.2 Insert CoCut Icon in CorelDRAW Toolbar

1.5.2.1 CorelDRAW X3-X8 and 2017-2024

Indication: CorelDRAW must be installed with the option “Visual Basic for
Application”.

This option can be installed as follows:

1.5.1 Corun Installer

32



Insert CorelDRAW medium into the drive / start setup / select type of installation „Custom
setup”. If already a CorelDRAW-version is installed on your computer, first select „user
defined setup” and then „Custom setup”.

In the dialog that opens now, double click on main applications or one click on the

Plus-field. Here, double click on productivity support and activate the option „Visual
Basic for Application”. After the installation of CoCut you have to link the CoCut Script

with the toolbar.

Select the menu Tools / Customization•   

Select the option Workspace / Customization / Commands  in the left option

bar

•   

Right next to the option bar, click once on File and select Macros and drag

Corun... or Cocut... to the toolbar of CorelDRAW.

•   

Activate the tab Appearance. Here, press the Import-button and select any

symbol.

•   

Select the option Workspace/Customization/Command Bars  in the left option

bar .

•   

Change the name of the toolbar „New ToolBar 1” to CoCut.•   

Click on OK.•   

If you now mark one or several objects and click on the thus created icon, the objects are

passed on to CoCut and can be plotted.

1.5.3 CoCut Script in Inkscape

The CoCut - script for Inkscape is located in the Extensions menu. The output routine is

activated using the cutting menu entry in the CoCut Professional XT sub menu.

Important note: The plugin only works with the non-portable version of Inkscape.

1.5.4 CoCut Script in Adobe Illustrator 8-10, CS-CS6, CC

CoCut is in the file menu underneath the menu item export.

How does the transfer of data from Illustrator 8, 9, 10, CS, CS2, CS3, CS4, CS5, CS6,
CC to CoCut take place?

Start CoCut from the file  menu. If the objects are marked, only the marked objects are
passed on to CoCut. If also texts are passed on they will automatically be converted to

curves.

Indication: If no objects are marked, CoCut is not active!

Indication: Special process color fills are not passed on.

1.5.2 Insert CoCut Icon in CorelDRAW Toolbar
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1.5.5 CoCut Script in Adobe InDesign CS4-CS6, CC

The CoCut script is in the Plug-ins menu, under the following sub-menu:

EUROSYSTEMS, Auto Export. From the function list, select the appropriate function with

a click.

1.5.6 CoCut Script in AutoCAD

1.5.6.1 Menu File for AutoCAD 2000(i), 2002 - 2024, LT 2002 - LT 2024

In the menu Extras select the menu item adjust menus.

(Indication: Alternatively you can also open the dialog via the command 

_menuload)

•   

In the dialog that now opens select the tab menu groups and press the browse
button.

•   

The file selection dialog opens. Change the file ending to *.mnu in this dialog.•   

Select the file corun.mnu  and close the dialog.•   

Now press the Load button and confirm the inquiry dialog with ok.•   

The CoCut menu is now loaded.•   

Now change the menu bar dialog in the upper tab. In the menu group select

CoCut Plot and insert it into the desired place in the AutoCAD menu.

•   

1.5.6.2 Menu File for AutoCAD LT 98 And R14

In the menu Extras select the menu item Adjust/Menus.•   

In the dialog that now opens press the browse button.•   

The file selection dialog opens. Change the file ending to *.mnu in this dialog.•   

Select the file corun.mnu  and close the dialog.•   

Now press the Load button and confirm the inquiry dialog with ok.•   

The CoCut-menu is now loaded.•   

Now change to the menu bar dialog in the upper tab. In the menu group select

CoCut Plot and insert it into the desired place in the AutoCAD menu.

•   

In the menu file  select the menu item printer installation.•   

In the dialog that now opens press the open  button and select the file

cocutlt98.pc2 (LT98) respectively cocutr14pc2 (R14).
•   

Close the dialog.•   

Start now the print-job by activating the menu item print  in the file menu in

order to do following settings: activate the button Plot in file, set the scale
factor to 1:1 and the unit to mm.

•   

In the menu is now CoCut entry and in the toolbars CoCut toolbar was added.

Important: Be careful that at the first output the checkbox "plot to file" is activated.
With this procedure, all graph elements are passed on. The change-pen commands
are interpreted from the PLT file so that the 8 layers are separable. AutoCAD does
not plot with Arcs, which means that all elements are resolved in lines and dots are
interpreted as bores.

1.5.5 CoCut Script in Adobe InDesign CS4-CS6, CC
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Indication: If DXF is used, you have to press twice the ENTER button after the
selection of the object as the execution of the macro menu is aborted by the object
selection. At the passing on via DXF the dimensions and texts are not passed on
but it is possible to select and output them. The curves are not converted to lines
but the Splines or Arcs in the DXF file are converted to Bezier curves. The layer
amount is not limited to 8.

In the startup group of Windows a link to the program autoimp.exe is installed during the

installation with which the passing on of files to CoCut is realized. If autoimp.exe is started

an icon is shown in the system tray (lower right corner of the screen). Double clicking on

the icon ends the program.

Attention: If the icon is switched off the transfer to CoCut does not work anymore!

Via Start / All Programs / Startup / Auto Import for CoCut it can be started again.

Indication: During the installation you have to pay attention that CoCut is always
installed for the last used AutoCAD version if several AutoCAD versions are
installed on your computer.

1.6 Selection of The Device Driver

Please, select first your output device from the list driver. In the field name of device  the

identical name for the selected device that is shown in the cutting dialog appears. This

name can be changed individually in this field. After the selection of the driver please

select - in the area type of connection - the device type with which the device is

connected to the computer.

Tip: If the driver you search for is not in the list you can try another driver from the
same manufacturer.

1.5.6 CoCut Script in AutoCAD
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Fig. 1.6-1: Dialog for the selection of the device driver

Detailed information for the setting of the local interface is here: please refer to 2.10:
Cutting - Milling - Creasing - Drawing …

1.6 Selection of The Device Driver
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2 How to work with CoCut

2.1 Desktop and Working Sheet

2.1.1 I. Desktop

The so-called Desktop means the whole visible program window including Toolbars,
Working Sheet and Desktop background.

Note: On the background can be placed any desired number of objects. The size of
the background is limited only by the resources of your computer. Thus the layout
can be done basically in 1:1 scale.

Fig. 2.1-1: Desktop with working sheet (here: gray), Background (here: white), Toolbars,

Sidebar, Rulers, Statusbar

2.1.2 II. Working Area

The workspace is a subset of the CoCut desktop. The workspace is usually in the format

that will later be output on a machine. In addition to the known DIN formats, any formats
can be applied, e.g. for different table sizes.
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Note: The working area is used primarily for guidance. The format of the working
area has no influence on the output on a connected device. The output preview
window displays what is given out.

please refer to 2.10: Cutting - Milling - Creasing - Drawing …

Fig. 2.1-2: The Working Area Dialog

2.1.2.1 The Buttons

The New Button

The New button creates a new format. The values for width and height of the selected line

are transferred to the new row.

The Delete Button

The Delete button removes the marked row.

The Change Button

This button saves all changed parameters and options.

The Default* Button

This button marks the name with a * (star). The star-marked format is used every time

CoCut is started.

2.1.2 II. Working Area
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The Read from connected device Button

By means of this button - if the read-out command of the driver is processed by the

machine controller - the width value can be read from the connected device and inserted

into the width field.

The Change orientation Button

This button changes the orientation of the working space from portrait to landscape and

vice versa.

The OK Button

The OK button accepts the changed values and closes the dialog.

The Cancel Button

This button closes the dialog without saving any changes.

2.1.2.2 The Areas

The Preview Area

In this area, the worksheet, the desktop background, their colors, as well as the orientation

are displayed proportionally reduced.

The Format Area

Name

The name of the format is entered in this field and the name of the selected one is

displayed.

Width

In this field, the width of the format is determined.

Height

In this field, the height of the format is set.

The Margins Area

Left, Right, Top, Unten

These 4 fields define the distance of the borders from the edge of the working area.

Note: Negative values are also allowed.

2.1.2 II. Working Area
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The Color Area

Foreground

Here, the color of the worksheet can be defined as RGB value.

Background

Here the color of the background desktop can be defined as RGB value.

2.1.2.3 The Options

The Fit to objects Option

This option captures the objects outside the working sheet and extends the sheet by the

amount necessary to accommodate all the objects on the working sheet.

The Show margins Option

This option displays the defined borders as dashed lines in front of the working sheet.

The Select image Option

This option displays the selected bitmap in the preview and later on the working sheet.

The ... button opens the file dialog for selecting the desired bitmap.

The Scale Objects too Option

If the height or width of the working sheet is changed, all objects on the working sheet are

reduced or enlarged by the same amount.

The Rotate Objects too Option

This option determines whether the objects on the working sheet and on the desktop

background will also be rotated when the orientation is changed.

The Accept working area dynamically from current device Option

This option ensures that the width and height values of the working area are read from the

connected device and used. For each device, a format is created with the name of the

device in the list.

2.2 Job Preparation

2.1.2 II. Working Area
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2.2.1 Import

With this command the graphics that have not been saved in the CoCut-job-format are

transfered to the working surface.

The functionality of this dialog box corresponds to the open file command. Differences are

only due to the possibility to change the size of the data to be imported by means of the

parameter X- and Y-factor. The desired file is chosen respectively specified via the name
of file, type of file and directories (search in).

Fig. 2.2-1: Import window with preview

With the preview window in the import dialog all following formats can be displayed.

*.ai/eps, *.pcx, *.jtp, *.tif, *.bmp, *.wmf, *.emf, *.dxf, *.gif, *.hpgl, *.gtp, *.ik, *.svg

Indication: With text files (*.txt) the preview window is switched off.

2.2.1.1 Import Presettings

For many import operations, constraints can be defined to be taken into account before,

during or after importing the data. Constraints can effect the DXF or HPGL import or all
import operations.

Also for export constraints are definable in this window. Thus, a special option on job files
can be activated, for example, the PDF export. The constraints are extensively recorded

2.2.1 Import
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in the following article. please refer to 3.6.1.7: The Import Setup

2.2.1.2 PDF Import

2.2.1.2.1 Additional Options

Fig. 2.2-2: Options concerning import of data

Raster Options

Import as Bitmap Option

If the Import as Bitmap option is enabled, then all vectors will be rastered into a bitmap
before the import.

Resolution

The value in dpi

Element Selection

Ignore Images Option

If the Ignore Images option is enabled, then no images will be imported.

2.2.1 Import
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Ignore Text Option

If the Ignore Text option is enabled, then no texts will be imported.

Page Selection

In the input field the page number can be entered, which should be imported.

All Pages Option

If the All Pages option is enabled, then all pages of the document will be imported.

Search in

In the row Search in the path can be set that shall be searched.

File name

If the file name is know it can be entered into this field

Type of file

Here, you have to choose the format of the file to be imported in order to activate the

corresponding import filter

Preview

The activation of this option draws a preview of the file content to the left preview window

Insert at Position (0,0)

This option inserts the objects at the 0 (zero) position of the CoCut-working surface.

X Factor, Y Factor

With these two factors the data can be scaled (increased or decreased) during the import.

The scale can be proportional or unproportional.

2.3 The CoCut Layer dialog

In the layer-settings dialog the parameters necessary for the output are set and attributed
to an object, a color respective a layer. The dialog opens by a right mouse click on the

CoCut layer-toolbar in the main window.

2.3 The CoCut Layer dialog
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Fig. 2.3-1: Layer setup with adjustment of output parameters

In the Information field a name for the layer can be entered. This name is shown later in

all dialogs in which the colors of the objects are needed. 

In the Mode / Tool field the output tool can be selected from a list. The tools shown here

depend on the used output driver.

In the Material field already saved material-configuration can be called up. The

material-configuration can be created, saved or deleted with the button right of the
selection box.

Indication: By clicking with the left mouse button on another color the settings are
saved and the values of another layer can be edited.

2.3 The CoCut Layer dialog
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2.4 Tool Assignment Via Layer

Tools which are provided from an output device are pre-defined in the device driver. The

tool selection is done with the output dialog of the Mode / Tool list field.

Fig. 2.4-1: Tools and toos parameter which were defined in the device driver

2.4.1 Define Layer Assignment

What tool is located in which layer - that is necessary to define the order of execution - will

be assigned in the layer settings window. A click with the right mouse button on the to

edit layer opens the layer settings window. Tool assignment is not possible here.

2.4 Tool Assignment Via Layer
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Fig. 2.4-2: Window before switching into the output view

2.4.1.1 The Output Button

If the Output button is enabled, the layer settings window switches in the following view:

2.4.1 Define Layer Assignment
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Now, all from the respective driver provided tool modes are listed. When you select a tool,
then the editable parameters and values appear in the list in the upper area of the output
parameter window. Values can now be edited. A doubleclick in the desired field allows

editing of its value. Repeat this operation for each layer and mode which is scheduled for

output.

Fig. 2.4-3: Layer with tool nomination (left-hand) - tool assignment (Middle) - Layer with

assigned tool (right-hand)

Note: When the red hook is visible, a tool assignment had been done. An additional
control is possible via a tool tip in the layer box by placing the mouse cursor on the
layer under investigation and is waiting for some time.

Depending on the output device, different tools and output modes are available. In the
example below, for example, tools of a flatbed cutter are been used. Here it is important to

determine the correct order in which the tools should work.

Fig. 2.4-4: Tool tip control for the "Cut Through Layer"

2.4.1 Define Layer Assignment
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2.4.2 How the Tool Sequence Is Determined?

In principle, it should be noted that the processing of the layer is done top down and the

logical sequence of different tools, is applied, so that for example, drawing is active ahead

the cut tool. This sequence can be reordered individually.

Fig. 2.4-5: Layer sequence which should be reordered

The change order function is enabled via the layer order menu item. In the move
layer area you'll find the buttons to change the layer order.

Fig. 2.4-6: Tool sequence reordered - Through Cut above Crease

2.4.2 How the Tool Sequence Is Determined?
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Conclusion:  The tool assignment allows first, the definition of tools, second, the
parameters for each tool, third, the selection of the color (layer) in which the to be

processed objects lie and in the fourth place, the sequence in which the operation should

be processed. CoCut Professional XT gives you the flexibility you need in dealing with

different output scenarios and workflows.

2.5 The Output

2.5.1 Device Setting - Interface Setup (Local Device)

The CoCut output

With this command you activate the module for cutting, milling, creasing and drawing of

your data.

You activate this function via the  button in the tools toolbar or via the file
menu, menu entry output…

S

Fig. 2.5-1: The output button

When first opening another dialog will be opened before in which the driver of the device

as well as the connection has to be defined.

Fig. 2.5-2: Driver and selection of the connection 

2.5 The Output
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General

Under the part of the dialog named General you select the driver of the device.

In the right list all device drivers are listed that are available in CoCut. In the left list an

individual name for the driver can be distributed. This name will be used in the output

dialogs of CoCut.

Enable as server

Requirements are at least 2 licenses of CoCut.

If the option enable as server is activated the output device will be marked as plot server
and can be used by another Plot Manager for the output.

The characteristic features of an output device are that a driver for the processing of the

data has to be distributed to this output device. On the computer on which the Plot

Manager is running the job data for the output are transformed into device data by means

of a driver. The output of the device data can be done in several ways:

Types of connection

Local interfaces

Local interfaces are the interfaces (COM1, COM2, ..., LPT1, LPT2, ...) that are directly on

your computer.

The activation of the settings button opens a dialog for the configuration of the

interface. These settings that are done here apply for the whole system.

Fig. 2.5-3: Dialog for the setting of the interface parameters

2.5.1 Device Setting - Interface Setup (Local Device)
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Indication: When steering serially you have to pay attention that all settings on the
side of the computer as well as on the side of the output device correspond.
Otherwise there is no or faulty communication between them.
USB / Firewire Devices

Here, all momentarily connected USB / Firewire devices are listed.

TCP / IP

Here, you have to enter the TCP / IP address and the port number to which shall be

output.

Spooler

Here, you can select a Windows printer driver.

When opening the output dialog again it will be opened directly with the previously set

device driver.

2.5.2 Device Setting (Network Device)

When selecting the menu item create network device … following dialog will be opened:

Fig. 2.5-4: Dialog for the configuration of a plot server

2.5.2 Device Setting (Network Device)
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A network device enables the output of CoCut jobs on a Plot Manager that runs on
another computer. Contrary to a "normal device" the data are not locally transformed into

device data but transferred unchanged to the plot server for the further processing.  

Device name

In the entry line enter the name of the device.

Server selection

In the area named server selection enter the TCP/IP address if you use a TCP / IP

connection or the name of the computer that is used.

Network

If a connection shall be done via a network the configuration file of the plot server,

the plotman.ini, must be selected.

Devices (of server)

If the actualize button is pressed the devices of the server are read.

Indication: The device of the server can only be read if the server was selected as
only then, the devices of the server are available.

Driver

In the field driver the device driver is entered that the server uses for this device.

Indication: This driver must also be created locally, which means as local device. 

2.5.3 Start Output from the CoCut Working Surface

The output is started using the plotter icon .

Fig. 2.5-5: Pre-processing line weight and color gradient

If a CoCut job contains objects with the attributes pen thickness and/or color graduation
a preceding dialog appears. The object attributes can be transformed into vectors so that

2.5.3 Start Output from the CoCut Working Surface
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they are taken into consideration at the output. After clicking on the OK button the object
attributes are transformed into curves.

2.5.3.1 Output to Device

Fig. 2.5-6: Output dialog

Output

In the area named output of the output to device dialog you can control most of

the parameters that are directly or indirectly in contact with the output device.

Device

In the device field the previously defined output device is shown.

2.5.3 Start Output from the CoCut Working Surface
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Mode

In the mode field  the required output mode is preset.

Output Profile

In the field output profile the required profile with individual settings and values is

selected.

Manage Profiles Button

Clicking on the  button opens the following popup menu:

Add

Activating the Add menu item writes a new data record into the profile database.

Save Profile

Selecting the menu item Save profile the prior to this edited and changed values are

written into the profile database.

Profile Defaults

Activating the menu item Profile defaults resets all Values to the default value. The
profile values are reread.

Mode / Tool Defaults

Activating the menu item Mode / Tool defaults resets all Parameters to the internal
driver values.

2.5.3 Start Output from the CoCut Working Surface

54



Number of Jobs

The value in the field number of jobs repeats the last output without the reading of the

video marks with identical output parameters such as scaling, etc. Only layers with tools

are given out. This variant protects against the fact that layers are output with no tool

assignment. This means that there is no error output due to the use of the last active tool.

Copies per Job

In the field copies per job you define how often the selected objects shall be cut. After the

cutting this value is automatically reset to 1.

Copy Spacing Y-Direction

The value in the field Copy spacing y-direction defines if the copies shall be stacked

vertically and which space has to be kept between the copies. Pre-condition for the

activation of this option is that the selected object can be cut more than one time on top of

each other!

Indication: In the preview the first object is shown „normally“. Each further object of
the stack is shown dashed in blue.

Copy Spacing X-Direction

The value in the field Copy spacing x-direction defines the space between the copies

that were entered in the field Copies per job.

Weed Border Distance

With the option Weed border distance it is defined if and with which space a rectangle is

cut around the plot that facilitates the weeding of the foil. In the output preview the frame
- if activated - is shown dashed in blue.

Segment Spacing

The segment spacing defines the horizontal space between the single segments.
Segments always occur if the job has to be sectioned which means divided.

Only Output Tool-Assigned Layers

By activating this option, only objects from a layer with an assigned tool are transferred to
the Plot-Manager.

Send Design Relative to Origin

Via this option the zero point (0/0) of the cutter can be moved. If this option is not
active CoCut selects automatically the physical zero point as starting point for the cutting.

If the Send design relative to origin option is active the physical zero point is
moved relatively to the offset coordinate of the reference point. The coordinates of the

reference point corresponds to the position of the down left corner of the object to be cut

2.5.3 Start Output from the CoCut Working Surface
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on the CoCut working surface.

Plot to File

If the option plot to file is active all output data are directed to a file you have named and

written onto the hard drive.

Enable Tool Tips

If this option is enabled, explanatory texts regarding parameters, values or options are

displayed, if the mouse cursor is located directly above.

Pause after Feeding a Segment

Sectioning / Segmentation: If a job is too big for the output CoCut separates the

job automatically in so many parts (segments) that are necessary for the complete output

of the job.

If the option Pause after feeding a segment is active the output is interrupted after each

segment and the material can be re-adjusted if necessary.

Save Settings Button

By activating the Save settings button all values that have previously been entered in the

output dialog are stored and assigned to the currently active output device.

2.5.3.2 Sort Options

Sort before Output

If the option Sort before output is activated all objects in the working surface are sorted

1. in head direction and 2. in transport direction.

Actual Setting

Fig. 2.5-7: Main direction icon

The icon shows which main direction is selected in the output to device dialog.

Always Prefer Job Order

This option ensures, that the sorting that was made before, is not changed through an

alternative sortation.

The Button

The sort options button opens the output settings dialog.

2.5.3 Start Output from the CoCut Working Surface
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please refer to 6.6.4.1: The Sort Settings Tab

Accuracy

The Accuracy field offers the following settings: very low, low, normal, high and very
high. As default, the value normal is set.

The accuracy defines of how many vector parts an object should consist. This is only

relevant with objects whose size range in ten thousands of a millimeter. Other object sizes

are calculated automatically by CoCut.

Feed / Origin

Depending on the selected driver the field name is either feed or origin.

Friction Feed Cutter

With origin the options are new origin or don't set. If the option new origin is selected

the device goes into X-direction at a fix set value behind the last cut object and this

position is then the new origin. If don't set is activated the physical zero point is the new

origin after the output.

Flatbed Cutter

With feed the options are feed or no feed. If the option feed is activated the material feed

is carried out with the sectioning and with the output from the roll if the flatbed cutter has

an automatic material feed.

Objects

The field Objects allows the selection of the objects to be output. Besides the modes all
objects and selected objects CoCut also allows the cutting of color sequences or of

single color layers. The two last named are explained more in detail in the chapter „color
separation when cutting".

Fig. 2.5-8: List field objects with selection modes.

2.5.3.3 Parameter / Value Table

The table Parameter / Value allows the access to the parameters of device and
driver. The area is divided in parameter and value. The width of the display can be
changed by moving the vertical line between the areas with the mouse. Whenever Edit…
is displayed in the value column a double-click opens the corresponding window for the
setup of a group of parameters.

2.5.3 Start Output from the CoCut Working Surface
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Fig. 2.5-9: Example for an opened parameter group

Info Line

In the Info Line information relating to the output process is displayed additionally, e. g.

"Job will be sectioned".

Test Drive

If the test drive button is activated the connected device drives along the weeding frame
with the tool head lifted. This also happens if the option weeding frame is not active.

Preview or Direct Output

The Preview button opens the output preview. Direct output suppresses the preview
window. After pressing the output button, the plotter commands are transferred to the

plotter together with the data.

Output

The Output button transfers the data directly to the Plot Manager and to the connected

device.

Read Material Size

The Read material size button delivers back to all connected devices the height of the

area to be plotted if an accordant command is intended in the firmware for the device.

Devices that do not offer this option no value respective zero is delivered back.

2.5.3 Start Output from the CoCut Working Surface
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2.5.3.4 Color Separation when Cutting

Each layer color used in the draft appears again in the objects list with the number that

clearly defines each layer color. In addition, in this list field two horizontal color bars

appear. After having transferred the data of a color layer, in the info area of the Windows

status bar the Plot Manager icon ( ) appears.

Double clicking on this icon activates the Plot Manager job control. If the mouse cursor is

positioned on the icon and the right mouse button is pressed, a pop up menu appears in

which the Plot Manager can be closed or the program version can be shown. In the layer
selection the color layers that have not been processed yet occur in the order in which

they had been selected. The order in the stack can be changed at any time.

Fig. 2.5-10: Definition of the order in which the single layers shall be processed by up /

down buttons

The order is defined via the up / down buttons. Layer colors that are not necessary are

deleted from the list with the  button.

Tip: For the color separated cutting use the register marks from the draw
tool. Register marks are cut at the same place on the foil independently from the
used color.

2.5.3 Start Output from the CoCut Working Surface
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2.6 Export

If you want to use a job-file also in other programs the data must be made available in

another format than the CoCut-job-format. This process is called „export”

Indication: Exporting is done with the highest quality and lowest compression.

Fig. 2.6-1: CoCut Export window with file selection

Save

With the icons next to the Save-field you choose the path in which the export-file shall be
saved.

File name

In this field you enter the name of the export-file.

Type of file

Here, you select in which other format the data on the desktop is to be written.

Following export-filters are available in CoCut: *.eps (opi), *.cmx (Corel6-X6), *.plt (HPGL),

*: jpg, .pcx, *.tif, *.bmp.

Indication: If objects are selected only those are exported, otherwise all of them.

2.6 Export
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Selected objects

If this option is activated only the marked objects are written in the export-file.

All objects

 If this option is activated all objects are written in the export-file.

Maintain worksheet

With this option the contour of the worksheet is written as object in the export-file.

Bitmap-Export

Fig. 2.6-2: Shade and resolution at Bitmap-export

Shade

The number in front of „Bit per pixel” indicates the exponent of the shade.

Example: 8 bits per pixel = 28 = 256 colors

Resolution

This value defines the amount of pixels per inch. The higher the value the finer becomes
the resolution. The value dpi 300 for example is sufficient for the offset printing.

Indication: Higher values are often not suggestive as the size of the file increases
with higher dpi.

Antialias

The export of a bitmap can also be done with antialiasing short: Antialias, which is a

jaggies smoothing or edge smoothing.

2.6 Export
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2.6.1 PDF Export

2.6.1.1 Additional Options

2.6.1.2 Encrypt Document Option

Enabling the Encrypt Document option allows input of an individual password.

Password

In the input field any password for the document can be filed.

Note: Please make sure that a secure password is used. It should be at least 8
characters long and made of numbers, letters, capital letters and special characters.

2.6.1.3 Set Access Rights Option

Enabling Set Access Rights option allows you to enter an individual password.

Password

In the input field any password for the following access rights of the document can be

filed.

Note: Please make sure that a secure password is used. It should be at least 8
characters long and made of numbers, letters, capital letters and special characters.

PS: The CoCut PDF export includes a double-stage password protection. The first

2.6.1 PDF Export
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stage refers to the entire document and the second stage to a specific access rights
of the document.

2.6.1.4 Access Rights

Printing not allowed Option

When this option is enabled, printing of the document - without knowing the password -

is not possible.

Content cannot be extracted Option

When this option is enabled, extracting of contents - without knowing the password - is

not possible.

Do not allow "Change Contents" Option

When this option is enabled, editing of contents - without knowing the password - is not

possible.

2.7 Excursion: Contour vs Outline vs Contour Line

Often, there is confusion among CoCut Professional XT users, because the differences

between this terms are not clear and there can be seen no difference on the CoCut

working sheet, if the so-called full surface mode is enabled. Not until then the so-called

contour mode - switch on or off using F9 key - differences can be seen. Obviously

completely different functions are meant.

In the following the terms are examined for their similarities and differences.

2.7.1 1. Contour

Definition:

Contour is a property, an attribute of a vector object or a type face, comparable with a

color fill. Color and width can be defined individually.This contour is given out on a laser or

ink jet printer. The tool for the definition of a contour is the pen .

2.6.1 PDF Export

63



Fig. 2.7-1: Pen attributes dialog

Fig. 2.7-2: Full surface mode

Fig. 2.7-3: Contour mode

Attention: A contour is not! given out on a cutter, unless the "Convert contours"
function was executed before data  transfer to the output module.

Fig. 2.7-4: Dialog for conversion of contours into cuttable objects

If the option Convert contours is enabled, a vector combination in the thickness of the
contour is generated. This combination is put in a layer with the same color.

Additionally the following dialog appears with a pre-selection of the correct welding method
(here: Weld by Color).

2.7.1 1. Contour
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Fig. 2.7-5: Welding dialog with presetting "by color"

Tip: For testing can be switched into the contour mode in order to control which
objects will be given out.

2.7.2 2. Outline

Definition

Outline is a vector contour around another vector object oder a type face. In differenc to
the term contour the generated contour is a real vector which can be outputted. Another

difference is, that  interior parts are contoured as well with a so-called Inline. Example:
Letters like a, e where the interior parts are also contoured (see fig. below) 

Note: The Outline function is linked with the welding function, so that if contours
are overlapping each other, an error-free output to vinyl gets possible.

Fig. 2.7-6: Outline dialog

2.7.2 2. Outline
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Fig. 2.7-7: Full surface mode

Fig. 2.7-8: Contour mode

2.7.3 3. Contour Line

Definition

By a contour line is often referred in connection with the term: "print & cut". In "Print & Cut"

bitmaps mostly logos - graphics without vectors - are contoured with a vector line, in order

to produce decals, label, sticker on a cutter with OPOS sensor. The contour line is the line

that is cut around each sticker. It is like the pen contour an outline around the entire object.

Note: In this case the thickness of an object cannot be defined; as default a
so-called hairline (0.01 mm) is generated.

Fig. 2.7-9: Contour line dialog

Fig. 2.7-10: Full surface mode

2.7.3 3. Contour Line
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Fig. 2.7-11: Contour mode

Conclusion: The above examples should made clear that it is important to keep apart the

notions. Although, there cannot be seen any difference on the scree when in the full

surface mode, different tools and functions are involved. This example also shows how

flexible the tools of CoCut Professional XT are.

2.7.3 3. Contour Line
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2.8 Excursus: Welding of Vector Objects

2.8.1 A Selection of the Most Important Welding Sub Types

The welding function merges two or more vector objects together to a combination.

Depending on number and shape of the selected objects, you can select between the

following options: Manually, Automatically, Trim (which cuts objects with lines or

curves), Open trimming, Fill, By color, Full surface or Screen printing.

2.8.1.1 Automatically

Automatically calculates the common areas of the objects. All overlapping pieces are

merged with each other; transparent interiors are taken into account.

The option Automatically is especially appropriate for the welding of serifs of scripts. The

serif of the preceding letter often overlaps with the following letter itself or its serif. Without

welding the material would be cut at this intersections. The automatic welding eleminates

this overlap and serves to a cuttable transient of the serifs.

Note: Please note that by this option objects with different color are welded to one!
combination object. Should the object colors taken into account, then choose either
one of the options: By color, full surface, or screen printing.

Tip: If after the automatic welding some parts are missing, then you should reduce
the character spacing in your text editor by 100% to 99%. As a result, identically on
top of each other lying node points get moved in a way, that they can recognized as
separate nodes and then the welding function runs correctly.

2.8.1.2 By Color

By color removes all areas, which are masked from overlying colors. It does not matter,

how much objects or colors you select. If open objects are also selected, they can be

closed or be provided with a line width.

2.8.1.3 Full Surface

2.8 Excursus: Welding of Vector Objects
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The option Full Surface underfills objects in one color, whose areas cover the areas of

another. The partially covered objects are handled in a way, that the overlying ones cover

the underlapped totally.

Tip: The most common application is the window lettering. Here, the option 'by
Color' is often too difficult to handle. At 2 or 3 foil colors, you should take the full
surface option, in which the individual foil colors are glued one above the other.

2.8.1.4 Screen Printing

The welding option screen printing is particulary powerful tool for screen printers. First of

all it eleminates overlaps of the color layers. Afterwards the colors are stacked in the color

sequence. Finally, a bridge (an outflow wedge) gets inserted as an overlap.

2.8.1.5 The Color Stack of Screen Printing

Changing the color stack: In screen printing the sequence of printing colors is from light

to dark. Lighter colors are printed before darker colors. With a mouse click a color layer

can be picked up and moved to the desired position. The color stack shows the location of

the individual layers above the medium. The output sequence takes, the changings of the

color stack, into account. 

2.8.1.6 Trim

Trim means, that you can cut closed objects with lines or curve objects and the resulting

subobjects are then closed again automatically. Depending on the request, you can put
one or more objects - like a "knife" - on the objects which should be dissipated. If you use

2.8.1 A Selection of the Most Important Welding Sub Types
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more "knives", this objects must lie in the same layer or must be combined. With the help
of the trim function the underlying objects are dissected along the "knives". Also, a

dissection in multiple tiles is easily achievable, because the knives may overlap. The

resulting subpieces are then sorted according to their location and condensed to

particulary groups.

2.8.1 A Selection of the Most Important Welding Sub Types
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2.9 Label Production with Cutters with Optical Sensor

CoCut Professional XT is predestined for the so-called "Print & Cut" production of labels or

stickers on self-adhesive material. The term "print & Cut" means, that on the medium gets

printed first and then the labels are cut outlined with a cutting plotter. The cutter therefor

should be equipped with an optical sensor, which recognizes so-called register marks or

jog marks, so that print inaccuracies can be compensated. For the "Print & Cut" process it

doesn't matter with which method the material was printed - screen print or digital inkjet

print.

Definition: OPOS - Acronym for Optical POsitioning System

2.9.1 1. Step: Job Preparation

The job is prepared with CoCut Professional XT. All tools which are needed for the

production of labels are included. With the CoRUN export function out of host programs

like CorelDRAW, Freehand, AutoCAD or Illustrator external data can be imported and

processed in CoCut.

Fig. 2.9-1: Job preparation

Using the special functions 1. Contour Line, 2. Clones, 3. Multi Copies, and 4. Set Jog

Marks a job is prepared for printing. Printing can be done directly using CoCut

Professional XT, if for example PjanntoRIP or EuroVPM as a print program is installed as

well. If another RIP than those specified is in use, you must use the EPS (OPI) export in
order to prepare the job data for printing.

Tip: For the generation of identical copies, the clone tools should be used. This
ensures a small amount of data and a high processing speed.

Thus the cutter can provide the print job with cut outline, manufacturer-specific jog marks

can be used and printed additionally! Setting of the jog marks can be done with the
Settings / Common Settings / Register Marks menu in CoCut.

2.9 Label Production with Cutters with Optical Sensor
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Limits: CoCut Professional XT has no resp. only rudimentary image processing tools. The
image processing must be done in a host program such as Photoshop. Afterwards, the

image data are imported into CoCut and processed.

2.9.2 Jog Marks for Optical Recognition Systems

2.9.2.1 Field of Application: Contour Cutting (Print & Cut):

Wherever printed materials must be cut or milled with contours, the usage of jog
marks is indispensable, in order to produce with the required accuracy. Beyond
that, inaccuracies which occur during the print process, must be
compensated.  Preset ist done in the Settings / Common Settings / Register Marks
menu. The jog marks are set using the  tools  menu with the Set Jog Marks
submenu item.

Note: The jog marks function can be used with all cutters with optical sensors or
with flatbed cutters or milling machines equipped with camera systems for mark
recognition.

Fig. 2.9-2: Settings menu in CoCut with jog mark selection

2.9.2.2 Definition

Jog marks and video marks are used synonymously for marks related to optical detection

of marks. Register marks describe a tool, that is used for the assembly of colored signs.
Print and cut marks describe marks, that are used commonly in printing and desktop

publishing.

2.9.1 1. Step: Job Preparation
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Note:  Jog marks are usually associated with an optical sensor; video marks with
camera usage.

2.9.2.3 Jog Marks

A detailed description of all parameters can be found here: please refer to 3.6.1.4: The
Register / Crop Marks… Setup

After preselecting the producer-specific jog marks, this jog marks can be set around the

job, so that in the 2nd step they will be part of the printing job. Hotkey for this function in

CoCut is SHIFT+J.

Fig. 2.9-3: Tool menu for setting of jog marks

2.9.3 2. Step: The Print Process

Print processing is either done in screen print or digital inkjet print with solvent ink. The
RIP does the rastering, the linearization and the density correction. Additionally control

parameter like heater temperature, resolution, etc. are managed. Modern solvent printer
print on un-coated materials which often do not have to be laminated. All users which do

not have an own printer, can delegate the print process to an external provider.

2.9.4 3. Step: The Cutting Process

Currently, all premium cutter have an optical sensor, so that with this devices a serial

production of label, stickers, or decals is possible. The cutter processes in doing so the

contour line - not to be confused with Outline - which was generated  in the job prepartion
around all copies. Fig. 2.9-7 shows the magenta contour lines which will be cut.

2.9.2 Jog Marks for Optical Recognition Systems
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Fig. 2.9-4: Cutting head with sensor and tangential knife

The cutter described above are able to process sheets or rolls. CoCut's plotter driver

support both functions. Fig. 2.9-5 and Fig. 2.9-6 show the driver parameter for the cutting

with sensor for the processing of identical job copies using rolls or sheets (Fig. 2.9-6).

Fig. 2.9-5: Parameter setting OPOS=ON using the example of Summa S-Class

Note: The parameter "OPOS" is set automatically on "ON" if the appropriate marks
are used. When processing identical copies of jobs on a roll using jog marks, the
mode "OPOS cutting with copies"  must be used (Fig. 2.9-6). Then additionally the
number of copies in X direction can be set and as well as the mark distance
between the copies in mm.

2.9.4 3. Step: The Cutting Process
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Fig. 2.9-6: Parameter setting with identical Job copies from roll (also possible with sheets,

if the parameter "Sheet=On" was set)

Fig. 2.9-7: Cut contours in the cut preview (the gray contour below left, is required
for "Flex-Cut")

The result of this process are readymade labels in individual number and size. To get the

labels carwashresistant, they must be treated with a liquid lacquer.

2.9.4 3. Step: The Cutting Process
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2.10 Cutting - Milling - Creasing - Drawing …

2.10.1 The Output Preview 

The output preview is automatically started if you press the preview button in the output
dialog. 

Closing the output preview and returning to the working surface of CoCut ESC

Fig. 2.10-1: Output preview with toolbars, status line and output objects

In the status line of the cutting preview the following information is shown: contour, filling,

width and height, group or combination, the max. foil consumption in square meters
and running meter (rnm) as well as selected object features. If the output menu is

activated the data are transferred to the output device.

Indication: If the job to be cut is left, underneath or above the material- or table
preview and the output -menu is activated you will automatically be reminded that
the objects to be cut are out of range of the output.

Detailed description:
please refer to 5.7: The Preview Tools Toolbar
please refer to 5.8: The Preview Object Parameters Toolbar

2.10 Cutting - Milling - Creasing - Drawing …
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2.10.1.1 Material optimization 

The material consumption can be reduced by using the module Box nesting. The Box
nesting  ensures that all objects are arranged in such a way that they take up as little

space as possible during output. Rotating or not rotating objects ensures that material

consumption can be reduced.

Fig. 2.10-2: Parameter dialog for the material optimization

Indication: Groups and combinations are each regarded as an optimization object. If
this is not desired the grouping must be interrupted and the combination cancelled.

Following options are available:

Weed border distance

In this field the desired distance between the optimization objects, the so called weed
border distance can be set.

Material width

This value determines to which maximum material width the optimization should be
applied. If the working area is to be used, just click on the From working area button to

enter the corresponding width value.

Rotation of  objects

none

With this option, no objects are rotated; they are only optimized for the weed
boarder distance.

2.10.1 The Output Preview 
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to the shortest side

All objects are rotated so that the shortest side is downwards.

as required

During the optimization all objects are rotated so that they can be arranged saving the

most space.

Only selected objects

Only the selected objects are considered. With this option you can for example optimize

according to layers (colors).

Include bitmaps

If this option is activated, bitmaps and groups that contain bitmaps are also optimized.

2.10.1.2 Weeding lines 

Weeding lines serve for the better procession of large jobs. Material length or width of

several meters are difficult to handle, therefore, you can insert weeding lines during the foil

cutting that divide the job into smaller parts that are more easy to handle.

Fig. 2.10-3: Output job with weeding frame (dashed in blue) without weeding lines

2.10.1 The Output Preview 

78



Fig. 2.10-4: Example with 3 horizontal and 3 vertical weeding lines (dashed in red)

Fig. 2.10-5: Result of the output with weeding lines - objects not! cut

In the output preview there are 3 possibilities to insert horizontal and vertical weeding

lines.

Indication: Weeding lines can only be inserted if the option weeding frame has been
activated in the output dialog.

2.10.1 The Output Preview 
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1. Manually

Position the mouse cursor on the weeding frame dashed in blue around the objects. The

mouse cursor changes into a double-headed arrow. Now draw a horizontal or vertical

weeding line to the position where it should be segmented. Repeat the process until all

necessary weeding lines are inserted.

2. Via the menu options

Open the menu options and activate the menu item horizontal weeding line or vertical
weeding line.

The first weeding line is inserted in the middle of the objects to be cut. The second call up

of the function bisects the two halves in two more halves and so on.

3. Via the shortcuts h or v

An „h” or „v” directly entered via the keyboard generates the respective weeding lines - as

described in 2.

Tip: Single objects can be provided additionally with a separate weeding frame via
the right mouse menu.

2.10.1.3 Job Sectioning

Sectioning is the division of a job in so many parts (sections) that are necessary for the

complete output of the job.

If the job to be output is bigger than the set or the available output width (output dialog,

field width of material) of the output device in the information area of the output dialog

the indication „job will be sectioned“ is shown.

Indication: The terms sectioning and segmentation are used as synonyms.

The activation of the output menu then opens the following dialog before the transfer to

the device:

2.10.1 The Output Preview 
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Fig. 2.10-6: Sectioning dialog with overlapping of 3 mm

Optimize material (max. size + smallest at last)

Optimize … smallest at last) causes CoCut to create segments in the maximum

permitted size. The size of the last segment usually differs from the others

Optimize material (max. size + smallest at first)

Only active with flatbed cutters. If the last segment was also cut as last the plate could not

be processed until the end. Therefore, the remainder is cut as first so that the plate lies on

the table until the end.

Segment optimization (segments of equal size)

If the option segment optimization is activated always segments of the same size are
created.

Optimize segments by mark posiions

This option is activated as default with CoCut if video markers exist in the Job. The above
dialog is skipped and the preview of the dynamic segments is shown. The reason of this

optimization is that always at least 3 video markers are necessary. Depending on the
location of the video markers CoCut "searches" up to 30% next to the segment line if there

is a video marker. If yes, the respective segment is adjusted dynamically.  

Preset segmentation

The last used setting is automatically saved. When loading the job again this sectioning

can be accessed.

X-overlap and Y-overlap

Segmentation with overlapping - In the fields X- and Y-Overlap you can define how much

the segments shall overlap. The vectors are enlarged accordingly at the cutting points.

2.10.1 The Output Preview 
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Fig. 2.10-7: Foil optimization in the sectioning preview with 8 segments and information on

segment sizes

Selection and deselection of the segments

Selection and deselection of the segments is done by clicking into the segment. The red

checkmark indicates which segment is active and being output. 

Changing the suggested sectioning

You can change the sectioning by clicking on the blue section lines and move them to the

desired position with the mouse. If necessary CoCut inserts automatically new sections.

In the status line of the segmentation preview the size of the job to be cut in X- and

Y-direction and the number of segments are shown.

2.10.1 The Output Preview 
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2.11 Printing

Fig. 2.11-1: The print button in the standard toolbar

2.11.1 Without RIP Software

The following chapters explain in detail the single functions of the CoCut print dialog.

Open the CoCut print… dialog by selecting the menu item print in the file menu, via the

keyboard hotkey CTRL+P or by pressing the  button in the toolbox.

Fig. 2.11-2: The print dialog

In the down right part of the dialog you find the option tile and the adapt button and the
1:1 button under output. Depending on which option you have activated the appearance of

the preview of the print -dialog changes.

Indication: If the print -dialog is opened the adapt button is automatically active
because we do not assume formats that exceed the maximum output-size of the
device to be accessed as standard for the printing of objects or graphics.

2.11 Printing
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The adapt mode

The adapt-mode corresponds to the printable area. The values for the printable area are

shown in the field print area which is in the upper right part of the print dialog.

The preview window in the adapt mode

The preview window offers the possibility to check your job before printing. The edges of

the window are magnetic which means that if an object is approaching the edge of the

sheet the object stays at the edge of the window.  Thus, a faster positioning of the objects

in the corners or at the edges of the sheets is obtained.

Tip: If the magnetization of the edges shall be switched off, keep the SHIFT button
pressed while positioning your objects.

The x- and y-coordinates that are shown underneath the preview window express the

location of the left upper edge of the object on the working surface.

Mouse-functions in the preview window (adapt-mode)

Clicking once with the right mouse button or activating the preview button increases the

preview window to the maximum size of display.

Fig. 2.11-3: The print preview button

Fig. 2.11-4: Print preview in the complete picture mode

2.11.1 Without RIP Software
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Indication: The size of display depends on the set screen resolution (800*600,
1024*768, ...). Clicking again with the right mouse button resets the original status.

Indication: If the left mouse button is pressed and kept pressed, a dashed black
frame appears around the objects to be printed. This frame covers all objects that
are on the working surface and corresponds to the printing area.
Printable area and object

The fields Printable area and object are in the upper right part of the print dialog.

Fig. 2.11-5: Section field printing area and object

Printable area

In this field, the specified printing area with height and width values is shown.

Object

In this field the object/s to be printed with height and width values is/are are shown.

Indication: The fields for the percental enlargement of the objects are not active in
the adapt-mode.

One field below on the right side of the print dialog is the field printer.

Fig. 2.11-6: Printer selection and Setup

If you open the list you will get a list of all printers that are installed on your system. Select

the printer that you want to use. In order to do more settings for the printing activate the

setup button. The dialog that now opens corresponds to the menu item properties of the

respective printer file menu.

Indication: The print dialog that is opened by pressing the setup button depends on
the loaded printer driver and is therefore not further explained.

Right next to the setup-button the orientation of the sheet (portrait / landscape) can be set.

What is printed?

In the area named print mode are two combo-boxes in which you can define what shall be
printed. In the first list you can choose between the options objects, objects with
worksheet.

2.11.1 Without RIP Software
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Objects

All objects on the worksheet are printed.

Objects with worksheet

All objects and the worksheet (black frame) are printed. Underneath the black frame the

company´s name, the dimensions of the working surface and the proportion in which it

shell be output are also automatically printed.  

All objects

All objects that are on the working surface are printed.

Selected objects

Only objects are printed that have been marked on the working surface.

Ratio

Here, you have the possibility to enter the printing proportion as numeric or percentage

values.

Indication: Both fields are coequal which means that if a numeric value is entered
the corresponding percentage value is entered automatically in the dedicated field
and vice versa.

Fig. 2.11-7: Field for the entry of the size proportion

Examples for the indications of proportion with the corresponding percentages:

Proportion 1 : 1 corresponds to 100.00 %

Proportion 1 : 2 corresponds to 50.00 %

Proportion 1 : 3 corresponds to 33.33 %

Proportion 1 : 4 corresponds to 25.00 %

Centered

If this option is activated all objects on the working surface are centered.

Tiling

If this option is chosen the print -dialog appears in the tile mode.

2.11.1 Without RIP Software
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Number of copies

In this field the number (max. 9999) of the exemplars to be printed can be defined. The

buttons adapt and tile enable switching between the two modi with the same name.

1:1

If this button is activated all objects on the working surface are displayed in their original

size in the preview window and output.

Adapt

If this button is activated all objects on the working surface are downsized so that they can

be shown completely in the preview window.

Options

Output to file - Print to file

If this option activated, print data is redirected to a file.

Contour mode

With this option activated all objects are printed like shown in contour mode - without

filling.

Also print colored worksheet

When selecting this option the background color defined for the working surface is also

printed.

Print subsidiary lines

If the job to be printed contains subsidiary lines they are also printed.

Always print black

This option becomes automatically active if in the first list all objects and in the second list

color separated printing (after the layer order) or print single colors (after single layers)

was selected.

Indication: If you want to print the objects on the working surface in color the option
always print black must be deactivated.

Register-/ Jog-Marks

This option becomes automatically active if in the first list all objects and in the second list

color separated printing (after layer order) or print single colors (after single layers)
was selected.

2.11.1 Without RIP Software
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Indication: If you do not want to also print register and jog marks this option must
be deactivated.

2.11.1.1 The Tile Mode

If you switch from the adapt mode to the tile mode the preview window appears as

follows:

Fig. 2.11-8: The preview window in tile-mode

In the tile mode all tiles are shown. A tile is that part of the object that can be output on the

device to be accessed.

The option pause after indicates after which tile (enter amount of tile) the output shall be

interrupted. The fields overlapping (mm) serve for the entry of the desired horizontal and

vertical overlapping of the objects to be printed.

When printing to roll (option Roll), whole lanes can be printed without having spaces

between the single tiles.

Indication: Only the print of a whole lane can be interrupted and not the printing of a
single tile. The entry of an overlapping in feed direction (print direction) has no
influence on the roll which can also be seen at the display of the size of the tile.

2.11.1 Without RIP Software
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After the tiling the dialog is not closed automatically as it is an advantage to directly
compare the print and the preview. In addition, thus you can directly repeat the print of a

specific tile.

Mouse function in the preview window (tile mode)

One click with the right mouse button on the tile preview increases the tile display. This

can also be done by clicking on the -button in the upper left area of the window. Clicking
once again with the right mouse button resets the original status.

If you double click with the left mouse button on a tile this one will be deactivated which

means it will not be printed.

Double clicking with the left mouse button while pressing the SHIFT button leads to the

inversion of the tiles which means that the tiles that have been deactivated before become

now active (printed) and the tiles that have been active become deactivated (not printed).

The objects within the preview window can be shifted by means of the mouse. The window

edges are magnetic which means that when the object is approaching the edge of the

sheet the object remains clinged. When pressing the SHIFT button the magnetization is

released.

Example for the printing in the tile mode

The following example explains the single functions, shortcuts,... in the tile mode in detail.

The tile mode offers the possibility to print in any size which means each graphic,

independent of the size can be printed on the connected output device. For the print of

your graphic you do not need a printer with which DIN A2-, A1-, A0- or even large size can

be output. 

How?

The graphic to be printed is divided in so many segments (tiles) that are necessary to be

able to output the graphic on the connected output device. The amount of necessary tiles

depends on the size of the graphic to be output and the pre-defined output format (DIN A3,

A2, ...). The setting of the output format is done via the set button CoCut print dialog and

depends on the connected output device.

Load any graphic in CoCut and open the print dialog, either via the file menu by selecting

the menu item print..., via the keyboard with the key combination CTRL+P or via the
button in the standard toolbar.

The CoCut print dialog is opened in the adapt mode. Activate the tile mode by activating

the thus named button.

The print dialog appears as follows:

2.11.1 Without RIP Software
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Fig. 2.11-9: The print dialog in the tile mode

In the upper right corner of the dialog you find the two fields tile and object.

The field tile corresponds to the field print area in the adapt mode. The other fields in the

right part of the print dialog are the same as in the adapt mode.

Fig. 2.11-10: Preview with settings in the tile mode

Activated and deactivated tiles

An active tile is a tile that is not marked with a red „X”. Deactivated tiles on the other hand

are marked with a red „X”.

2.11.1 Without RIP Software
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Fig. 2.11-11: Bottom row: Tiles deactivated

The deactivation or activation of a tile is done by double clicking with the left mouse

button which means when double clicking on an active tile it becomes deactivated.

Another double click on the same tile activates it again.

In the previous figure you can see that the lower row of tiles is marked with a red „X”.

These tiles were deactivated and will not be printed.

In the tile mode you do not only have the possibility to activate / deactivate single tiles.

Tip: Keep the CTRL button pressed while double clicking with the left mouse button
on the desired tile and all tiles where the mouse cursor is are deactivated.

2.11.2 With Pjannto RIP software

Fig. 2.11-12: The Pjannto RIP button in the standard toolbar

Indication: Pjannto RIP is a professional PostScript-RIP that is not a part of CoCut. If
a license was purchased from Pjannto RIP and the software is installed on the same
computer the Pjannto RIP button is automatically embedded in the standard toolbar
of CoCut and the file menu enlarged with the entry Pjannto RIP… .

2.11.2 With Pjannto RIP software
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3 Reference Part

The menu items in chronological order:

3.1 The File Menu

3.1.1 The New… Command

With the New command a new job is opened. CTRL+N

3.1.2 The Open… Command

With this command the files that were stored on your hard drive or another

data carrier in the CoCut JOB file format are brought onto the current screen

/ desktop. You can further edit this file. Jobs can be deleted after a safety

query.

 CTRL+L

3.1.3 The Save Command 

With this command you save the current job. If the respective job has

already been stored before, the given file name and the directory are kept.

The older version of the job is overwritten so that the old version can not be

restored any more.

If you have created a new job that has not been saved before, the program,

if you have clicked the save command in the file menu, goes automatically

to the command save as… .

First, the job info dialog is opened where you can enter more information

about the job. Then, the real dialog for saving your job is opened and you

are asked to enter the file name and select the directory.

CTRL+S

3.1.4 The Save as… Command

With this command you save a new job under a file name chosen by you in

a directory to be selected. This command is also for changing the file name
and / or directory of already existing files. If for example you want to save a

job that is build up on an older one without losing the old version then you
select the command save as ... and you can save the new job under

another name in a new directory if you wish to.

The command save as... is also to be selected if you want to save the

current job onto another data carrier. To do so, select the appropriate disk
drive.

SHIFT+
CTRL+S
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3.1.5 The Send by Email… Command

This command opens the standard email client and links the current job as

attachment to the email. The job must be saved before.

3.1.6 The Import… Command

With this command files are imported into CoCut. Known file formats are

shown in a list.
CTRL+I

3.1.7 The Export… Command

If you want to use a job also in another program the job file must be

converted into a suitable format which means exported.
CTRL+E

3.1.8 The Send to RIP… Command

With this command the PostScript RIP is started, if it was installed and

activated (licensed) before.

Note: This menu entry is only visible, if an EUROSYSTEMS RIP had
been installed and activated (licensed) before. Then the RIP-Setup in
CoCut Professional XT must be processed: please refer to 3.6.1.3:
The RIP… Setup

3.1.9 The Print… Command

With this command you print the current file in any size (tiles) on the

standard printer.
CTRL+P

3.1.10 The Output… Command

With this command you call the output module (Plot Manager) for cutting,

drawing or milling.
S

3.1.11 The Quit Command

With this you terminate CoCut and return to the Windows desktop. If you
have not saved the job that is currently being edited, you will be asked if you

want to do so.

CTRL+Q

3.1.12 The Job History

The Job History function facilitates the loading of the 4 last jobs without

having to pass via the directory tree. At the end of the menu list of the file
menu the names of the 4 last edited jobs appear. Click with the mouse
button on the desired job name. Then, the selected file will be loaded on the

3.1.5 The Send by Email… Command
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3.2 The Edit Menu

3.2.1 The Undo Command

With this command it is possible to undo the last done operations and

functions. The default setting is 5 steps. This default value can be changed

via the settings menu, menu entry standard settings / miscellaneous and

here undo levels. The maximum value is 100 steps.

Indication: This setting can only be changed with a new file (file menu,
menu item new)!

F5

3.2.2 The Undo Stack… Command

This command opens a window with the last used commands. Most

intermediate states are previewed. By clicking on the respective command

this state is restored.

Note: This menu entry is only displayed, if restorable commands are
used.

SHIFT+F5

3.2.3 The Redo Command

This command is the reverse command to undo. It restores the status that

was there before the undoing.
F6

3.2.4 The Redo Stack… Command

This command opens a window with the last commands, which were made
undone. Most intermediate states are previewed. By clicking on the

respective command this state is restored.

Note: This menu entry is only displayed, when commands were
undone.

SHIFT+F6

3.2.5 The Cut Command

With this command objects are copied to the Windows clipboard and deleted

from the working surface. Via the clipboard objects can be inserted at
another place or in another program.

Indication: For the transport of your data you can also use the export
command. This is always necessary if your data shall be transferred to
another computer.

CTRL+X

3.2 The Edit Menu
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3.2.6 The Copy Command

With this command marked objects are copied to the clipboard without

deleting them from the working surface.
CTRL+C

3.2.7 The Paste Command

This command inserts graphics and objects from the clipboard to your job.

The mouse cursor changes to a right angle in which insert is written.

Now point the tip of the right angle to the point on your working surface

where the graphic or the object shall be inserted.

CTRL+V

3.2.8 The Paste Special... Command

Via this menu item "pictures" can be imported from the clipboard to CoCut.

Indication: If in CoCut objects are copied this menu item is not active.

3.2.9 The Select All Command

With this command all objects of the active job which means all objects on

the working surface and also outside the working surface are marked. The

selected objects can then be grouped, combined or moved.

CTRL+A

3.2.10 The Reverse Selection  Command

With this command all non-selected objects are selected. Already selected
objects will be unselected.

SHIFT+E

3.2.11 The Job Info… Command

With the job info you have the possibility to save additional information with
every job. You can print this information and use them for invoicing or as

accompanying working sheet.

Next to this information as for example order number and company
address the job-info also gives information about the used material.  In the

memo-field additional comments in note form can be stored.

3.2.12 The Color Layer… Command

This command starts the layer settings dialog in which objects are colored,
foil colors are defined, device tools are assigned, objects of the same color
are selected and layers can be made invisible or blocked.

L

3.2.6 The Copy Command
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3.2.13 The Multi Copy… Command

This command serves the generation of any number of object copies (duplicates) on the

working sheet. Number, Offset and more can be set in a dialog.

Detailed description: please refer to 5.4: The Object Parameter Toolbar

3.2.13 The Multi Copy… Command
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3.3 The Design Menu

3.3.1 The Rotate Axis Command

This command rotates the marked objects at 90° counter-clockwise.

This option is always necessary if you want to adjust your objects fast to the

rolling direction of the foil without having to go via the rotate function.

A

3.3.2 The Rotate Axis With Page Command

This command rotates the marked objects with page at 90°

counter-clockwise.
SHIFT+A

3.3.3 The Horizontal Mirror Command

The selected object is mirrored at its horizontal through its center point. If

several objects are marked, the center point of the virtual checkbox whose

edge is limited by the 8 black dots with the corresponding horizontal is taken

as axis of reflection. If no objects are marked all objects are mirrored.

X

3.3.4 The Vertical Mirror Command

The selected object is mirrored at the vertical through its center point. If

several objects are selected the center point of the checkbox with its

corresponding vertical is used as axis of reflection. If no objects are marked

all objects are mirrored.

Y

3.3.5 The Delete Command

Pressing the DEL key executes the delete command. In order to delete

particular objects from your graphic they must be marked.
Del

3.3.6 The Mirror on the X Axis Command

 All selected objects will be mirrored at the visible X-coordinate axis. SHIFT+
X

3.3.7 The Mirror on the Y Axis Command

 All selected objects will be mirrored at the visible Y-coordinate axis. SHIFT+Y

3.3.8 The Duplicate Command

In order to use this command the object to be duplicated must be marked

before. Now click with your left mouse button on the duplicate command or
activate it via the hotkey. The marked objects are now doubled.

CTRL+D

3.3 The Design Menu
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The positioning is done according to the values that you have entered in the
settings menu, menu item standard settings / miscellaneous.

Indication: You can also duplicate an object by first marking it, moving
it with the left mouse button kept pressed and then press the right
mouse button once at the position where the duplicate shall be
created. The displacing values are entered automatically with this
procedure.

please refer to 5.4: The Object Parameter Toolbar

3.3.9 The Clone Command

If you clone an object you create a copy linked to the object. Modifications at

the original (the initial object) are automatically done at the clone (the copy). 

If a clone is modified in its size or form, an other "original" is created.

3.3.10 The Group Command

This command allows combining several objects to a group in order to edit

them together. This can be wise if for example you want to move several

objects without changing their position to each other. To do this, first mark

all objects that you want to move together, select the group command and

then move the newly created group to the desired place. Now, it is not

possible any more to change the single objects that form the group

independently from each other. 

In order to make this possible again the grouping must be broken with the

break group command. 

CTRL+G

3.3.11 The Break Group Command

This command is used to divide a group of objects again into single object.
Each object can then be edited individually.

CTRL+B

3.3.12 The Combine Command

This command combines like the grouping several objects to one. The
difference to the group command is that the selected objects are not

regarded as single isolated objects lying next to another anymore.

Let us explain this fact with an example.

You have created two squares with different sizes, the smaller one lying

completely within the bigger one. In order to obtain that in the
full-color-mode the area of the smaller square is transparent you combine
the two squares after having marked them before. The size of the bigger

square is now interpreted as outer edge and the smaller one as inner edge.

SHIFT+K

3.3.8 The Duplicate Command
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The area between the two edges is filled with the color selected in the layer
box. In the middle, a hole with the size of the smaller square remains.

3.3.13 The Break Combination Command

With this command you cancel a combination. Now, the program treats the

combination objects as single objects again.
SHIFT+L

3.3.14 The Fill Function

With this function vector objects and text blocks can be filled.

None
All fillings respective filling bitmaps of the marked object are removed. Only

the contour of the objects remains in the previously defined layer color.

The Layer color… command

This command removes all fillings and shows the object in the layer color in

which it was created.

3.3.15 The Contour Function

Via this function objects can be provided with pen attributes (width of pen,

color,...), hairlines can be created and pen attributes removed.

The none command

This command removes all pen attributes of the marked object and shows it

in the color in which it was created.

The hairline command
This command allocates a hairline to the marked object in the momentarily

active layer color.

The layer color command

This command assigns selected layer color to object contour.

Indication: The pen attributes have no influence on the display of the
objects in the contour mode (F9). Here, the contours of the objects are
drawn with a simple contour line in the layer color.

3.3.16 The Draw Command

In this menu the tools with which you can create graphic objects are
summarized. All tools can be activated via the toolbox or the menu item
draw in the object menu.

3.3.12 The Combine Command
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3.3.16.1 Rectangle

You have switched to the rectangle-mode and move the mouse cursor on

the desktop to any corner of the desired rectangle.

Press the left mouse button and keep it pressed while moving the mouse

cursor to the diagonally opposite corner. If you let got the mouse button the

rectangle appears.

Indication: If you keep pressed the SHIFT key while drawing a
rectangle the first selected point is the center point of the rectangle. If
you keep pressed the CTRL key while drawing the rectangle the
movement of the mouse automatically draws a square. Pressing
simultaneously the SHIFT and CTRL kex draws a centered square. For
drawing the object the status of the keys (pressed or not pressed) is
important when letting go the mouse button.

3.3.16.2 Circle

With this command you activate the mode for drawing the ellipses and

circles. In this mode you open up a box in which the ellipse is adapted. So,

first select a corner point of the box to be opened up with the mouse.

Indication: The first drawn point is no point of the ellipse. Only if you
press the SHIFT key the starting point becomes the center point of the
ellipse.
Pressing the CTRL key only allows the drawing of a circle. Pressing
simultaneously both keys results in the drawing of a centered circle.

3.3.16.3 Line - 4 Modes

3.3.16.3.1 The Line Mode

This command activates the mode for the drawing of lines. The mouse
cursor has now the shape of a cross with a line shown on the down right.

For the drawing of lines two modes are available:

1. "Closed" Lines
You can create closed lines by keeping pressed the left mouse button when

drawing the line. You terminate a line by letting go the left mouse button.
If the mouse cursor is beyond an ending point of a line it will be highlighted

and the mouse cursor changes its form. If you click now once with the left

mouse button on this point, this point will be initialized.
Now you can continue to draw with one of the following four modi: draw,
curve, digi mode, freehand.

2. "Open" Lines
You can create open lines by clicking once with the left mouse button before
drawing. Then, you create the line according to your wishes. If you now click

3.3.16 The Draw Command
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once again with the left mouse button the subline is finished and a new one
can be attached. This mode is terminated by double-clicking with the left

mouse button.

Indication: If you keep pressed the SHIFT key while moving the mouse
cursor the drawing of the straight line is limited horizontally and
vertically. If while drawing you keep pressed the CTRL key the angle of
the drawn straight line is limited to 15° steps. The straight line now
moves at 15°, 30°, 45°, ... to the edges of your working surface.

3.3.16.3.2 The Circular Arc Mode

You activate the circular arc mode by pressing the right mouse button in the

line mode and select there the respective menu item.

When drawing in the circular measure after placing the second curve

point the curve calculated from the first, second and current cursor point is

drawn. One click with the left mouse button places the curve.

If the mouse cursor is above an endpoint of a circular arc it will be

highlighted and the mouse cursor changes its form. If you click now once

with the left mouse button on this point, this point will be initialized. 

Now you can continue to draw with one of the following four modi: draw,
curve, digi-mode, freehand.

3.3.16.3.3 The Digitize Mode

With this command you activate the mode for post-digitizing bitmap

templates.  

Switching between the modi line, curves, digi-mode or freehand via the

right mouse menu, the arrow keys of your keyboard or the toolbox facilitates

the post-processing enormously.

Assignment of the arrow keys:

Left -->Line mode

Right -->Circular Arc
mode

Up -->Freehand mode

Down-->Digitize mode

If open objects have been drawn they can be closed via the right mouse

menu and there the menu item close. Indication: with this option all
marked objects can be closed independent of the distance between the
starting point of the first drawn and the endpoint of the last drawn
object.

Another possibility to close open objects that have been drawn is the
following:

Draw an open object. Move the endpoint of the last drawn object with the
mouse near the starting point of the first drawn object. You can see that the

3.3.16 The Draw Command
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mouse cursor changed its appearance. If you let got the mouse at that point
the object will be closed. 

If the mouse cursor is above an endpoint of a digi-curve/line it will be

highlighted and the mouse cursor changes its form. If you click now once

with the left mouse button on this point, this point will be initialized. 

Now you can continue to draw with one of the following four modi: draw,
curve, digi mode, freehand.

3.3.16.3.4 The Freehand Mode

With this command you activate the mode for the drawing of arbitrary lines,

curves or objects. Keep pressed the left mouse button and create the object

of your choice. Let go the left mouse button to terminate the object. If the

mouse cursor is above an endpoint of a digi-curve/line it will be highlighted

and the mouse cursor changes its form. If you click now once with the left

mouse button on this point, this point will be initialized. 

Now you can continue to draw with one of the following four modi: draw,
curve, digi-mode, freehand.

3.3.16.4 Register Mark

With this option you can place register marks as administer help in your

graphic. This function enables the accurate mounting of the color separated

cutting job. To do so, activate this command and click the register marks to

the desired positions. Register marks are cut along layer neutral (color

neutral).

If open objects where drawn, they can be closed via right mouse button with

menu item Close.

3.3.17 The Align… Command

With this function objects are aligned - relative to the working sheet or other

objects You can align the objects horizontally or vertically. The objects are
arranged in that way that they are either centered or aligned at the desired

side.

In addition, the objects can be aligned with the same distance so that a

steady appearance is obtained.  It is also possible to center all objects
horizontally or vertically on the working sheet.

Indication: If not aligned to the worksheet, then aligned to the last
selection.

R

3.3.18 The Sort With Simulation… Command

This command opens the object sort function with which the output order

and direction of rotation of the objects can be defined. The sort can be
done dependent or independent of layers. Also, the preferential direction

of the sort can be defined.

CTRL+F10

3.3.16 The Draw Command
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In a preview the output of the object is simulated graphically; here, the
traverse path of the tool head can be sketched. The simulation can be

repeated unlimited without changing the original objects.

3.3.19 The Sort Manually… Command

This command enables a manual object sortation. For every single output

object the order and direction of rotation can be defined. This can be done

for every layer. In the preview window the objects are clicked to the

desired order with the mouse cursor. Alternatively, the objects can also be

sorted by clicking in the object list. The sorted objects are shown dashed

in blue. 

CTRL+F11

3.3.20 The Clockwise Command

This command sets the direction of rotation of the marked objects to

clockwise.

Indication: This function is only relevant in connection with a
connected milling or engraving device.

>

3.3.21 The Counterclockwise Command

This command sets the direction of rotation of the marked objects to

counter-clockwise.

Indication: This command is like the previous only relevant in
combination with milling applications.

<

3.3.22 The Close Contour Command

With this command open objects can be closed. You can see in the status
line if an object represents an open track or not. To close it you mark the

object and use that command.

SHIFT+S

3.3.23 The Open Contour Command

With this command closed objects can be opened.

Indication: The menu item open contour corresponds to the separate
function in the node tool.

SHIFT+O

3.3.24 The Round Corners… Command

The round corners command rounds down nodal points with a freely
defined radius. 

The rounding can be done inwards or outwards. The rounding can also

SHIFT+
CTRL+R

3.3.18 The Sort With Simulation… Command
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affect the whole object or just single nodes.

Indication: This function can also be used for the rounding of font
characters.

3.3.25 The Delete double lines command

This function combines the Welding function with the Close objects
function. All vector objects whose distance from the start and end point lies

within the closing tolerance are automatically closed or connected. 

Note: This function is particularly useful when outputting data on a
laser, as double traverse paths are avoided. The output time is also
reduced for cutting plotters and milling machines.

SHIFT+D

3.3.26 The Convert to Grid Lines Command

This function converts a grid of rectangles lying exactly on top of each other

into a sorted line grid without double lines. All double lines are removed and

merged into one continuous line. Ideally, the travel paths are optimized and

the cutting direction is alternating.

Example: please refer to 6.3: Convert into Grid Lines (Example)

3.3.27 The Insert Bridge Command

Bridges are intended to prevent milled parts from falling out. Parts of the milling contour

remain, the length and number of which can be specified individually. The position of the

manual bridges can also be changed. Bridges are inserted for all selected objects.

Note: In the node mode, bridges can be added precisely to a point. 

3.3.28 The Weeding Border Command

This command generates a so-called weeding border or frame around one

or more selected objects. A weeding border facilitates weeding of the vinyl

from the carrier.

3.3.29 The Object Properties… Command

A click on the Object Properties… menu opens the Object Properties dialog. This
dialog informs about the Object Type and gives the Coordinates of the bounding box of all

selected objects. Restrictions can be set for the selected objects, such as No output to

device, Hidden, etc. In addition, a name can be assigned. This can be used to customize
objects and apply macros to them. For example, object groups with a certain name can be

switched to Hidden. Attributes that are assigned to the objects are displayed and can be
switched off if required, e. g. the attribute Video mark. In summary, it can be said that all
object-relevant information is accessible at this point.

3.3.24 The Round Corners… Command
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Note: This command corresponds to the Object Manager in the sidebar.

please refer to 7.5.2: The Object Types Tab

please refer to 7.5.4: The Attributes Tab

3.3.29 The Object Properties… Command
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3.4 The View Menu

3.4.1 The Zoom In Command

If you select this function the mouse cursor changes into a lens with a plus

inside. You can now select an area that shall be zoomed by keeping

pressed the left mouse button. The selected area will then be shown

increased to the maximum in the program window.

Indication: A beep of the computer loudspeaker informs you that the
maximum zoom is reached.

+(NUM)

or  F2

3.4.2 The Zoom Out Command 

This function decreases the working surface gradually. If it had been

zoomed repeatedly before, the single zoom steps are carried out backwards.
-(NUM)

or  F3

3.4.3 The Full Page Command

Select the function so that the whole available working surface is shown. B

3.4.4 The Show All Command

This function changes the display of the vector drawing in this way that all

objects can be seen in the program window. The section is chosen in that

way that it is the biggest possible display of the graphic showing all objects.

Indication: If you keep pressed the SHIFT key while doing this
command only the marked objects are zoomed to maximum.

F4

3.4.5 The Show Selected Objects Command

If this command is activated only the objects marked on the working

surface are displayed as big as possible.
SHIFT+F4

3.4.6 The To Front Command

If you have arranged several objects on top of each other the following

commands enable you to modify the location of the objects to each other.

With the to front command the marked object is set on the top place above

the others.

CTRL+O
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3.4.7 The To Back Command

With this command you set the marked object underneath respective behind

all other objects.
CTRL+U

3.4.8 The Forward One Command

This command sets the marked objects further front in the display. PgUp

3.4.9 The Back One Command

With this command you set the marked object further down and thus further

back in the display.
PgDn

3.4.10 The Reverse Order Command

The order of the objects in the stack is reversed. What was lying on top then

lies at the bottom and vice versa. This also applies for all objects

in-between.

U

3.4.11 The Change Order Command

With this command you can change the order of the objects in the display

interactively by clicking the object contours one after another in the desired

order.

Note: If all contours are to be taken into account, the grouping of the
objects must be broken or the combination of the objects must be
broken as well.

SHIFT+R

3.4.12 The Contour View Command

This command switches the display of the working surface to the contour

mode which means that only the contours of the objects are shown.
F9

3.4.13 The Enhanced View Command

With this command you can obtain the best possible display of the objects

(smoothened contours).

Indication: It slows down the speed of processing and should
therefore only be used for the last check or presentation.

SHIFT+F9

3.4.7 The To Back Command
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3.4.14 The Always on top Command

The CoCut window remains always in the foreground.

Indication: This menu item is only active if the CoCut window is in the
window mode.

CTRL+Y

3.4.15 The Refresh Screen Command

With this function the content of the visible window is build up again without

changing the size or the selected section.

Indication: Use this command if objects on the screen are visible that
cannot be accessed by the arrow tool or if display errors of another
kind occur.

CTRL+W

3.4.14 The Always on top Command
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3.5 The Tools Menu

3.5.1 The Contour Line… Function

With the contour line function the outer edge of arbitrary many objects is

calculated and provided with a contour. Contrary to the outline with this tool

also bitmaps can be contoured. In addition, not every single object is

contoured but it is tried to find only one contour that comprises all selected

objects. Therefore, this function is especially suitable for the creation of

intersection lines around labels. The objects of the label can be arranged

arbitrarily. Afterwards, with the tool described here the contour of the label in

the desired distance is calculated. The thus created contour can be used

later for cutting the printed label.

Detailed: please refer to 2.7: Excursion: Contour vs Outline vs
Contour Line

K

3.5.2 The PhotoCut… Function

The function creates vectors from bitmaps. PhotoCut calculates from

Windows Bitmap files (*.BMP, *.PCX, *.TIF) grids or patterns that can be

output with a cutting plotter or a similar device. The picture is divided into

logical pixels and the average gray value calculated for each of these logical

pixels. So, a picture is created that has less pixels than the original. Out of

this picture horizontal or vertical stripes, circles, squares, ... are created

whose width is proportional to the gray value at the respective position.

please refer to 6.12: The PhotoCUT Function

3.5.3 The Set Jog Marks Command

This command automatically sets jog marks around the selected objects.

Type, size and position relative to the selected objects are pre-set in

settings / standard settings / register / jog marks menu.

Indication: The markers do not lie in a layer, are always displayed in
black, keep their scaling and size and are grouped when being created.

SHIFT+J

please refer to 3.6.1.4: The Register / Crop Marks… Setup

3.5.4 The Search / Replace Video Marks Command

With this command circle objects in an import file - with an in the
Register-/Jog Marks menu entry defined size - are searched and replaced
by video marks.

3.5 The Tools Menu
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Note: This option can also be set as a standard via the Settings /
Standard Settings / Import menu entry.

3.5.5 The Measure Command

With the function measure an arbitrary track can be measured, scaled,

rotated and dimensioned. If you have activated this command the mouse

cursor changes into a reticle. It is then set at the starting point of the track to

be measured and the mouse button pressed and kept pressed. Then, the

mouse cursor is moved to the end of the track to be measured and the left

mouse button let go. With the SHIFT key pressed you only measure

horizontal and vertical distances. Now, the result of the measurement is

shown in a dialog field and can be modified.

Indication: The modification of the size is applied proportionally to all
selected objects. When rotating bitmaps the area of the bitmap
increases but not the objects displayed in the bitmap.

M

3.5.6 The Box Nesting… Function

This optimization takes care that all objects are arranged in a way that they

take the least space on the output. By rotation or no rotation of objects it is

taken care of that the waste of material can be reduced.

please refer to 2.10.1.1: Material optimization

3.5.7 The Outline… Function

This function creates a contour with a distance around a vector object to be

freely selected and is mostly used for contouring text objects. The color of
the target layer can be pre-selected. Inline, the reverse function creates a

contour lying inwards. „Outline & Inline” combined creates a closed
contour in the pre-selected strength. 

Indication: Contrary to the contour with combined objects
simultaneously an inner contour is created. This function is not to be
confused with a contour pen that only is a drawing attribute and no
vector object.

O

3.5.8 The Welding Command

The merge functions manually, automatically, trimming, open trimming,
fill, by color, full area and screen printing take care that overlaying object

parts what would cut the foil are eliminated and connected.

W

please refer to 6.7: The Welding Tool

3.5.4 The Search / Replace Video Marks Command
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3.6 The Settings Menu

3.6.1 The Standard Settings Menu

Fig. 3.6-1: Default Settings dialog - here: Miscellaneous tab is active

3.6.1.1 The Miscellaneous… Setup

3.6.1.1.1 Duplicate values

- X offset

Indicates the value that remains between the original and the duplicate (in

X-orientation) after the creation of a duplicate.

- Y offset

Indicates the value that remains between the original and the duplicate (in

Y-orientation) after the creation of a duplicate.

- Dynamic adaptation Option

This option takes care of the switching on or off of a function that

automatically enters and uses the duplication values as X- or Y- orientation

when duplicating with the right mouse button.

3.6.1.1.2 Move objects

CTRL+J
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- X increment

Indicates the value how much the marked objects are moved or displaced

when pressing the arrow keys on the keyboard.

- Y increment

Indicates the value in Y-orientation how much the marked objects are moved

or displaced when pressing the arrow keys on the keyboard.

Indication: If you keep pressed the SHIFT key during the movement,
the value of the displacement is reduced to a tenth part. If you keep
pressed the SHIFT + CTRL key the displacement is a hundredth of the
set step size.

3.6.1.1.3 Undo function

- Max. undo levels

Refers to the undo function in the edit menu.

Indication: This option can only be set if no job is loaded.

- No undo / redo for bitmaps larger than ... MB

For bitmaps that are bigger than the value set in this field the

undo/redo-function is automatically switched off which means that the

operations on this bitmap cannot be made undone.

Advantage: saving of time.

Reason: The expenditure of time (computational expenditure) for bitmaps

from a specific size onwards becomes too big as for every undo / redo step

a copy of the original (initial state) must be created.

The value that is entered in this field should be between 5-10% of the RAM

available in the computer.

3.6.1.1.4 Program start

- Info window

When the program is started, an information window is displayed in front of
the workspace, which informs about news, updates, etc., if there is a

connection to the Internet.

The 3 options are: Display always, Do not show again, Only display
when new.

Recommendation: With „Only display when new” you do not miss any
important information regarding CoCut.

3.6.1 The Standard Settings Menu
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3.6.1.2 The Mouse… Setup

3.6.1.2.1 Mouse action

- <Ctrl> + right mouse button assigned with:

Here, you can define the assignment of the right mouse button. To do this,

open the selection list and select the command that shall be carried out

when clicking once with the right mouse button.

- Click Delay

This option increases the accuracy when selecting objects. The default

value is 100; the unit is millisecond. The higher this selected value the

longer it takes until the object follows the mouse cursor. An accidental

displacement of the objects is thus decreased.

Note: Users that are not so sure with the handling of the mouse should
increase this value.

- Scroll window automatically Option

This option is switched on by default and takes care that whenever an object

is moved above the edge of the working surface with the mouse, the working

surface automatically is moved, scrolled.

3.6.1.2.2 Mouse Wheel

These options ease the navigation on the CoCut desktop with computer

mice, which are equipped with a mid-wheel button. 

- <Shift> toggles these modes

Two modes are possible: Zoom or Vert. Scroll.

Zoom

This option - starting from the cursor position - increases or decreases the

working area when turning the mouse wheel: according to the direction of

rotation.

Scroll vert.(ical)

This option - starting from the cursor position - moves the working area

horizontally (Wheel + CTRL key) or vertically when turning the mouse wheel.
According to the direction of rotation the movement is done to the left, top or

bottom or to the right, top or bottom.
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- Resolution

The sensitivity of the wheel can be adapted to individual requirements. The

range is from 1 (coarse) to 10 (fine).

3.6.1.3 The RIP… Setup

Standard RIP

As an extension to CoCut Professional XT, 1 RIP is provided by default:

EuroVPM

EuroVPM

This option must be enabled from the EuroVPM licensee. Using the ...

button, goes to the folder containing the EuroVPM.exe.

3.6.1.4 The Register / Crop Marks… Setup

Fig. 3.6-2: Default Settings dialog: here: Register / Crop marks tab active

3.6.1.4.1 Registration marks (Print & Cut)

Fig. 3.6-3: Different register marks depending on the manufacturer
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- Type

The Type list field is used to select for which manufacturer or for which

device register marks are to be generated.

Note: Only the options supported by the selected device are active!

- Alignment

Align to selection

If the Align to selection option is activated, the register marks are aligned

relative to the selected objects.

Align to page margin

If the Align to page margin option is activated, the register marks are

aligned relative to the border(working surface).

- Target layer

The Target layer determines in which layers the register marks are placed.

Note: This also indirectly determines with which tool the register
marks are edited, if a tool assignment has been made via the layer.

- Outside corners

The Outside corners option determines whether or not the outside lying

corners are taken from the object to calculate the distance.

- Emit marks (or by pressing <Ctrl>)

The Emit marks option determines whether the register marks should be

taken into account when outputting the data, that is, print, cut or mill.

If, in the output dialog, the CTRL key is pressed before clicking the preview
key or the output key, the register marks will be given out as well.

- Size

This option determines the size of the register marks.

Note: Maximum and minimum size are dependent on the device
manufacturer.

- Offset to object

The Distance to object option determines how close the register marks are
to be positioned in relation to the objects.
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- Distance to page border

The Distance to page border option determines how close the register

marks should be positioned to the edge of the page.

- Line thickness

The Line thickness option specifies the width of the lines of the register

marks.

Note: Maximum and minimum line thickness which can be used
depends on the cutting system.

- Max X distance

The Max X distance option determines how far the maximum distance

of the register marks in the X axis should be related to the objects.

- Max Y distance

The Max Y distance option determines how far the maximum distance of

the register marks in the y axis should be related to the objects.

3.6.1.4.2 Alignment marks

With this function you can place alignment marks as a weeding help in your

graphics. This function makes it easy to accurately fit color-cut cutting jobs.

Practice

Click on the Alignment mark icon in the drawing toolbar and set the

marks on the desired positions.

By default, the CoCut alignment mark consists of a square with two

diagonally extending lines inside the square, which resemble a cross. The

result is 4 triangles, which can be used to precisely apply two films of

different colors.

Note: Alignment marks are cut-layer-neutrally, provided there are cut
objects in the layer.

- Size

In the Size field the desired size of the alignment mark is defined.

- Cut without cross Option

If this option is activated, only the square is used as an alignment mark. The
diagonal lines inside the square are suppressed. This option is used when

only 2-colored signs are to be processed.

3.6.1 The Standard Settings Menu

118



3.6.1.4.3 Crop marks

Crop marks are markers used when printing. They are located outside the

print space. They show where exactly the sheet has to be cut. The crop

marks are located at the corners of the sheet.

- Size

Here is set the size of the crop marks.

- Offset to object

Here, the distance between the crop marks and the objects is determined.

- Line thickness

Here, the thickness of the crop lines is determined.

3.6.1.5 The Weed Border Setup

This command creates a frame around one or more selected objects. An

additional frame facilitates the release of the cut objects from the carrier

material (Weeding).

3.6.1.5.1 Manual Weed Border

Manual, because by selection is determined, around which which objects a

frame is placed.

- Uniformly Page Distance

Here, a uniform distance from all 4 object sides to the weed border is

established. 

- Different Page Distance

Here, a non-uniform distance from all 4 object sides to the weed border is
established.

- One Frame For Each Used Layer

In each layer in which objects are located, a weed border around all objects
therein is placed.

3.6.1.6 The Output Devices… Setup

This category of the basic settings allows the definition of important
parameters for the output on the output device. The default settings

correlate with the information in the output dialog before the output of the job
data to the connected device.

3.6.1 The Standard Settings Menu

119



Current output device

All currently connected output devices can be selected in this window. The

driver name, file name, and the port interface are displayed. Mode and

material from the material database can be determined.

The … button enables the creation, modification and deletion of the settings.

Port

Indicates with which computer interface the output device is connected.

Default Settings

Keep reference point

This option takes care that no new origin is set after the output of a job. The

next output is done at the same coordinates as the previous.

Stack processing

This option enables an uninterruptible output without an interaction of the

Plot Manager.

Wait after segment

Waiting after segment indicates if the cutter shall remain at this position after

the output of a cut segment. This option is typically needed with flatbed

devices without integrated automatic foil transportation.

Segment thus indicates the maximum addressable area that can be
processed in one piece.

After the segment the foil is forwarded by hand to the correct position.

Sort before output

Sort means that all inner objects are processed before the outer objects and

that a sortation is done in x-axis-orientation. This switch takes care that the

foil is moved as little as possible in order to maintain the repeat accuracy as

high as possible. This option is especially necessary with cutters with friction

roll drive or when milling.

The output speed is slightly reduced with this setting.

Plot to file

This option does not lead the output of the data to the connected device but

opens a dialog in which the path and the name of an output file can be given
that will be saved to the hard disk.
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Read out automatically

This option can be activated if a device is connected and "online" and a read

out command for this device exists in the driver.

Output only tool-assigned layers

This option takes care that only objects are output where a tool assignment

to a layer was done.

please refer to 2.4: Tool Assignment Via Layer

Weeding border

This option defines if and with which distance a weeding frame is cut around

the output objects. This option facilitates the weeding of foil.

Overlap

It defines the overlapping of two segments. This value takes for example

care of the compensation for the shrinking that occurs with foils.

Copy spacing

Copy distance defines the distance of copies on the output medium.

Segment spacing

Segment distance defines the distance between single segments of a job.

Stack spacing

Stack distance defines if copies shall be stacked vertically. Requirement for

the activation of this option is that the selected object can be output more

than once on top of each other.

Indication: In the output-preview the first object is shown "normally".
Each further object of the stack is shown with a black square filled with
an X.

No tooltips

This option takes care that no tooltips that were entered in the device driver
are shown in the output dialog.

Enable output for objects larger than page size

This option causes objects to be passed to the output module that are larger
than the dimensions of the working area.
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3.6.1.7 The Import Setup

The setup import dialog is used to preset all import filters implemented in CoCut. The

settings are divided into 4 categories for the sake of clarity. Settings made in the General
tab apply to all import filter file formats listed in the left column. Default settings are

already activated. Settings other than the standard can be activated by clicking on the

respective file format tab. The filter-specific settings can be activated or deactivated as

required.

Fig. 3.6-4: Import dialog with closed category structure and import filter file formats

Fig. 3.6-5: Plus sign control

Fig. 3.6-6: Minus sign control

Fig. 3.6-7: Check control

A click on the plus sign control opens the desired category. A click on the minus sign
control closes the desired category. Clicking on the check control activates or

deactivates the corresponding option.
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Fig. 3.6-8: Import dialog with opened category structure - here: General tab active

3.6.1.7.1 The Settings

3.6.1.7.1.1 Job preparation

- Assume file name as job name

This option takes the name of the import file for the job file. This makes it easier to assign
source file to job file.

- Create new job

(Default: set) - When importing foreign data, the data is imported into a job without a name
(untitled.job).

and

- close active job

The active job is closed during import. This prevents the job history becoming very large

and confusing when importing many files.
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- Load following palette:

Enabling this option allows you to load a color palette with the *.PAL file extension.

- Run the following macro before importing:

This option lists all available macros. This option allows data operations to be performed

before importing, such as 90° rotation, sorting with simulation, etc.

3.6.1.7.1.2 Conversions

- Separate layers by name

When importing external data, it may happen that several layers have an identical color

value. If they are assigned different names, CoCut can separate them during import and

place the corresponding objects in separate layers.

- Insert objects at position

If this option is activated, it is possible to determine the position in X and Y in which the

data is stored on the work surface.

- Combine objects in the same layers

If this option is activated, all closed objects that are in the same layer are combined during

the import.

- Break Combinations

If this option is activated, all object combinations are exploded during the import, with the

result that only individual objects are available.

- Group all objects

If this option is activated, all objects are grouped during import. Advantage: The position of

the objects remains unchanged when the objects are moved because only one group
object is moved.

- Ungroup

If this option is activated, all object groups are broken during import.

- Rotate objects by the following angle:

The value specifies the angle at which the objects are rotated when they are imported.

Negative values are allowed.

- Drag'n Drop objects rotate at the following angle:

If objects are dragged to the CoCut work surface, they are rotated by the entered value

when released.
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- Scale objects by the following factor:

The value specifies the extent to which the objects are scaled, i.e. enlarged or reduced,

during import. Negative values are allowed.

- Mirror objects as follows:

This option allows the objects to be mirrored when they are imported: Possible settings

are: horizontal axis, vertical axis, both axes.

- Search / replace alignment marks in the following layers:

This option searches in the selected layer for vector objects that have the size of the

alignment marks (see Standard Settings / Register / Crop Marks / Size) and convert them

into alignment mark objects, that is, these objects get the object attribute: alignment
mark.

- Insert weeding frame:

This option adds a weeding frame around the imported objects. The distance is based on

the settings for the weeding frame.

3.6.1.7.1.3 Object properties

- Assign "Fixed object size"

If this option is activated, all imported objects are marked with the object attribute "fixed

object size"; Thus size change is deactivated

- Assign "Fixed object size at the output"

If this option is activated, all imported objects are marked with the object attribute "fixed

object size at the output". If this option is active, then no size compensation takes place

during output. The objects are placed and rotated only after the marks have been

imported.

- Assign "Do not move"

If this option is activated, all imported objects are marked with the object attribute "Do not

move". The Do not move option prevents the selected object from being moved. The

position is locked.

-  Keep object sorting

If this option is active, the object sorting is not changed during the import. The sequence of

objects will remain.

3.6.1.7.1.4 Edit objects
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- Reduce nodes

Enabling this option removes all superfluous nodes. The vector object is reduced by those

nodes whose removal does not influence the curve trajectory.

- Remove duplicate lines with the following tolerance automatically:

If this option is activated, all identical, overlapping lines are automatically removed.

- Automatically close objects with the following tolerance:

If this option is activated, all vector objects are automatically closed or connected during

import, whose distance from the start and end point is within the closing tolerance.

- Run the following macro after import:

This option lists all possible macros. This option allows operations to be performed after

importing, such as 90° rotation, sorting with simulation, etc.

3.6.1.7.2 Layer Mapping - Example

Why Layer Mapping?

The mapping ensures that imported layer names, tools, methods are integrated into the

database structure. The purpose of the layer mapping is the manual assignment of

unknown layer names to tools or methods existing in the CoCut database.

Note: The assignment applies to all filters. Multiple assignments (mappings) are
allowed.

Important note: If there are no names in the import palette, then there will be no
selection in the root layer column. If the column is empty, the "Sample Layer Entry"
is displayed, i.e. there is no mapping.
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Example:

This option can be found under: Settings, Standard Settings, Import..., Conversions,
Use Layer Mapping. A click into the Number of assignments field opens the following

dialog:

Target layer column
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In the Target layer column, select the desired database layer(s) on which the mapping is
to act. Here: Kiss-Cut and/or Thru-Cut (see figure above).

Root layer column

The layer name from the import file is to be entered in the Root layer column. Here:

CutContour; Kiss; Cut; is assigned to the Kiss-Cut Target Layer (see figure above).

3.6.1.8 The Profile... Setup

The Profile... setup serves the customization of the desktop. The user or administrator

can adapt the CoCut interface to fit his needs or restrict it to its necessary amount. The so

defined user profile can be exported or be transferred - provided with a password

protection - onto other licensed client computers.

3.6.1.8.1 View

Design

The following options are possible: Black, Silver, Blue and Dark. Changes

are previewed directly in the dialog.
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Menu Icons

Possible sizes are: Small, Medium and Large.

Toolbar Icons

Possible sizes are: Small, Medium and Large.

Password

Lock dialog with password Option

If this option is activated, this password will be requested when activating the profile
menu. This prevents unwanted or unintended changes to the view.

Note: Changing the view is now only possible with a known password.
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3.6.1.8.2 Profile Management

Export Profile Button

Fig. 3.6-9: Save profile dialog with default path

Enabling of the Export Profile button allows saving of customize CoCut profiles. The used

file extension is *.EC7. As default *.EC7 files are saved in the folder, where the program

data are located.

Load Profile button

A click on this button opens the Windows Open dialog.

Note: If all menus or the settings menu were accidentally disabled, then access on
the profile resp. profile file is possible using the sytem menu. The system menu is
enabled with a click on the program logo, which you'll find left from the program
name in the program bar.

3.6.1.8.3 System Menu

A click on the icon in the upper left corner of the program window opens the following

dialog.
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Fig. 3.6-10: System menu with Profile… sub menu

3.6.2 The Color Palette Command

With this command new color palettes can be created, loaded or saved.

Layer Numbers

If this option is active layer numbers are shown in the layer-toolbar.

Layer Info…

Opens the dialog for the setup of the layer toolbar. Here, you can define

which information is shown if the mouse cursor is positioned above a layer

color.

Possible information is: color-number, RGB values, CMYK values, material

name, mode/tool, material and amount objects. In addition, the amount of

visible layers and the width of the window can be set.

An „I”-button opens a window with shortcuts of the layer toolbar.

Layer Order…

This option opens a dialog for the modification of the layer order respective

the output order.

Only Sel. Layer Visible

If this option is activated only the objects lying in the selected layer are

shown on the working surface.

Delete Sel. Layer

Deletes the selected layer from the layer list.

Delete Unused Layers

This option removes all unused layers, all layers without objects and without
device connection.
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New Palette

All color layers that have layer numbers bigger than 6 are removed. You use

this command if you want to define a new color palette individually. The

selection of the layer color is done by just selecting the desired color with

your mouse cursor and then activating the OK button.

Load Palette…

The previously defined palettes can be loaded.

Save Palette

With this command you save a newly defined or a modified standard palette

on your hard disk. If this new or modified palette is saved as default palette it

will be used at every new start of CoCut.

Save Palette As…

This command allows the new allocation of a palette name.

Default

This command loads the color palette that is delivered as standard with

CoCut. It is a Mactac foil color chart that was defined as default palette by

means of the color fan.

Palette History

This function facilitates the loading of the last 4 color palettes without the

detour via the file directory tree. At the end of the menu list of the color

palette menu the names of the last 4 edited color palettes appear. Click with

the mouse cursor on the desired palette name and thus open the selected

palette. 

3.6.3 The Working Area… Command

3.6.3 The Working Area… Command
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Fig. 3.6-11: Working area with shadows and rulers

Here, you can newly define the size and color of your working area. The

working area is displayed as a paper frame with a gray shade on the right

and bottom next to the frame (see figure above). The color of the working

area is freely definable; this guarantees an optimal layout control on the

screen.

Pre-defined are for example DIN-A-sizes. Besides the fix defined measures

you can define any number of user-defined working area. One can be

defined as standard. It will then be pre-set at every "file new".

This option is a very helpful function for everybody who has e. g. a milling or

an engraving machine as the new entry in each case of the usable area can

be omitted.

Indication: A double click on the shade right next and below the
working area also opens this dialog.

3.6.4 The Rulers… Function

With this function you define the positions where the rulers shall be

placed. Due to lack of space the display of the rulers can be

abandoned. With diametric display each 5th step is drawn longer and with
non-diametric each 2nd and each 4th once again.

SHIFT+I

3.6.4 The Rulers… Function
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3.6.5 The Unit of Measurement Function

This instruction switches the measuring unit to the preferred unit (mm, cm or

inch).

Indication: The metric can also be changed directly via a button that is
in the angle of both rulers.

3.6.6 The Origin Function

This function shows a zero point (origin) in the lower left corner or the lower right corner of

the working area. It is used for orientation on the working area. Which view is preferred

depends mostly on the zero point of the connected machine. The view on the working area

then corresponds to the real conditions.

Fig. 3.6-12: Here: Origin bottom left

3.6.6.1 The Settings Origin Menu

Fig. 3.6-13: The Origin Options

3.6.6.1.1 Setup...

3.6.5 The Unit of Measurement Function
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Fig. 3.6-14: The origin dialog box

New Position (X / Y)

This option allows you to set the zero point using specific values.

X Field + Measuring Unit

In the X field, the absolute coordinate of the zero point on the X-axis can be specified.

Note: The unit depends on the setting of the ruler.

Y Field + Measuring Unit

In the Y field, the absolute coordinate of the zero point on the Y-axis can be specified.

Note: The unit depends on the setting of the ruler.

Display as Cross Option

If this option is activated, the origin point is represented by a dashed coordinate cross. If

the option is deactivated, the position of the zero point is only taken into account in the

rulers.

Bottom Left Option

This option places the zero point in the lower left corner of the working area. 
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Bottom Right Option

This option places the zero point in the lower right corner of the working area.

3.6.6.1.2 Move

This command serves to move the ruler origin. The Move option activates a crosshair as

a mouse cursor. With the help of this, the zero point can be moved to any individual

position.

3.6.6.1.3 Reset

The Reset option returns the zero point to the original position (lower left or lower right).

3.6.6.1.4 Center to page

This command serves to move the origin point to the center of the working area (center of

page).

3.6.6.1.5 Center to selection

The Center to selection option sets the zero point to the position of the middle handle

located at the center of a selected object.

Note: This command is selectable only, if one or more objects are selected on the
desktop.

3.6.6.1.6 To selected node

The To selected node option sets the zero point to the position of a marked (selected)

node.

Note: This command is selectable only, if one or more objects are selected on the
desktop.

3.6.6.1.7 Display

This option displays the zero point or makes it invisible.

Note: Only visible, if the Display as Cross-Option is active.

3.6.6.1.8 Fix

This option makes the zero point moveable or fixes it at the current position. 

3.6.6 The Origin Function

136



3.6.7 The Undo / Redo Command

With this instruction the undo / redo function can be switched on or off.

Advantages when undo / redo switched off:

With big or many objects the node processing is faster. The testing phase

(initial state -> edition -> temporary final state) with several processing

steps can be made undone as follows:

1. Switch off undo/redo, 2. edit objects and 3. switch on undo / redo

The selection of the undo function in the edit menu reestablishes the state

before point 1.

SHIFT+F7

3.6.8 The Snap Mode Function

The snap mode facilitates the creation of objects at the subsidiary lines. This

option activates the "magnetic" effect on graphic objects and text blocks.
P

3.6.9 The Choose Language… Command

This option sets the language for user interface and help file.

3.6.9.1 Program Language

The user interface language is set here.

3.6.9.2 Language for the Help File

The language for the help is determined here.

3.6.7 The Undo / Redo Command
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3.7 The Window Menu

3.7.1 The New Window Command

Activating this instruction opens a new CoCut window.

3.7.2 The Tile Horizontally Command

The activation of this instruction places all open windows diminished - one

above the other - horizontally.

3.7.3 The Tile Vertically Command

The activation of this instruction positions all opened windows diminished  -

side by side - vertically.

3.7.4 The Cascade Command

The confirmation of this instruction displays all windows diminished and

cascaded (diagonally displaced).

3.7.5 The Close Command

Clicking this instruction closes the momentarily active window after prior

safety query.

3.7.6 The Close All Command

Clicking this instruction closes all open windows after prior safety query.

3.7.7 The Standard Command

This command switches the tool-toolbar on the desktop or makes it

disappear.
CTRL+1

3.7.8 The Sidebar Command

This instruction switches the so-called Sidebar on or off. The Sidebar
contains several tabs (e. g. layer) and is normally displayed at the right

border.

CTRL+2

3.7 The Window Menu
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3.7.9 The Setup Command

This instruction switches the setup toolbar on the desktop or makes it

disappear.
CTRL+3

3.7.10 The Common Tools Command

This instruction switches the common tools toolbar on the desktop or

makes it disappear.
CTRL+4

3.7.11 The Object Tools Command

This instruction switches the object tools toolbar on the desktop or makes it

disappear.
CTRL+6

3.7.12 The Object Parameters Command

This instruction switches the object parameters toolbar on the desktop or

makes it disappear.
CTRL+7

3.7.13 The Status Bar Object Info Command

This instruction switches the status bar object info toolbar on the desktop

or makes it disappear.
CTRL+8

3.7.14 The Status Bar Element Info Command

This instruction switches the status bar element info on the desktop or
makes it disappear.

CTRL+9

3.7.15 The Active Windows List

At the below part of the window menu instruction list all active jobs are
listed.

Indication: If more than 9 jobs are active it will be indicated by the
menu item: further windows.

3.7.16 The Further Windows… Command

This instruction is only visible if more than 9 windows are active. A window

with a list of all active windows is opened. A click switches to the wanted

window.

3.7.9 The Setup Command
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3.8 The Help Menu

3.8.1 The About … Command

The selection of this menu entry opens an info window in which various

information is shown. On the left part of the dialog among others the serial

number, version number, free disk space, co-processor, or type of processor

are shown. On the right down part of the dialog is a scroll window in which

all the application files of the respective application version are listed. This

file list can be printed via the print button.

Indication: If there should be problems with your CoCut version you
can fix them the fastest, if this list is made available to our support
staff.

3.8.2 The Help… Command

This option starts the CoCut help. F1

3.8.3 The Object Info… Command

The activation of this instruction opens an info window that contains

information about the objects on the desktop. These are among others the

number of objects, number of selections, vector objects, text blocks, all

groups and combinations or all bitmaps.

The selection button opens the object manager.

F10

3.8.4 The Install Autoimport Plug-Ins… Command

Enabling this command opens the Corun Installer window, that lists for
which programs plug-ins are available. Programs which were automatically

found are marked already. Select the target program for the intended data

exchange in the Eurosystems Software list field.

Pressing the Install button starts the installation.

please refer to 1.5.1: Corun Installer

3.8.5 The Online Support Command

The activation of this menu item establishes a direct internet connection to

the support page of the EUROSYSTEMS S.à.r.l. - www.eurosystems.lu.

3.8 The Help Menu
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3.8.6 The Remote Support… Command

Via remote control the content of the screen of a computer can be

transferred in realtime to another computer. Thus it is possible that two

users who are at different places look at the same desktop. While you are on

the telephone with our consultant (support) you can show each other

documents or applications even if you are far apart from each other in

reality. The direction of transmission respective line of vision can be

changed with a mouse click. Thus you can choose if you want to look

together at your screen or at the screen of your consultant.

In order to be able to use the remote support you need an active internet

connection.

3.8.7 The Live Update Command

This instruction activates a software update via internet.

Indication: Requirement is an active internet connection on the
computer where the software is installed.

3.8.6 The Remote Support… Command
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3.9 Context Menu Left Mouse Button

3.9.1 Context Menu Ruler

3.9.1.1 The Unit Button

A click on the Unit button activates one of the following context menus:

Note: Which of the two is enabled, depends on whether objects are selected on the
working area and what zero point setting is active.

 or 

3.9.1.1.1 Origin…

please refer to 3.6.6: The Origin Function

3.9.1.1.2 Move Origin

This command serves to move the ruler origin to any position on the desktop.

3.9.1.1.3 Reset Origin

This command serves to move the origin point into the lower left corner of the working

area.

3.9.1.1.4 Set Origin to Center of Page

This command serves to move the origin point to the center of the working area (center of

page).

3.9.1.1.5 Set Origin to Center of Selection

This command serves to mirror or place objects at the coordinate axis.

Note: This command is only visible, if one or more objects are selected on the
working area.

3.9 Context Menu Left Mouse Button
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3.9.1.1.6 Hide Origin

This command serves to switch the ruler zero point to invisible.

3.9.1.1.7 Release Origin

This command serves to release the fixation of the ruler origin in order to move it with the

mouse.

3.9.1.1.8 Show Origin

This command serves to switch the ruler zero point to visible.

3.9.1.1.9 Fix Origin

This command serves to anchor the ruler zero point at a definite point.

3.9.1 Context Menu Ruler
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3.10 Context Menus Right Mouse Button

3.10.1 Context Menu on Empty Working Area

Fig. 3.10-1: This menu appears if no objects lie on the desktop

Job Properties…

This command opens the following Job properties dialog:

Fig. 3.10-2: Job properties dialog with job infos

Do not sort during output

This option prevents, if activated, the objects being sorted before or during output. In other

words, the original object sorting is retained.

Note: If this option is activated, the "Do not sort during output" option located in the
output dialog is automatically deactivated.

Refresh screen

This instruction refreshes the active window.

3.10 Context Menus Right Mouse Button
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Import…

This menu entry opens the import dialog for the import of external file formats.

Insert

This menu entry inserts contents from the Windows clipboard to the CoCut working area.

Working area

This menu entry opens the dialog for the pre-setting of the parameters of the working area.

Fit Page to Objects

This option scales the working area proportionally in relation to the object size.

3.10.1 Context Menu on Empty Working Area
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3.10.1 Context Menu on Empty Working Area

146



4 Reference Part Output Preview

4.1 The Output Menu

4.1.1 The Output Command

Starts the output on the connected device with the settings of the output to device
dialog.

4.2 The Options Menu

4.2.1 The Save As… Command

The save as… command in the output preview ... saves the job

with all changes that were done in the preview. When returning to

the working surface all these settings would be lost, therefore, the

job can here be saved under another name.

please refer to 3.1.4: The Save as… Command

SHIFT+CTRL+S

4.2.2 The Rotate Axis Command

This command rotates the marked objects at 90° counter-clockwise.

please refer to 3.3.1: The Rotate Axis Command A

4.2.3 The Horizontal Mirror Command

The selected object is mirrored at the horizontal through its center-point.

please refer to 3.3.3: The Horizontal Mirror Command X

4.2.4 The Vertical Mirror Command

The selected object is mirrored at the vertical through its center-point.

please refer to 3.3.4: The Vertical Mirror Command Y

4.2.5 The Optimization… Command

The foil optimization takes care that all objects are arranged in a way that they take the

least space on the foil. By rotation or no rotation of objects it is taken care of, that the
material waste can be decreased.
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please refer to 3.5.6: The Box Nesting… Function
please refer to 2.10.1.1: Material optimization

4.2.6 The Sort With Simulation… Command

This command opens the sort objects function with which the output

order and the direction of rotation can be defined. The sortation can de

done dependent or independent on layer. Also, the preferred direction of

the sortation can be defined.

In a preview window the output of the objects is simulated graphically;

here, the traverse paths of the tool head can also be drafted. The

simulation can be done unlimited without changing the original objects.  

CTRL+F10

please refer to 3.3.18: The Sort With Simulation… Command

In detail: please refer to 6.6: The Sort with Simulation… Tool

4.2.7 The Recalculate Command

The recalculate command enables the modification of the

output-parameters or of the driver settings without leaving the output routine.

This command switches back from the output preview to the output dialog.

N

4.2.8 The Initial View Command

Puts back the output preview to the status before having pressed the

preview button in the output dialog. All changes are made undone. 
SHIFT+N

4.2.9 The Horizontal Weeding Lines Command

Weeding lines serve for the better processing of big jobs. Material lengths of
several meters in length or width are difficult to handle, therefore you can

insert weeding lines during the foil cutting that divide the job into smaller
parts that are easier to handle.

The horizontal weeding lines are set with the hotkey "h" or drawn with the

arrow from the weeding frame dashed in blue.

please refer to 2.10.1.2: Weeding lines

H

4.2.10 The Vertical Weeding Lines Command

Weeding lines serve for the better processing of big jobs. Material lengths of
several meters in length or width are difficult to handle, therefore you can
insert weeding lines during the foil cutting that divide the job into smaller

V

4.2.5 The Optimization… Command

148



parts that are easier to handle.

The vertical weeding lines are set with the hot key "v" or drawn with the

arrow from the weeding frame dashed in blue.

please refer to 2.10.1.2: Weeding lines

4.2.11 The Test Drive Command

If the test drive command is activated the connected device goes with lifted tool head

along the weeding frame. This also happens if the option "weeding frame" was not

activated.

Compare test drive button in the output dialog please refer to 2.5.3: Start Output
from the CoCut Working Surface

4.3 The View Menu

4.3.1 The Material Width Command

When activating this command the section is adjusted to the values for the

material width defined in the driver or set in the output dialog.
B

4.3.2 The All Objects Command

This function changes the display in that way that all objects can be seen on

the screen. The section is selected so that it is the biggest possible display

showing all objects.

If the SHIFT key is pressed while activating this command, only the selected
objects are zoomed to maximum.

F4
and

SHIFT+F4

4.3.3 The Selected Objects Command

If this command is activated only the selected objects from the output
preview are displayed as large as possible.  

SHIFT+F4

4.3.4 The Total Area Command

If this menu item is activated the preview of the whole material surface is

shown.

The size of the shown surface depends on the so called frame size (foil

height x foil width) of the output device to be accessed.

If in the output dialog a driver for a friction feed cutter was selected, in the
preview always a material length of 30m (32,81 yd) is shown. 
If in the cutting dialog a driver for a flatbed cutter was selected, the

maximum width of the flatbed cutter is shown as material length.

SHIFT+B

4.2.10 The Vertical Weeding Lines Command
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4.4 The Window Menu

4.4.1 The New Window Command

Activating this instruction opens a new CoCut window.

4.4.2 The Tile Horizontally Command

The activation of this instruction places all open windows diminished - one

above the other - horizontally.

4.4.3 The Tile Vertically Command

The activation of this instruction positions all opened windows diminished  -

side by side - vertically.

4.4.4 The Cascade Command

The confirmation of this instruction displays all windows diminished and

cascaded (diagonally displaced).

4.4.5 The Close Command

Clicking this instruction closes the momentarily active window after prior

safety query.

4.4.6 The Close All Command

Clicking this instruction closes all open windows after prior safety query.

4.4.7 The Common Tools Command

This instruction swithes the Common Tools toolbar on or off. CTRL+4

4.4.8 The Object Parameters Command

This instruction switches the object parameters toolbar on the desktop or

makes it disappear.
STRG+7

4.4.9 The Status Bar Object Info Command

This instruction switches the status bar object info toolbar on the desktop
or makes it disappear.

CTRL+8

4.4 The Window Menu
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4.4.10 The Status Bar Element Info Command

This instruction switches the status bar element-info on the desktop or

makes it disappear.
CTRL+9

4.4.11 The Active Windows List

At the below part of the window menu instruction list all active jobs are

listed.

Indication: If more than 9 jobs are active it will be indicated by the
menu item: further windows.

4.4.12 The Further Windows… Command

This instruction is only visible if more than 9 windows are active. A window

with a list of all active windows is opened. A click switches to the wanted

window.

4.5 The Help Menu

4.5.1 The About … Command

The selection of this menu entry opens an info window in which various

information is shown. On the left part of the dialog among others the serial

number, version number, free disk space, co-processor, or type of processor

are shown. On the right down part of the dialog is a scroll window in which

all the application files of the respective application version are listed. This

file list can be printed via the print button.

Indication: If there should be problems with your CoCut version you
can fix them the fastest, if this list is made available to our support
staff.

4.5.2 The Help… Command

This option starts the CoCut help. F1

4.5.3 The Install Autoimport Plug-Ins… Command

Enabling this command opens the Corun Installer window, that lists for

which programs plug-ins are available. Programs which were automatically

found are marked already. Select the target program for the intended data
exchange in the Eurosystems Software list field.

Pressing the Install button starts the installation.

4.4.10 The Status Bar Element Info Command
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please refer to 1.5.1: Corun Installer

4.5.4 The Online Support Command

The activation of this menu item establishes a direct internet connection to

the support page of the EUROSYSTEMS S.à.r.l. - www.eurosystems.lu.

4.5.5 The Remote Support… Command

Via remote control the content of the screen of a computer can be

transferred in realtime to another computer. Thus it is possible that two

users who are at different places look at the same desktop. While you are on

the telephone with our consultant (support) you can show each other

documents or applications even if you are far apart from each other in

reality. The direction of transmission respective line of vision can be

changed with a mouse click. Thus you can choose if you want to look

together at your screen or at the screen of your consultant.

In order to be able to use the remote support you need an active internet

connection.

4.5.6 The Live Update Command

This instruction activates the update of the software via the internet.

Indication: Requirement is an active internet connection on the
computer where the software is installed.

4.6 Context Menu of The Right Mouse Button

4.6.1 Context Menu Output Preview

Fig. 4.6-1: Context menu of the output preview with weeding frame function

Weed border

This function creates a weeding frame around the selected objects in the output preview
unlike the weed border option.

All other menu entries can be activated via the main menu.

4.5.3 The Install Autoimport Plug-Ins… Command
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5 Toolbars

5.1 The Standard Toolbar

The standard toolbar is switched on or off via the window menu. CTRL+1

Fig. 5.1-1: Freely placeable toolbar - Collection of standard tools

Fig. 5.1-2: Fixed standard toolbar

BUTTONS FROM 1 TO 15

1. Create New window 9.  Print objects
2. Open job 10. Import file
3. Save job 11. Export objects
4. Save all 12. Scan image
5. Edit job info 13. Undo
6. Cut to Clipboard 14. Redo
7. Copy to Clipboard 15. Help
8. Paste from Clipboard

5.2 The Setup Toolbar

The Setup toolbar is switched on or off via the Window menus. CTRL+3

Fig. 5.2-1: Free placeable Setup toolbar

Fig. 5.2-2: Fixed Tool Bar

BUTTONS FROM 1 TO 2

1. Contour mode on/off
2. Desktop Setup

Indication: Alternatively the work area can be defined by doubleclick on the shades
beside the work surface.
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5.3 The Object Tools Toolbar

The Object Tools toolbar is switched on or off via the WIndow menu. CTRL+6

Indication: Depending on the used EUROSYSTEMS software some of the listed
tools can be missing (n. a.).

Fig. 5.3-1: Freely placeable toolbar - collection of objcet tools

Fig. 5.3-2: Anchored toolbar

BUTTONS FROM 1 TO 21

1. Delete Objects 12. Open Objects
2. Do Axis Change with Objects 13. Round Objects
3. Horizontal Mirror of Selected Objects 14. n. a.
4. Vertical Mirror of Selected Objects 15. n. a.
5. Group Objects 16. Generate Contour Line
6. Ungroup Objects 17. Start Foil Optimization
7. Combine Objects 18. n. a.
8. Release Combination of Objects 19. n. a.
9. n. a. 20. Generate Out- or Inlines
10. Align Objects 21. Weld Objects
11. Close Objects

5.3 The Object Tools Toolbar
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5.4 The Object Parameter Toolbar

Fig. 5.4-1: Freely placeable toolbar - collection of object parameters

Fig. 5.4-2: Object parameters toolbar with explanations

5.4.1 The Duplicate Command

Definition: Multi Copy = Multiple copies of selected objects (Duplicates)

5.4.1.1 The Multi Copy Button

Pressing the button opens the following dialog:

5.4 The Object Parameter Toolbar
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5.4.1.2 The Arrows

Clicking on the desired arrow determines whether duplication is from right to left, left to
right, bottom to top, or top to bottom.

5.4.1.3 Distance beginning

The Distance beginning option specifies that the object distance, starting from the
bounding box, is to be calculated from the bottom left box node in each case.

5.4.1 The Duplicate Command
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5.4.1.4 Distance between

The Distance Between option specifies that the object distance, starting from the

bounding box, should be calculated from the box node at the top left and bottom left.

5.4.1.5 Fill Working Area

If this option is activated, then you can specify the number of parts with which the

working area will be filled.

5.4.1.6 Number of parts

An additional function to the Fill Working Area option, a certain number of parts can be

defined. If the Fill Working Area option is activated, then the maximum number of

objects is calculated under Number in X and Number in Y. The total number of parts is

then displayed in the Number of parts field. The number can be changed at any time.

Example:

For example, if 10 in X and 11 in Y = 110 are calculated - but only 69 parts are to be

duplicated and placed - then the user can set the number to 69. The preferred direction

should therefore be Y in columns. In this example, an incomplete column is created at the

end.

Note: This option applies only to the Fill working area option.

5.4.1 The Duplicate Command
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5.4.1.7 Create clone option

If this option is activated, then no identical vector objects are duplicated, but so-called

clones. These are objects that reference the original and carry its properties. The

processing of a large number of objects on the desktop is significantly accelerated by

using clones!

5.4.1.8 Group result option

If this option is enabled, then after duplicating the individual objects, a group object is

created from all of them.

5.4.1.9 Optimization

Preferred optimization

The  button creates the duplicates in Y-axis direction - "column-wise".

The  button sorts the benefits preferably in X-axis direction - "row by row".

5.5 The Status Line Object Info

This status line informs about the properties and attributes of objects on the CoCut

desktop. This information comprises number, type of object, color model, color value and

many other data important for the evaluation. 

Fig. 5.5-1: Status line for the display of object properties, color spaces , etc. - free floating

Fig. 5.5-2: Status line for the display of object properties, color spaces, etc. - fixed

5.6 The Status Line Element Info

This status line indicates the current mouse cursor position in x/y-coordinates. In addition,

in the left part next to the cursor coordinates subsidiary texts and additional texts from the

layer info for example from the field material name are displayed. It is also possible to

show driver information as for example the set tool depth for a particular layer.

Fig. 5.6-1: Status line element with subsidiary texts and element information, here
coordinates

5.4.1 The Duplicate Command
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5.7 The Preview Tools Toolbar

The Arrow Tool

This mode allows you to mark, move, group temporarily (marking function)

and modify the size of objects in the output preview.

SPACE

The Magnifying Glass+

The button with the (+) plus sign increases parts of the output preview. Draw

with the marking function a frame around the area that shall be increased.

This function can be carried out successively several times until a beep

reminds acoustically of the last possible step.

F2
or

+(Num)

The Magnifying Glass–

The button with the (-) minus sign decreases gradually parts of the desktop

or of the working area.

F3
or 

-(Num) 

The Sheet

The button with the symbolic sheet of paper shows the material area

increased to the maximum

 B

The Screen

The button that symbolizes a screen displays all objects on the material area
as big as possible. The section is thus selected that is it the biggest possible

display with all objects visible.

 F4

The Magnifying Glass for Selected Objects

The „dotted loupe” button displays all selected objects as big as possible.

SHIFT +

F4

The Measure Tool

This tool serves for the determination and the percental modification of

object dimensions.

 M

The Output Command

The activation of this button gives the data to the Plot-Manager for the

output to the connected device.

 S

5.7 The Preview Tools Toolbar
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5.8 The Preview Object Parameters Toolbar

The preview object parameters toolbar is activated with the following

shortcut.
CTRL+7

Indication: It is identical with not variable part of the object parameters toolbar in
previous CoCut versions.

Fig. 5.8-1: Object parameter toolbar with position, size, angle, multi copy, …

Note: The display of the object parameters toolbar varies depending on how the
object properties are set!

5.8 The Preview Object Parameters Toolbar
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6 Tools

6.1 The Desktop

After starting CoCut the desktop with the working area appears as follows:

Fig. 6.1-1: CoCut Desktop with working area and shown tool-toolbar, rulers, Object

Manager and status lines

The working area is marked by a black frame that has on the right and below a gray

shade. The working area serves for the orientation and dimensioning.

The rulers can be freely positioned or completely switched off. The layer toolbar is

integrated into the Sidebar. The metric (cm, mm, inch) can be directly changed via a

button that is within the angle of the two rulers. Also ruler's origin can be changed.

Following options are available: Set Origin to Absolute Coordinates, Move Origin, Reset
Origin, Set Origin to Center of Page, Show Origin and Release Origin.

In the status line you find much information about the objects on the working area. For

example the wire frame, filling, object dimensions, -number, combination or grouping
are displayed.
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6.1.1 Cursor forms on the working area and their meaning

Cursor form Meaning

no object marked or selected

Indication: You mark objects by positioning the mouse cursor above the object and
pressing the left mouse button.

Cursor form Meaning

Move objects

Indication: This cursor is only active if the cursor is within the range of the inner
part of the object or in the range between the 8 black squares on the wire frame
line. The object must be marked.

Cursor form Meaning

Increase object vertically

Increase object horizontally

Increase object diagonally

Indication: The cursors for the modification of the object size are only active if the
cursor is within the range of the 8 black squares on the wire frame line of the
object. You switch to the skewing-/rotation-mode by clicking with the left mouse
button with active cross cursor (see above move objects).

Cursor form Meaning

Object in the skew/rotate-mode

Rotate object

Skew object (set tilted horizontally/vertically)

6.1.1 Cursor forms on the working area and their meaning
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6.2 The Outline Function

This function is activated via the  button in the variable part of the object
tool toolbar or via the tools menu, menu entry Outline…

O

The outline function creates contours in a freely definable distance around graphical and

text objects.

Fig. 6.2-1: Outline parameter window

Type Area

Outline

The option Outline creates a contour line to the outside around the selected objects.

Note: If there are objects within other objects, then an inline from the inner object is
created.

Inline

The option Inline creates a contour line inside the selected objects.

6.2 The Outline Function
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In-/Outline

The In / Outline option creates a contour line outwards and inwards around the selected

objects.

Corners Area

The corner treatment can be influenced by three additional options. The preview shows

how the selected option affects the contours.

Do not change

The option do not modify corners creates the mathematical accurate dot on the outline

to each corner dot. This leads to the fact that in pointed corners the outline is extended

endlessly which often leads to unaesthetic results. Therefore the option cut corners is

pre-defined as default. This option shortens the extension up to the value that is entered in

the field tolerance.

Cut off

This option truncates the extension up to the value entered in the Tolerance field.

Round

Rounding corners converts the corner point into a rounded curve. The field Tolerance
indicates, in which distance of the corner point is rounded off.

Spacing

The desired value for the distance of the inner or outer contour from the original object is

entered in the Spacing field.

Number of copies

The Number of copies option specifies how many Inlines or Outlines are to be created

simultaneously during a function call.

Min. Object size

This value defines from which object size a contour is generated. It prevents the creation

of small parts that can not be weeded.

Tolerance

The field Tolerance indicates how much is cut off or rounded off. The value 1 equates

approximately the spacing value.

Options

6.2 The Outline Function
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Automatic welding

Automatic welding means that all overlappings of the generated contour lines will be

removed.

Delete original

If the button Delete original is activated, the original object is deleted after creating the

contours.

Do not create interior elements

This option suppresses the automatic generation of an inner contour.

Node reduction

If this option is activated, the number of nodes required for the contour line will be reduced

as much as possible without losing accuracy.

Create parallel at open objects

If this option is activated, parallel lines will be created next to the selected open object

instead of a closed outline.

Target layer

The target layer option allows the preselection of the layer into which the contour lines are

laid.

Note: It is possible to pre-select the tool since the layers can be preconfigured with
a tool.

6.3 Convert into Grid Lines (Example)

6.3.1 What does the Function do?

The Convert into Grid Lines function converts an array of adjacent rectangles in a sorted

line grid without double lines.

6.3.2 Example

Initial situation:

A grid of rectangles that are exactly on top of each other. This has the consequence that

each two lines are superimposed. This results in the problem that every line would be

processed twice. To fix this, the "Convert to gridlines" function has been implemented

in CoCut Professional XT.

6.3 Convert into Grid Lines (Example)
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Applied to the example above, the result is the following:

1. All duplicate lines have been removed, and

2. are welded into a coherent line.

3. The routing paths are optimized.

4. The cutting direction is now alternating.

This powerful feature creates an output-optimized line grid.

6.3.2 Example
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6.4 The Undo Redo Stack

The undo redo stack is activated via following key combination: SHIFT+F5
or SHIFT+F6

These functions can undo or redo all object-related actions.

Indication: Actions that refer for example to the working area, the desktop or the
layer-toolbar are not taken into the stack.

The pre-settings in the settings menu, submenu miscellaneous

The Undo Redo stack related settings as for example the number of stack actions is

carried out in the following setup dialog.

Indication: The maximum number of the undo steps can only be modified with no
objects on the working area.

Fig. 6.4-1: The parameter of the undo stack (here: marked in red)

The area undo function comprises the settings that effect the undo stack.

6.4 The Undo Redo Stack
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Fig. 6.4-2: Undo stack with preview window and working area

In the left stack the action can be selected up to which you want to go back. The preview

window shows the status of the working area and of the objects on the working area at the

moment of the action.

The redo stack operates in the same way.

6.4 The Undo Redo Stack
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6.5 The Align Function

Fig. 6.5-1: The Align button

This function aligns two or more marked objects to each other or to the working area.

Fig. 6.5-2: The Align dialog

Objects can be aligned horizontally or vertically. A centered alignment is also possible as

the selection of the same distance between the marked objects. The type of alignment is

illustrated by icons. Setting can be stored by pressing the Save settings button.

Indication: The last marked or drawn object serves for alignment as reference
object. That means that all others are aligned in the same way. If alignment is not
'Align to Page', then alignment will refer to the last selection.

6.5 The Align Function
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6.6 The Sort with Simulation… Tool

This tool serves for the sortation of objects and the determination of sequences before

the output at the connected device. A simulation with or without complete path of the

device tools facilitates the estimation of the results.

Fig. 6.6-1: Object sortation with preview window and simulation option

6.6.1 Zone A1 - Object Position, Color Bar, …

Object Position and Rotation

The object position column indicates the object number and the coordinates of the
objects on the work surface in the X / Y direction. The rotation column indicates
whether the object contour is rotated clockwise ">" or counterclockwise "<".

Color Bar

A click on the wanted color bar selects the respective color layer.

6.6 The Sort with Simulation… Tool
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The Select All Button

Clicking on this button selects all objects in the list.

The Deselect all Button

Clicking on this button deselects all objects of the list.

The Toggle rotation Button

This option modifies the orientation from clockwise (right) to counterclockwise (left) and

vice versa.

Connect / close objects with "OK" Option

This option ensures that open objects are automatically closed when the dialog is closed

with the "OK" button.

View selection Option

Shows the selected objects in the preview window

Single selection Option

In the list only one object can be selected; the multi-selection (standard) is deactivated.

View complete path Option

A blue dashed line shows the track that the tool head covers.

Don't sort at output Option

This option prevents object sorting at output.

6.6.1.1 Layer-dependent Sorting

All Layer Option

This option will include all layers in the sort if layer-dependent sorting is enabled.

Note: This option is disabled in the output preview, depending on the driver setting.

Selected Layer Option

This option only applies the selected layer to the sort, if layer-dependent sorting has

been activated.

6.6.1 Zone A1 - Object Position, Color Bar, …
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6.6.2 Zone A2 - The Simulator

The simulator is used to test and evaluate all settings before output. The operation of the

simulator is similar to a DVD-player.

Lo (low) up to Hi (high) regulates the speed of the simulation display.

Indication: Before simulation, in addition to orientation, you have to do sorting by
clicking on the sort button.

Fig. 6.6-2: Option View complete path activated (blue dashed lines)

6.6.3 Zone A3

6.6.3.1 Options

By Main Direction

If this option is activated, the main direction (area) is visible.

By Nearest Object

If this option is activated, the nearest object (area) becomes visible.

6.6.2 Zone A2 - The Simulator
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Reposition origins to

In this option the start point is set: Possible settings are: unchanged, lower left, upper
left, lower right, upper right.

6.6.3.2 Zone A3.1 - Main Direction (Area)

Main Direction

16 methods can be activated as main direction for the sortation. The icon shows with a red

arrow where sortation begins.

Max. deviation in … mm

In the input field can be entered the value for the maximum deviation of the imaginary

vertical respective horizontal line that an object may have in order to be sorted.

6.6.3.3 Zone A3.2 - Nearest Object (Area)

Fig. 6.6-3: Cutout from the main window (see above)

Optimize origin of objects Option

The aim of this option is to minimize empty runs. Enabling this option checks, which node

of the following object is closest to the first start point. The first is established; Then it is

examined which node of the following object is closest to the start point.

The simulator can be used to check whether the desired optimization is achieved. Usually
the variant, which has the shortest travel distance, is to be regarded as optimal. In

6.6.3 Zone A3
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individual cases, however, other criteria can also be decisive.

Note: If this option is active, the "Reposition origins to" option in the Options (area)
is disabled.

Begin with object at Option

This option determines which start object is taken into account during sorting. Possible

choices: lower left, upper left, upper right, lower right.

Focus: Simulation with start point optimization

In addition to the other traverse path optimizations, the starting point of the objects can be

moved automatically so that the tool head shifts as little as possible. The figure on the right

shows the starting points of the contour objects, represented by an arrow, before and after

the optimization. The direction of the arrow shows the orientation - clockwise or

counterclockwise.

Fig. 6.6-4: Before

origin optimization

Fig. 6.6-5:

After origin optimization

6.6.4 Zone A4 - Sorting, Settings, …

Path length Field

This field displays the realistic traverse path length of the tool measured during the

simulation.

The Sort Button

Only the Sort button activates the object sorting. You can then check in the simulation

whether the sorting meets your requirements.

The Reset Button

Resets the objects in the sort-list to the initial values
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The Apply settings for output Button

This option saves the changes made in the Sorting with simulation dialog.

The Settings for output Button

Clicking on the Settings for output button opens the following dialog:

Note: The settings made here are job-spanning and are the default settings for
output.

please refer to 2.5.3: Start Output from the CoCut Working Surface

6.6.4.1 The Sort Settings Tab

Fig. 6.6-6: Sort settings tab with main direction (Area) active

6.6.4.2 Options (Area)

Main direction Option

If this option is activated, the main direction (area) is visible. The desired main direction

is selected via mouse click. (See figure above)

Next object Option

If this option is activated, the nearest object (area) becomes visible.
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Nearest object (Area)

Start point optimization Option

See above: Focus: Simulation with start point optimization

Start object Option

In this option the start point is defined: Possible settings are: unchanged, lower left,
upper left, upper right, lower right.

Note: The selection of the starting point has an effect on the traverse path length. In
the simulator, the shortest path can be evaluated.

6.6.4.3 Main direction (Area)

In this area, all possible preferential directions are displayed graphically. The desired

preferential direction is selected by mouse click. The icon shows a red arrow where the

sorting is started.

Max. deviation in … mm

In the input field can be entered the value for the maximum deviation of the imaginary

vertical respective horizontal line that an object may have in order to be sorted.

6.6.4 Zone A4 - Sorting, Settings, …

176



6.7 The Welding Tool

This function is activated via the  button in the variable part of the object
parameter toolbar or via the tools menu, menu entry welding…

W

This function welds two or more vector objects with each other to a combination.

Depending on the number and the form of the selected objects you can choose between

the following options: manually, automatically, trim (cuts objects with lines or curves),

open trimming, by color, full area or screen printing.

Fig. 6.7-1: Tools menu - welding submenu

Dialog…

The activation of this submenu opens the following dialog

Fig. 6.7-2: Welding dialog
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Manually

Manually separates all intersections that occur because of the overlapping of outlines and

creates object parts. With the arrow-function you mark the object parts that you want to

remove. With the DEL-button the selected object parts are deleted. Overlapping-free

object parts are kept and can later be further edited. The original color of the object parts

are kept with the manual welding.

Automatically

Automatically calculates the common areas of the objects. All overlapping parts are

combined, transparent interior elements are considered.

Indication: With this option, objects of different colors are welded to a combination
object.

If the object colors shall be considered please select the options by color, full area or

screen printing.

The option automatically is especially suitable for the welding of serifs with scripts. The

serif of the previous letter overlaps often with the successive character. The material

would be slit at these positions without welding. The automatic welding eliminates this

overlapping and takes care of a cuttable transition in the serifs.

Tip: If single parts are missing after the automatic welding, then reduce the
character spacing in the text editor from 100% to 99%. This causes that identical
node dots that lie on top of each other are misplaced so that they are recognized
also as single nodes and the welding routine is carried out properly.

Trimming

Trimming means that you cut through closed objects with lines or curve objects and that

the object parts that are thus being created are automatically closed afterwards.

Depending on your request you can lay one or more objects over the objects to be slit like

a "knife". If you want to work with several "knives" these objects must be allocated to the

same layer or be combined. Then, by means of the trimming-option, the objects lying

underneath are cut alongside the "knifes". Also cutting in several "tilings" is possible

without problems as the knifes can overlap at discretion. The parts having thus being

created are then sorted according to their position and combined to single groups.

Open trimming

The open trimming works like the trimming with the difference that cut-off points of the

cut objects are not closed automatically but kept as open objects.

By color

By color removes all areas that are hidden by colors lying above. It does not matter how
many objects and colors you select. If open objects are also selected they can be closed

or provided with a line weight.
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Full area

The option full area underfills objects of one color whose areas hide those of another. To

do this, the partially hidden objects are modified so that they underlay completely the ones

lying above. Here, you can also proceed with the open objects as described under

automatically.

Tip: The mostly used field of application is the showcase labeling where the by
color-option is often too laborious to be pasted over. With 2 maximum 3 foil colors
you take the full surface option where the single foil colors are pasted above the
other.

Screen printing

The welding option screen printing is an especially efficient tool for the screen printer. At

first, the overlappings of the single coatings are removed. Then, the colors are layered

according to the sequence in the field color sequence. At the end, a small bar is inserted

at the seams between the single color layers as overlapping.

The color stack with the screen printing-welding

Modification of the color stack: With the screen printing, the printing sequence is from

bright to dark. Brighter colors are printed before the darker colors. By mouse click a

coating is grabbed and drawn to the wanted position.  The color stack reflects the position

of the layers above the medium. The output sequence considers the modifications of the

color stack.

Delete original

With the checkbox delete original you set if the initial objects shall be deleted after the

welding process or not.

6.7.1 Mask

Topmost object

If this option is activated the topmost object can be defined as welding object with the
welding functions trim, open trim and fill.

Topmost color

If this option is activated all objects of the above lying color can be defined as welding
object with the welding functions trim, open trim and fill.

Provide open objects with contour … mm

If open objects are amongst the selected you can indicate with the option provide open
objects with contour …  which thickness the created closed object shall have.

6.7.1 Mask
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Do not correct appearance of combinations

With this option combinations are treated that they are welded as displayed in the full

surface mode. Overlays in combinations remain transparent.

Join same colors

It can happen that the same color reappears in different group- or combination objects.

Then, select the option join same colors so that those merge to one color layer.

Indication: This is especially important with the creation of screen printing
templates as with the screen printing process the darkest color is always spread at
last in order to prevent possible white gap that might occur while mounting the
single colors.

Remove identical lines

With this option all vectors that are identical are removed but one.

6.7.2 Seams

Underlap - Offset

These options can only be activated with by color. In the field overlay you can enter the

value for the underlap or the offset.

Overlay … mm

If the option screen printing is activated you can enter here the value for the overlay of

the colors in mm.

Complete overlay up to:

Here, you can additionally enter the limit up to which width it shall be completely overlaid.  

6.7.2 Seams
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6.8 The Measure / Measurement Tool

Fig. 6.8-1: The measure button

Activate the measure button in the toolbox with the mouse pointer. Return to the working

area; the mouse pointer appears as circular sight. Move the center point of the sight to the

starting point of the track to be measured. Keep pressed the left mouse button while

moving to the end point of the track and let go the mouse button when you have reached

the end point. A subsidiary line marks the measured track.

Indication: Keep pressed the SHIFT key during the measurement. Then the
measurement is limited horizontally or vertically. This facilitates the exact
measurement of straight lines.

Fig. 6.8-2: The measure dialog

In the text field name length the result of your measurement appears. In order to modify
this value, first mark the text field and then enter the new value. In the text field

underneath you can percental increase or decrease the objects.

In addition, you get information about the angle of the measure lines, the width of the

measured object at the starting point of the measurement and the difference in height

between the starting and the end point that is resulted from the measure angle.
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6.9 The Contour (Line) Function

With the contour line function the outer edge of arbitrary many objects is calculated and

provided with a wire frame line. Contrary to the outline you can contour also bitmaps with

this tool. In addition, not every single object is outlined. Instead, it is tried to possibly find

one contour that comprises all selected objects. This function is therefore especially suited

for the creation of cutting lines around labels. The objects of the label can be arranged

arbitrarily.

Then the wire frame of the object is calculated in the wanted distance with the tool

described here. The contour line thus created can be used later for cutting out the printed

label.

First select the objects that you want to contour / outline. Then select contour… in the

tool menu.

The following dialog for the creation of the parameters appears:

Fig. 6.9-1: Parameter dialog for the creation of contour lines

Find contour

With the fields in the dialog group find contour you can influence the calculation of the

wire frame line. Generally, all objects that are not white are considered with the contour

finding. Ideally, the background of the graphic to be contoured should therefore be white.

But especially bitmaps contain often light gray spots that can occur when scanning.

Maximum gray scale

With the option maximum gray scale you can determine that gray spots above the

selected intensity are not contoured. You can enter values between 50 and 99% or set

them with the roll bar. 50% correspond to a relatively dark gray and 99% to an almost
white color.

6.9 The Contour (Line) Function
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Accuracy

In the field accuracy you can select between three options. The low accuracy works the

fastest. If the result is not satisfying with this setting, select the middle or a higher

accuracy. The calculation of the contour line then takes a little bit longer.

Indication: The field accuracy is not activated if only a single bitmap was selected.

Keep interior elements

If the option keep interior elements is activated, possibly created interior elements are

not deleted. This way you have the possibility to cut out parts of the graphic by applying a

brighter "plaster".

Look at the following illustration for this:

Fig. 6.9-2: Option: keep interior elements

On the left side you see the two initial objects. A smaller white circle is put onto the black

circle. On the right, the calculated contour line is displayed. The option keep interior
elements was active, also the inner circle was considered at the contour finding. With the

dialog field switched off, only the outer contour would have been created.

Indication: As default, keep interior elements should be switched off.

Distance and line guidance

In the second dialog group distance and line guidance you can influence the

appearance of the contour line.

Contour offset

With contour offset you determine how far away the wire frame line shall be from the

graphic. If you enter here the value "0" a contour line is created that directly is attached to
the edge of the selected objects. With values smaller than 0 the contour line goes into the

contoured objects.

Corner shape

The option corner shape determines how the contour line acts at salient corners.

Normal creates the mathematical exact dot on the contour to every corner dot. The
contour line can thus be lengthened very far at sharp corners, which often leads to

unaesthetic results. The options cut off and round lead to more satisfying results in such
cases.
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Cut off

Cut off shortens the contour at the indicated distance and cuts off the corner by a section.

Round

Round leads the corner dot to a rounded curve.

Color

On the right side of the dialog you can see a color selection field. A click on the change
button opens the color selection dialog. With this dialog you can allocate colors to

contours.

Destination Layer

This Field determines in which color layer - in doing so indirectly, with which tool - the

contour line is processed.

Note: The contour line color can be different in the full surface mode (print) and the
contour mode (output).

6.9 The Contour (Line) Function
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6.10 The Job Info

The job info can be opened in three ways:

1. Via the edit menu / menu item job info…
2. Automatically when saving a new job

3. Via the so named menu item in the context sensitive menu (right mouse button)

Fig. 6.10-1: Job info main window

With the job info you have the possibility to save additional information to each job. This
information can be printed and used for the invoicing or as accompanying ticket to jobs. If

the job info is printed, also the complete path in which the job was saved is printed.

Besides information as for example order number and company address the job info

gives information about the used materials, duration of the production, number of cut /

printed jobs as well as the intended or calculated price. In the memo field keyword

comments can be saved.

In the settings menu / menu item standard settings / menu item job info… the job info
can be extended by arbitrary many fields.

Indication: The information under the field media are only inserted automatically, if
you have given these information to the respective color layer in the layer settings
dialog and selected the adequate palettes at the design. Further information about
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this can be found here: please refer to 7.3: The Layer Tab

Tip: The switch between the single fields is done the fastest way with the
TABULATOR key.

Fig. 6.10-2: Job restrictions

To each job following restrictions can be added:

No output

This job cannot be output.

No export

This job cannot be exported and thus cannot be converted to another format.

No printing

This job cannot be printed.

No saving

This job cannot be saved.

Password protection

In addition to the restrictions described above, a password can be given to each CoCut

job. This way, the unauthorized access to these job data is not possible.
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Fig. 6.10-3: Dialog for the determination of a job password
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When outputting to a connected device, the safety instructions of the

machine manufacturer must always be observed strictly.

No liability is assumed for infringement.

6.11 The Plot Manager

The Plot Manager has the following tasks:

6.11.1 Creation and Modification of Device Configurations

With the Plot Manager it is possible to create a device configuration or short, to create an

output device. In a device all information necessary for the output of the data as for

example driver and ports are summarized.

In CoCut, these devices then can be used for the output of the graphics. It is possible, to

output simultaneously at several devices.

6.11.2 Monitoring the Output Processes of the Jobs

The outputs to the respective devices can be monitored with the Plot Manager, for

example the output can be broken or aborted and the sequence of the jobs can be

changed retroactively.

6.11.3 Output of Data to Local Ports

The serial and parallel ports of the computer are identified and can be used for the file

output.

6.11.4 Administration of Hotfolders

A function independent of CoCut is the administration of Hotfolder. A Hotfolder is a

directory monitored by the Plot Manager. If a file is copied to this directory the Plot

Manager carries out automatically certain configurable functions.

6.11.5 Plot Server Function

The Plot Manager can enable devices so that other Plot Managers can use these enabled
devices. This allows separating design and output working places.

Important note: You start the Plot Manager with a double click on the  icon that is
down right of the screen in the task bar.
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Fig. 6.11-1: Plot Manager main window with job preview down left

6.11.6 Devices Folder

Each device possesses three device folders in which the jobs are shown:

Indication: with jobs, also those output actions are meant that are carried out by
Hotfolders or on local ports.

Devices Folder 1

Active Jobs
All jobs that shall be output as soon as the device is ready are collected in this folder. If a

job has been output completely, the next job is output. If the option „show message

window before output of a job” is active, a notification dialog is shown before each output.

Devices Folder 2

Passive Jobs
If the output device is broken, all jobs to be output are moved to this folder.

Devices Folder 3

 Saved Jobs
Here, all jobs that have been output are saved. The number of the saved jobs can be

indicated in the options dialog of the device. If the number of the saved jobs is reached the
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next one to be saved replaces the oldest existing job.

Job Functions

The functions differ according to device folder, device type and job status.

Indication: The functions can be carried out via a context menu.

6.11.6.1 Jobs at local devices

Active Jobs
If the job is being output:

Pause

The output of the data is paused. The job is marked with the symbol.

Paused Jobs

Continue

The output is continued.

Set Job to passive

The job is removed from the list of the active jobs and added to the folder of the passive

jobs.

Delete Job

The job is deleted.

Passive Jobs

Activate Job

The job is removed from the list of the passive jobs and added to the folder of the active

jobs.

Delete Job

The job is deleted.

User message: to this job, a notification text can be entered. This information is shown if
the job shall be output respective if it is selected.

Saved Jobs

Activate Job

The job is removed from the list of the output jobs and added to the folders of the passive

or active jobs depending on the setup device.

Delete Job

The job is deleted.

Plot to File

Here you can determine if the job shall be output to a file.

6.11.6 Devices Folder
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Save as

Save job data into file before cut data processing.

6.11.6.2 Jobs at Plot Servers

Active Jobs
No functions

Passive Jobs

Activate Job

The job is removed from the list of the passive jobs and added to the folder of the active

jobs.

Delete Job

The job is deleted.

User message: to this job, a notification text can be entered. This information is shown if

the job shall be output respective if it is selected.

Saved Jobs

Activate Job

The job is removed from the list of the output jobs and added to the folder of the passive or

active jobs depending to the setup device.

Delete job

The job is deleted.

Save as

Save job data into file before cut data processing.

6.11.6.3 Jobs at Hotfolders

Active Jobs
No functions

Passive Jobs

Activate Job

The job is removed from the list of the passive jobs and added to the folder of the active

jobs.

Delete Job

The job is deleted.

User message: To this job, a notification text can be entered. This information is shown if
the job shall be output respective if it is selected.
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Saved Jobs

Activate Job

The job is removed from the list of the output jobs and added to the folder of the passive or

active jobs depending to the setup device.

Delete Job

The job is deleted.

Save as

Save job data into file before cut data processing.

6.11.6.4 Jobs at local ports

Active Jobs
If the job is being output:

Pause

The output of the data is broken. The job is marked with the  symbol.

Paused Jobs

Continue

The output is continued.

Set Job to passive

The job is removed from the list of the active jobs and added to the folder of the passive

jobs.

Delete Job

The job is deleted.

Passive Jobs

Activate Job

The job is removed from the list of the passive jobs and added to the folder of the active
jobs.

Delete Job

The job is deleted.

Notification: To this job, a notification text can be entered. This information is shown if the

job shall be output respective if it is selected.

Saved Jobs

Activate Job

The job is removed from the list of the output jobs and added to the folder of the passive or
active jobs depending to the setup device.
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Delete Job

The job is deleted.

Plot to File

Here you can determine if the job shall be output to a file.

Save as

Save job data into file before cut data processing.

6.11.7 Settings of the Plot Manager

Fig. 6.11-2: Optional parameters for the Plot-Manager

If the option is activated Plot Manager always on top, the Plot Manager window remains

always in the foreground.

If the option tooltips is activated, a short description to a dialog element is shown if the

mouse pointer remains above the dialog element.

If the option view job preview is activated a preview of the output data is shown.

Command line parameters

If the Plot-Manager is started without parameters it checks all devices if there are jobs for
processing.

If a job was found it is carried out. It stops if no jobs were found or if all jobs have been
processed.

If, when calling up the parameter !SPOOL! is given, the Plot Manager remains active. It

then has to be terminated manually with a right mouse click onto the symbol in the

taskbar.

Hotfolder

With a Hotfolder a directory can be monitored. If a file is copied to the directory to be

monitored one of the following actions is carried out automatically depending on the
settings:
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Fig. 6.11-3: Example for setup devices of a Hotfolder

Settings

Hotfolder name: here you have to enter the name of the Hotfolder

File mask: here, the file name ending are given, that shall be considered, for example *.plt.

Hotfolder directory: here, it is determined which directory the Hotfolder shall monitor.

Output

COM/LPT: the file is output to a local serial respective parallel port.

USB: the file is output to a USB device. A USB device is only shown if it is connected with

the computer.

TCP/IP: the file is send to a TCP/IP address. With some addresses, you additionally have

to enter the right port number.

Spooler: the file is output via a printer driver.

File: the file is copied to the output directory. An existing file with the same name is

overwritten.
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After having carried out the action, the input file is deleted.

Indication: if "file" is set as output, the application is started after the copy. In all other

cases, the application is started before the output.

Extended Settings

Start application if Hotfolder becomes active: in addition, another application can be

started that shall further process the input file to be processed. The file name is marked

with %s.

RIP: only necessary if Pjannto RIP uses this Hotfolder as RIP Hotfolder.

Mask: formatting of the output file name: %File file name; date/time:

%Y-%m-%d_%H-%M-%S year/month/day: hour/minute/second

Change defaults: prevents that the user modifies the output parameters accidentally.

6.11.7.1 Device Options

In the Device Options window you can set - for each device which is listed in the Plot

Manager - the following device options.

Note: This window will be enabled by clicking with the right mouse button on a
device item and selecting the Options menu item.

Fig. 6.11-4: Additional options for each device

Maximal number of saved output files

The registered value of this option limits the number of saved output jobs for this device in

the history of stored files.

Number of outputs (of a Job)

The registered value of this option defines how often active Jobs will be given out.
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Inform user before output

If this option is enabled, then a message window will be shown, before the outputting of

each Job. This gives the user the opportunity to prepare the machine before the data

output.

Plot to File

If this option is enabled, then the output is redirected to a file. Before writing the file to the

Job Save As dialog is enabled.

Activate Sound Signal

If this option is enabled, then an individual sound signal will be given out before each

output of a Job, in order to draw attention to the user.

A sound file in the WAV file format can be selected using the  button.

The Movement... Button

Fig. 6.11-5: Distances of the used tools

This feature tracks the distance (tool motion), from every tool of the activated output

device in meters. In addition to the distance, date and time of each output are given.

6.11.7.2 Context-sensitive Buttons

Context-sensitive buttons are displayed for functions that would otherwise only be
accessible via the right mouse button or a context menu.
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Options Button

A click on the Options button opens the following dialog:

Reset Button

Prerequisite: The driver is selected - here: Device Driver. Clicking the Reset button
ensures that all temporary files of this driver are deleted from the queue of the machine.

Note: The cutters have buffer memories that must be emptied on the machine itself
if it is to be ensured that all data has been deleted.
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Activate / Delete Buttons

These buttons become visible when a job is selected. This can be an active, a passive or

a saved job.

Activate Button

Clicking the Activate button activates a passive job or a job that has already been given

out. Jobs that have already been given out can be repeated identically as often as desired.

Delete Button

The Delete button deletes the selected job from the list.
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Pause Button

A click on the Pause button interrupts the data flow of the selected job to the device.

Note: The output devices have buffer memories that ensure that data transfer can
take place without interruption. Only when the buffer memory has been manually
emptied at the machine output is actually stopped.
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Continue Button

Clicking the Continue button continues the data transfer.
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Summary: Depending on what was selected in the Output Status area, additional

appropriate buttons appear.
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6.12 The PhotoCUT Function

PhotoCUT creates vectors out of bitmaps. PhotoCUT calculates from Windows bitmap

files (*.BMP, *.PCX, *.TIF) raster strips or patterns that can be output with a cutting plotter.

The picture is divided in logical pixel and the average gray value detected for each of

these logical pixel. A picture is created that has fewer pixels than the original. Then,

horizontal or vertical strips, circles, squares, ... are created from this picture whose width is

proportional to the gray value at the respective position.

6.12.1 The PhotoCUT Dialog

Open the PhotoCUT dialog by selecting the so named menu item in the tools menu.

Fig. 6.12-1: Dialog with parameter-setup

General settings

Pixel in X-direction

In this field, enter the number of pixel that shall be combined to a logical pixel in
X-direction. The smaller the value in this field, the better the output quality of the "picture".
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Pixel in Y-direction

In this field, enter the number of pixel that shall be combined to a logical pixel in
Y-orientation. The smaller the value in this field, the better the output quality of the

"picture".

Remaining width

This value determines the remaining width of a strip (only with strips) in mm of the line

respective column size.

Excursion: contrast (adjust via image menu contrast)

Because of the division of the bitmaps into logical pixel the line respective column size is

determined. The width of a strip depends on the set gray value and the contrast. The

maximum width is line respective column size minus the value of the remaining width.

Corresponding to the contrast value the width of the strip is identified by the average

shade of gray. The contrast is the proportion between white and black in %, which means

with 100% contrast the 100% black is mapped on the maximum and 100% white on the

minimum width of the stripe. If the contrast is reduced, the 100% black is only calculated

with for example 50% of the maximum width of the stripe.

Minimum gray value

The Minimum gray value is a limit for the shade of gray. You can for example remove a

constant gray bitmap background.

Indication: This value is only relevant if a graphic is darker than its background.

For all examples the following picture serves as template: (Standard path: C:\Program
Files\EUROSYSTEMS\CoCut Professional XT\Bitmaps\photo.bmp)

Fig. 6.12-2: Template for all following result examples
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Negative

The range of value of the shades of gray is reversed which means that 100% black

become 0% white and vice versa.

Positive Negative

Fig. 6.12-3: Example for the reversion of the range of value

Reverse direction (only with stripes)

If this option is activated, the width of the stripe is aligned downwards.

Width of stripe upwards Width of stripe downwards

Fig. 6.12-4: Example for the reversion of the width of stripe
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Cut out

Width of stripe upwards Width of stripe downwards

Double (only with stripes)

If this option is activated, the width of stripe is created up and down.

Width of stripe up and down

Fig. 6.12-5: Example for „double”

Horizontal or vertical

With the options horizontal or vertical the direction of the stripe is determined.

Bitmap

In the area named bitmap the file data of the template (of the picture) are shown. In the

upper area the width and height of the picture in pixel are indicated and the resolution in

dpi. Underneath, the width and height of the picture are shown in millimeters.

Depending on the functions in the area general settings different effects are created.

Example 1

Following values have been set:

Pixel in X-direction = 1

Pixel in Y-direction = 10

Remaining width = 0
Contrast = 80
Minimum gray value = 0

Orientation = horizontal

6.12.1 The PhotoCUT Dialog

205



Negative = not active
Reverse direction = no active

Double = not active

Result

Fig. 6.12-6: Result from the value of example 1

Example 2

Following values have been set:

Pixel in X-direction = 3

Pixel in Y-direction = 15

Remaining width = 5

Contrast = 60

Minimum gray value = 0

Orientation = horizontal

Negative = not active

Reverse direction = not active

Double = not active
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Result

Fig. 6.12-7: Result from the value of example 2

With the 2 examples you can see that already small modifications of the values lead to big

discrepancies with the result.

Weeding aid

Create weeding aid

The stripes at the ends are automatically thickened so that the result can be wed faster.

Stripes per strap

In this field the number of stripes that shall contain a strap can be set.

Width of strap

In this field you define the width of a strap.

For information, underneath these fields the estimated number of objects is shown. This

is important to decide beforehand if the expenditure of time for the weeding is in a
responsible relation to the complexity. 

6.12.1 The PhotoCUT Dialog
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Fig. 6.12-8: Example for stripes per strap, width of strap and stripes

The different modi

In the PhotoCUT dialog you can select between following modi: stripes, rhombuses,

circles, rectangles, single rhombuses, single circles, single rectangles.

With which mode you obtain the best and most attractive result depends strongly of the

used template. Templates rich in contrast are usually better suited for optically interesting
results.  

Tip: The screen does not always show a view that enables a reliable evaluation of
the results. Therefore, print the result on your printer. Now you can judge the result
of the procedure relatively exactly and do not risk to waste expensive material!

6.12.1 The PhotoCUT Dialog
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7 The Sidebar

The Sidebar is switched on or off via the Window menu.
CTRL+2

7.1 Term Definition Sidebar

A "sidebar" means a lateral toolbar with tabs. It is comparable to the so-called docking

bars in CorelDRAW. In summary, we find the layer editing (formerly Layerbox), the clip art

manager, object manager, file manager, and the macros.

Functionality of the Sidebar for the user:

The Sidebar summarizes different tools. Previously distributed toolbars such as Layerbar,

Clipart Manager were combined in a compact tab structure. The sidebar serves as a

central element of the object management.

7.2 The Anchorage Control

Fig. 7.2-1: Anchorage control with arrow and dotted line for moving and placing

Note: Only in the docked state, the Anchorage control is activated and visible.
The Collapse Button

Pressing the Collapse button folds in the sidebar so that only the tab bar and the Unfold
button stay visible on the right side.

The Unfold Button

Enabling the Unfold button folds out the sidebar to the previous set size.

The Close Button

Pressing the Close button removes the sidebar from the program user interface.

The Dotted Line

The Dotted Line is used to move the entire sidebar. While the left mouse button is hold
down, the sidebar can be moved to any place. Double-clicking on the dotted line looses
the sidebar as well. Double-clicking on the head or moving the mouse towards the right

edge of the bar anchors the sidebar.
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The Tab Bar

Fig. 7.2-2: Tab bar with activated layer tab

The selection is done by clicking on the appropriate tab.

Note: The bar may include, depending on the program version more, less or other
than those shown tabs.

7.2 The Anchorage Control
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7.3 The Layer Tab

The Sidebar is switched on or off via the Window Menu. Selection using

the Layer tab.
CTRL+2

The Layer area serves for the coloring of objects, the definition of foil colors, the selection

of objects that have a layer color, the locking and the hiding of color layers as well as the

allocation of output tools.

7.3.1 A) The Layer Area

7.3.2 B) The Layer Options

Fig. 7.3-1: The New button

This option generates a new layer an opens the corresponding dialog.

Fig. 7.3-2: The Sel(ect) button

This option selects the clicked Layer.

7.3 The Layer Tab
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7.3.3 C) The Palettes Options

Layer numbers

The activation of this option switches on or off the numbering next to the color bar.

7.3.3.1 Layer Info Dialog

Layer Info...

opens the following Setup Layer dialog.

Fig. 7.3-3: Setup Layer Dialog

When mouse over layer, show following info,

the activated information is shown in so-called Tooltip.

7.3.3 C) The Palettes Options
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In addition, the used part of color bar to this info %, number of visible layers can be
defined and the window width of the layer toolbar can be changed interactively.

7.3.3.2 Layer Order Dialog

Fig. 7.3-4: The Change Layer Order Dialog

The sequence of the layers can be changed arbitrarily. To do so, please use the up,
down, to top, to bottom button.

7.3.3.3 Only sel. layer visible

Only shows the objects that lie in the selected layer.

7.3.3.4 Del sel. layer

The activation of this option deletes the selected layer.

Note: This option can only be activated if no objects lie in this layer, if the layer is
unused.

7.3.3.5 Delete unused layer

All layers that do not contain any objects (unused) are deleted.

7.3.3 C) The Palettes Options
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7.3.3.6 New Palette

This option generates a new color palette.

Note: 6 base layers will always be created. Order and color can be changed anytime.

7.3.3.7 Load Palette...

Previously defined palettes can be loaded.

7.3.3.8 Save Palette

With this instruction a newly defined or modified palette is saved on your hard disk.

Note: If a new or changed palette is named 'Default', this palette is used at every
restart of CoCut.

7.3.3.9 Save Palette As...

This instruction allows the renaming of a palette name and save the palette using the new

name.

7.3.3.10 Default

This instruction loads the color palette that is delivered as standard with CoCut. It is a

Mactac foil table.

7.3.4 Status Indicator Layer

Fig. 7.3-5: Layer status view

Object in layer color

Is a layer marked with this symbol, it means that objects are in this color or layer

assignment exists. The selection is easiest using the  button.

Not visible layer

Is a layer marked with this symbol, it means that objects in this color or layer assignments

are not visible at present. They exist and can be switched visible if needed. In general
layers are set to invisible, if they are obstructive while designing.

7.3.3 C) The Palettes Options
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Locked layer

Is a layer marked with this symbol, it means that objects in this color or layer assignments

are locked, thus can not be edited, moved or scaled.

Tool assigned

If a layer is marked with this symbol, this means that a tool from the selected device driver

has been assigned to this layer. All objects that are in this layer are given out using this

tool.

Layer active but not occupied

Is a layer marked with a frame, it means that no objects are available in this color or layer

assignment, but the layer is active. Now, for example, objects can be filled with that color

or contour and layer assignments can be done. The number indicates the layer number

and the depth of arrangement.

Note: The term depth of arrangement means that objects with a lower number are
drawn before those with higher numbers. The layer order also has an influence on
the drawing sequence.

Object in layer and active

Is a layer marked with a frame and this symbol, it means that the layer is active and there

are objects in that color (or layer assignments) on the desktop. The number indicates the

layer number and the depth of arrangement.

Note: The term depth of arrangement means that objects with a lower number are
drawn before those with higher numbers. The layer order also has an influence on
the drawing sequence.

7.3.4 Status Indicator Layer
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7.3.5 The Layer Settings dialog

7.3.5.1 The Color Tab

Fig. 7.3-6: Default view of the color tab window

7.3.5.1.1 The Color selection

The color can be selected by clicking in the large color field in the middle of the window or
by clicking on one of the color fields below the middle color field. The lower color field
allows the direct selection of gray tones in 10% increments, red, green, blue, cyan,

magenta, yellow, black, as well as the secondary colors orange and dark green. The
settings are accepted with OK. The Cancel button closes the window without making any

changes.

7.3.5 The Layer Settings dialog
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Color model

The user has three color models to choose from in the Layer settings dialog:

1. CMYK - Cyan, Magenta, Yellow, Key (Black)

2. RGB - Red, Green, Blue

3. HSB - Hue, Saturation, Brightness

Brightness control

The brightness of the active color can be adjusted from 100-0% using the slider to the

right of the brightness strip. The % value is displayed in the HSB color model in the

brightness field.

The Layer / Palette Button

Save

Saves an additional layer with the individual settings.

Insert

Inserts a layer into the Layer toolbar.

Delete

Deletes a layer from the Layer toolbar.

Save palette

This option saves all changes made in the corresponding palette file in the Pal
subdirectory.

7.3.5.1.2 Eigenschaften-Layer-Optionen

Locked

If this option is activated, the selected layer is locked, which means that objects in this

color, this layer cannot be edited, moved or scaled. The layer is marked with the locked
symbol.

7.3.5 The Layer Settings dialog
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Hidden

If this option is activated, all objects in this color, this layer are made invisible. The layer is

marked with the not visible symbol.

Spot Color

A Spot color is a color with an exactly defined RGB or CMYK color value. Unlike process

colors, a spot color can be printed in one print run; it is not mixed from other colors.

Note: The color name entered in this field is written to the output file during EPS
export. This option is often used for the definition of cutting paths or the spot color
is treated like a special channel in Photoshop.

Material name

A material can be assigned to a layer in this field. This information is displayed to the user

when the mouse pointer is positioned over the corresponding layer.

Color number

A number can be assigned to a layer in this field. This information is displayed to the user

when the mouse pointer is positioned over the corresponding layer.

7.3.5.1.3 The Eyedropper

The Eyedropper function, also known as the color picker, can pick up colors from vector

objects or from anywhere in an image to add to the palette colors.

After clicking the eyedropper button, the mouse cursor turns into an eyedropper. Now you
can use the pipette tip to pick up the color of an outline, a fill, or a pixel of a bitmap. The

captured color is then displayed in the display field at the top right of the dialog and the
color value is entered in the color value fields (CMYK and RGB).

Then you can save the layer color value using the Layer / Palette button. Either the

individual layer (Save...) or the entire color palette (Save Palette...) can be saved.

The eyedropper function is terminated by the ESC key or by clicking on the Eyedropper
button.

Note: The Layer dialog is opened by clicking with the right mouse button.

7.3.5 The Layer Settings dialog
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7.3.5.2 The Output Tab

Fig. 7.3-7: Default view of the output tab window

The Layer / Palette button

7.3.5 The Layer Settings dialog
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Save

Saves an additional layer with the individual settings.

Insert

Inserts a layer into the Layer toolbar.

Delete

Deletes a layer from the Layer toolbar.

Save palette

This option saves all changes made in the corresponding palette file in the Pal
subdirectory.

7.3.5.2.1 Properties Layer Options

Locked

If this option is activated, the selected layer is locked, which means that objects in this

color, this layer cannot be edited, moved or scaled. The layer is marked with the locked

symbol.

Hidden

If this option is activated, all objects in this color, this layer are made invisible. The layer is

marked with the not visible symbol.

Information / Method

Information or a method can be assigned to a layer in this field. This information is

displayed to the user when the mouse pointer is positioned over the corresponding layer.

Note: If assignments are already predefined in the device driver, the method can be
selected in the list.

Mode / Tool

A mode or tool can be assigned to a layer in this field. This information is displayed to the
user when the mouse pointer is positioned over the corresponding layer.

Note: If assignments are already predefined in the device driver, the tool can be
selected in the list.

After selecting the tool, the following additional option appears:

7.3.5 The Layer Settings dialog
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Material

A material can be assigned to a tool in this field. This information is displayed to the user

when the mouse pointer is positioned over the corresponding layer.

Add

Clicking on the Add option opens a window for entering a new material.

Note: The parameters of the added material can now be changed. If the changes are
to be permanent, this must be done using the Save profile option.

Delete

Clicking on the Delete button deletes the selected material from the material list.

Save profile

This option saves the changed parameters in a material profile associated with the

material.

Mode/Tool defaults

Activating this option resets the values to the mode/tool defaults specified in the device

driver.

Material defaults

Activating this option resets the values to the material defaults specified in the device

driver.

Layer defaults

Activating this option resets the values to the layer defaults.

Parameter

The tool parameters are displayed on the right-hand side of the dialog. Changes to the
associated parameters can be made here.

7.3.5 The Layer Settings dialog
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Fig. 7.3-8: Parameter view after Kiss Cutting Knife Tool selection

7.3.5 The Layer Settings dialog
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7.3.6 Hotkeys in the Layer Processing

The following hotkeys are available in the layer processing. 

Adjacent hotkey opens the Layer Settings dialog box L

Jump in the toolbar

POS 1 key Jump to the first layer

END key Jump to the last layer

PgUp key Jump to 1/10 of the total layer number

CURSOR up / down Jump to the next layer

Color assignment via the toolbar

Double-click assigns the layer color to marked objects

Double-click + CTRL
key

assigns to marked objects a pen contour in the active layer

color

Movement of single layers / modification of the sequence

1. Step: Position mouse cursor on wanted layer

2. Step: Press left mouse button and keep pressed

3. Step: Move layer to the wanted position

4. Step: Press once right mouse button

5. Result: The layer is at the new position

7.3.6 Hotkeys in the Layer Processing
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7.4 The Files Tab

The Sidebar is switched on or off via the Window Menu. Selection using

the Files tab.
CTRL+2

Fig. 7.4-1: File preview images (Thumbnails)

7.4.1 Toolbar in the Files Tab

7.4 The Files Tab
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7.4.1.1 The Create New Search Path Button

Fig. 7.4-2: Create New Search Path button

The following dialog appears if the open job option was activated.

Fig. 7.4-3: Settings - Job open window

The following dialog appears if the import file option was activated.

Fig. 7.4-4: Settings - Import file window

7.4.1 Toolbar in the Files Tab
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7.4.1.1.1 The Monitor Folder Option

If the monitor folder option is activated, then the in the search path mentioned folder is

monitored. The result is that whenever a file is copied to this folder, the display is updated.

The search must not be updated manually.

7.4.1.1.2 The With Subfolders Option

If the with subfolders option is activated, then all folders which are located below the

selected folder are included in the file search.

7.4.1.1.3 The Hotfolder Option

7.4.1.1.4 Formats

In the following list of file formats can be selected, which formats in the search path should

be taken into account. A multiple selection is possible.

7.4.1.2 The Edit Search Path Button

In the Edit search path dialog one selects, which file format should be searched in the

selected Folder.

Fig. 7.4-5: Edit Search Path Button

The following dialog appears if the edit search path option was activated.

Fig. 7.4-6: Open job window

The following dialog appears if the edit search path option was activated.

7.4.1 Toolbar in the Files Tab
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Fig. 7.4-7: Import file window

7.4.1.3 Save Modifications Button

The activation of the save modifications button saves all current settings from the files
tab.

7.4.1.4 Update Button

The activation of the update button rereads the selected search path and

generates up-to-date preview images (thumbnails).

7.4.1.5 The Settings Dialog

The activation of the Settings button opens the following dialog, where you can set up the

parameters of the thumbnails in the file preview area.

7.4.1 Toolbar in the Files Tab
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Fig. 7.4-8: Settings Dialog for the File Search

7.4.1.5.1 Compression

The variation of the compression influences the displayed quality of the thumbnails in the

preview area. Moving the slide control in the direction of High, improves the display

quality. Moving the slide control in the direction of Low, reduces the display quality.

Indication: In case of Jobs no effect ist visible, because the job's thumbnail is
stored in the file in a fixed size.

7.4.1.5.2 Priority

Priority assigns more or less computing time for the generation of the thumbnails. The

more computing time is assigned is assigned to this process, the faster the thumbnails are

displayed in the preview area respectively updated.

7.4.1.5.3 Other Settings

The Prefer Contour Mode Image Option

If the Prefer contour mode image option is enabled, then the thumbnails will

be displayed in the contour mode and not in the full surface mode.

The Enabled Tool Tips Option

If the  Enabled Tool Tips option is enabled, then exolanatory texts are displayed at the

cursor position.

7.4.1 Toolbar in the Files Tab

228



7.4.2 Search Paths

7.4.2.1 Open Job Button

A click with the right mouse button in this area opens the following context menu.

Description of menu items see above.

7.4.2.2 Import Job Button

A click with the right mouse button in this area opens the following context menu.

Context menu

Description of menu items see above.

7.4.2.3 Properties

7.4.2.3.1 Add Folder

A click with the right mouse button into the list field activates the add folder option and

opens the following settings dialog.

7.4.2.3.2 Folder

In the folder field a search path can be specified where the files shall be searched.

Alternatively the following dialog can be activated using the  button. Select here the
folder which contains the files that should be listed.

7.4.2 Search Paths
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Fig. 7.4-9: Setting of the search path

7.4.2.3.3 Context Menu Search Path

A click with the right mouse button in a search path opens a context menu with more

menu entries.

7.4.2.3.4 Edit Search Path Menu Item

The edit search path menu item open the edit search path dialog (see fig. above).

7.4.2.3.5 Actualize Menu Item

The actualize menu item activates the file search in the selected search path.

7.4.2.3.6 Delete Menu Item

The delete menu item removes the selected menu item.

Note: A double-click on the vertical separator between the columns (here: img,
name, date, size) automatically sets the maximum possible width of each column. A
click on the column heading sort ascending or descending depending on the
selected criterion (column name). In doing so, a black triangle beneath the column

7.4.2 Search Paths
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heading shows which column is activated and if it has been sorted in ascending or
descending order.

7.4.3 Search Field and File Preview

7.4.3.1 Open or Import a file

A double-click on a preview image (thumbnail) loads (opens) the file on the CoCut working

sheet. A pull out of a file via drag & drop imports the selected file additionally to the

objects on the working sheet.

7.4.3.1.1 Reset Status

Files which are still not edited are marked with a yellow star. After opening or importing

this file the star labeling will be reversed. The star labeling serves the clarity which files in

a selected folder

were already edited and which not. The labeling can be reversed in its original state with

the reset status option.

7.4.3.1.2 Status Area

In the area underneath the thumbnails resp. list view status messages, like number of

selected files and more, are displayed.

7.4.3.2 The Magnifying Glass Button

A click on the magnifying glass button activates a transparent slider (see fig. below) with
which the view can be enlarged or reduced.

Fig. 7.4-10: Transparent slider

When the thumbnails are enlarged the number of images per line is displayed. A minimum

size of 42 x 42 pixels can not be undercut.

7.4.3.3 The List View Button

The list view button switches from the thumbnail view in a list view and vice versa.

7.4.3 Search Field and File Preview
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7.4.3.3.1 The List View

Fig. 7.4-11: List view with search field

7.4.3 Search Field and File Preview
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7.4.3.3.2 The File Preview In The List View

Fig. 7.4-12: List view with file preview popup window

7.4.3 Search Field and File Preview
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7.4.3.3.3 Thumbnail View

A so-called thumbnail is a decreased pixel view of a file.

Fig. 7.4-13: Preview images (Thumbnails)

Note: The thumbnail preview is often of much help when searching files whose
names are unknown or have been forgotten.

7.4.3.4 The Search Field

The search field serves to accelerate search requests. Depending on, which column is

enabled (click on column name) the search is additionally performed after values from the

search field. The preselection of the search is displayed in a list of file names. Each entry

of a character in the search field refreshes the preselection.

Tip: After entry of the first letter or a number in the search field is searched in the
selection for the same file name prefix and the selection is restricted - using the
TAB key. This facilitates the search after distinguishable characteristics in file
names.

7.4.3 Search Field and File Preview
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7.5 The Objects Tab

7.5.1 The Object Manager

Basically, the Object Manager is used to list and display the elements in the job layout.

This means, for example, that objects listed at the top are also superordinate to the

elements below them in the layout. The listing in the docking window thus also reflects the

arrangement of the layers in the layout.

The Object Manager gives you access to and an overview of all the elements present in

the job. The Object Manager helps you to keep everything at hand and well sorted. From

here, all elements can be selected, object types assigned or object names assigned.

Groups and combinations of objects are broken down.

The Sidebar is switched on or off via the Window menu. Selection is done

using the Objects Tab.
CTRL+2

7.5 The Objects Tab
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7.5.1.1 Components Of The Object Manager

7.5.1.1.1 The Navigator

Tasks

- Object preview

- Navigation on the desktop and on the working sheet

- Zoom in and zoom out of the desktop and the working sheet

Fig. 7.5-1: Navigator with zoom slider, controls, vavigation area and to move rectangle

(red) 

The Zoom Slider

The Zoom Slider serves to diminish or enlarge the desktop's view. Every click to the left

or right of the slider button enlarges or shrinks the view. The button can also be slided

using the mouse cursor. When the 100% view is exceeded a red rectangle appears

additionally in the preview window. This rectangle can be moved using the mouse cursor.

The Drop-Out Menu

Invert Selection

Reverts the selection in the objects list, i. e. what was previously selected is deselected.

Show Attributes

Displays all of the selected options of the Options tab in the status bar.

7.5.1 The Object Manager
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Options…

Fig. 7.5-2: Restriktions for the object list in the Objekt Manager

The Tree Buttons

1. Unfold branches

2. Collapse branches

The Zoom Buttons

1. Show whole sheet - Hotkey B

2. Show all objects -  Hotkey F4

3. Show selected objects -  Hotkey SHIFT+F4 

7.5.1.1.2 The Color Bar

Fig. 7.5-3: Section of the color bar of the object manager

Tasks of the color bar

- color variation and assignment (Layer)

7.5.1 The Object Manager
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7.5.1.1.3 The Area Object List - Object Tree

Selection with mouse click

1. One click selects

2. SHIFT+Click selects several in sequence

3. CTRL+Click selects several not immediately contiguous objects

A click on plus / minus opens or closes the tree (cf. Windows Explorer)

7.5.1.1.4 Object Type And Object List's Attributes Selection

Task: Definition of the objects which should be displayed in the object list.

7.5.1.1.5 The Name Field

Task: Define alias or field name

Purpose: Apply macros or scripts on field value e. g. substitute objects, properties, …

Fig. 7.5-4: Context menu name field

Add To List Menu Item

Adds the entry from the Name field to the name suggestion list.

Save With Attributs Menu Item

Saves additionally to the names the selected attributes (object properties).

Delete From List Menu Item

Deletes the selected entry from the name suggestion list.

Select Objekts Menu Item

Selects all objects with this name that are located on the working sheet.

Assign Menu Item

Assigns name from the name field to all selected objects.

7.5.1 The Object Manager
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7.5.2 The Object Types Tab

Note: Any selection or multiple selection of the restricting attributes is possible at
any time.

All

Shows all object types in the object list.

Vector objects

Shows all resp. only vector objects in the object list.

Text objects

Shows all resp. only text objects in the object list.

Bitmaps

Shows all resp. only bitmaps in the object list.

Combinations

Shows all resp. only combinations in the object list.

Groups

Shows all resp. only groups in the object list.

Container

Shows all resp. only containers in the object list.

Register marks

Shows all resp. only jog marks in the object list.

7.5.2 The Object Types Tab
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Drill holes

Shows all resp. only drill holes in the object list.

Video marks

Shows all resp. only video marks in the object list.

Print marks

Shows all resp. only print marks in the object list.

Jog marks

Shows all resp. only Jog marks in the object list.

Die Forward / Backward button

The  button appears automatically if the column width gets to narrow to display all tabs

at once. By means of the  buttons can be scrolled back and forth between the tabs.

7.5.3 The Object Names Tab

The Object Names Tab list all defined names which were assigned to particular objects

using the Name field. Names can be used in order to individualize objects and to apply

macros.

Fig. 7.5-5: List of all object names

The Forward / Backward Button

The  button appears automatically if the column width gets to narrow to display all tabs

at once. By means of the  buttons can be scrolled back and forth between the tabs.

7.5.3 The Object Names Tab
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7.5.4 The Attributes Tab

The Attributes tab lists all restrictions, limitations that can be assigned to an arbitrary

object.

Fig. 7.5-6: List of all possible object restrictions

Note: Any selection or multiple selection of the restricting attributes is possible at
any time.
No output on device

The No output on device option prohibits that the selected object is given out on a

connected device (cutter, milling machine).

Note: Device means in that coherence devices that can be controlled from the Plot
Manager.

No output on printer

The No output on printer option prohibits that the selected object is given out on a

connected printer.

No Export

The No Export option prevents that the selected object is exported.

Limited

The Limited option marks the object with red handles. The number of object

manipulations is restricted.

The following object properties are not accessible after setting the attribute:

- Change layer

- Change rotation direction

- Delete object
- Round object

- Edit nodes
- Insert bridges

7.5.4 The Attributes Tab
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- Any bitmap manipulations
- Cut out a region

- Convert text to curves / into lines

- Set start tool paths

- Outline

- Welding

- Perform object manipulations from "Object" menu that change the object

- Replace marks

Important note: The object can only be selected individually, not as a group or
combination; neither via CTRL-A nor via layer selection or similar.

Do not move

The Do not move option prevents that the selected object can be moved. The position is

locked.

Fixed size

The Fixed size option prevents that the selected object can be scaled (enlarged or

decreased). The size is locked.

Fixed size during output

The Fixed size during output option prevents that the selected object was unintentional

scaled (enlarged or decreased) before output.

Text not editable

The Text not editable option prevents that the selected object is unintentional edited. The
Text is not changeable.

Invisible

The Invisible option makes that the selected object is not visible on the working sheet.
This option is useful every time when there is a lack of clarity.

Container

The Container option transfers an object into a container or back into the generic object.
Container:

Video mark

Special attribute resp. object which is used when camera based recognition is used. The
camera module drives the tool head with camera to the so marked objects.

Register mark

Register mark is a special object that is always cut at the same position when output on a cutting plotter,

regardless of the layer color. The purpose is the subsequent, precision-fit assembly of the

7.5.4 The Attributes Tab
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different colored materials.
Drill hole

Drill hole is a special attribute for milling applications. The object has no expansion and

can not be scaled.

Note: Drill holes can be drawn using the drawing tool

Print mark

Print or cut marks are printed additionally to the print data while printing.

Jog mark

Special objects which are required while the output on cutters with optical sensors for a

precise contour cutting. Each producer uses specific jog marks. The selection can be done

using the properties menu.

The forward / backward button

The  button appears automatically if the column width gets to narrow to display all tabs

at once. By means of the  buttons can be scrolled back and forth between the tabs.

7.5.4 The Attributes Tab
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7.6 The Cliparts Tab

7.6.1 Clipart Management

The Cliparts tab is switched on or off via the window menu.

The Cliparts tab serves for the administration of your cliparts.

You can take these so-called cliparts from the wnate clipart group via drag &

drop to the CoCut working sheet and edit them further.

CTRL+2

7.6.1.1 Definition Clipart

What is a Clipart? Cliparts are objects, parts of jobs or whole jobs that have been added

to the cliparts tab. Cliparts serve primarily to direct and quick access to design elements.

As clip art is therefore virtually everything that is needed for quick or frequent job

generating, for example sign plates of different sizes, logos, design templates, and much

more.

Cliparts are similar to jobs in the handling.

Note: Aid lines are not saved.

7.6.1.2 Add Cliparts

Cliparts can be added via drag & drop or right mouse button context menu activation

submenu "Add Cliparts".

7.6.1.3 Delete Cliparts

Cliparts can be deleted from the group using the DEL key.

7.6.1.4 Definition Clipart Folder

Folder is the structural generic term. In a Clipart Folder, several Clipart Groups can be

included.

7.6.1.5 Definition Clipart Groups

Group is the structural generic sub term. Individual cliparts are collected in Clipart
Groups.

7.6 The Cliparts Tab
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Fig. 7.6-1: Clipart area with control elements

Fig. 7.6-2: Clipart info window

The Clipart info window is displayed if the mouse cursor whiles a short period of time

above the desired thumbnail.

7.6.1 Clipart Management
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7.6.1.6 Add Clipart Folder… Button

7.6.1.7 Settings Tab

Folder Field

The selected folder in the Folder field is added to the list of clip art management.

Monitor Folder Option

With this option, the directory monitoring is turned on, ie, whenever a new file is stored in

this folder, a thumbnail is created.

With Subfolders Option

All subfolders are included in the monitoring if this option is also enabled.

7.6.1 Clipart Management
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7.6.1.8 Macro Assignments Tab

Using the Macro Assignments tab events (e. g. double-click or enter key) can be

assigned to specific functions. The possible function assignments are listed in the

Available functions area.

Additionally functions can be added to the context menu via drag & drop. After this

procedure they are listed in the Current Functions area.

7.6.1.9 Create New Clipart Group… Button

Clipart Folder Field

In this field the name of a new clipart group can be entered.

7.6.1 Clipart Management
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7.6.1.10 Rename Clipart Group Button

Clipart Folder Field

Clicking on the ... button allows the selection of the clipart folder that should be renamed.

7.6.1.11 Edit Clipart Folder… Button

Folder Field

The directory field in the selected directory can be edited.

Monitor Folder Option

With this option the folder monitoring is turned on that is, every time when a new file is
stored in this directory a thumbnail is created.

With Subfolders Option

All subfolders are included in the monitoring if this option is also enabled.

7.6.1.12 Import Clipart Files… Button

By means of this function elder CLA files can be read. All previous versions of CoCut

used the cla file format when saving cliparts. This function converts them into the new
format.

7.6.1 Clipart Management
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7.6.1.13 Refresh Button

Rereads the clipart group and generates up to date thumbnails.

7.6.1.14 Save Changes Button

7.6.1.15

Saves the current state of the clipart management.

7.6.1.16 Diminish Presentation of Folder Levels… Button

Shortens the visible path by one folder level. This provides clarity in a complex and

widespread clipart folder structure.

7.6.1.17 Increase Presentation of Folder Levels… Button

The visible path is extended by one more folder level.

7.6.1.18 Common Settings… Button

Fig. 7.6-3: Setup dialog of the Clipart Manager

Thumbnails Tab

7.6.1 Clipart Management
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Compression

This option determines which compression rate will be used when generating preview

images (Thumbnails).

Priority

This option adjusts, how the thumbnail creation  behaves in relation to the main

application. The higher the priority, the more CPU time the process gets assigned.

Other Settings

Prefer contour mode image option

Enabling this option displays the thumbnails in contour mode i. e. without color fill -

analogous to the contour mode.

7.6.1.19 Number of Thumbnails per Line Button

7.6.1.20 Slider

The slider serves to determine the number of thumbnails that can be displayed in a line.

This is based on the current width of the sidebar. Here there are 6 thumbnails that are

displayed per line.

7.6.1.21 Show Name

This option shows in the activated state the name of the clipart file in addition to the
thumnbnail.

7.6.1.22 Thumbnail View / List View Button

7.6.1.23 Thumbnail View

7.6.1 Clipart Management
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7.6.1.24 List View

7.6.1.25 The Search Field

7.6.1.26 Search by File Name

By default, is searched in the order of the letters, how they are entered.

Note: Permitted are also wildcards such as * and ?. 

Example:

Be* - searches for all file names beginning with Be

B??ling - searches for all filenames that start with B, then have 2 characters in between

and end up with ling, such as Billing

7.6.2 The Context Menus

7.6.2.1 Context Menu 1

Description of menu items: please refer to 7.6.1.6: Add Clipart Folder… Button ff

7.6.2.2 Context Menu 2

Description of menu items: please refer to 7.6.1.6: Add Clipart Folder… Button ff

7.6.2.3 Context Menu 3 Search Field

7.6.1 Clipart Management
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7.6.2.4 Context Menu 4 Clipart

7.6.2 The Context Menus
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7.7 The Macros Tab

7.7.1 The Macro Player

A double-click on a macro in the macro list opens an additional window (called the

parameter view) or executes the macro directly.

Fig. 7.7-1: Macro in Parameter View

7.7.1.1 The Control Elements of an Active Macro

7.7.1.1.1 The Cancel Process Button

Pressing the cancel process button breaks the macro process.

7.7 The Macros Tab
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7.7.1.1.2 The Step Back Button

If the step back button is pressed, the macro jumps back to the last executed macro

function.

7.7.1.1.3 The Execute Function Button

If the execute function button is pressed, the macro starts.

7.7.1.1.4 The Open View Button

Pressing the open view button opens the parameter view which allows entry of values

and modes.

7.7.1.1.5 The Close View Button

Pressing the close view button closes the parameter view.

7.7.1 The Macro Player
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8 Tips & Tricks - Trouble Shooting

Often, it is just a bagatelle that makes the "implementation" of new software

difficult. Similar to a new machine, there are questions and problems with new software

that often can be explained and solved easily. Therefore, we have explained a selection of

questions that occur daily at our hotline- and support routine more closely.

8.1 Code is not accepted with Windows 7, 8, 10 or 11 (No
Dongle)

Error message: Invalid code or after each program start the code must
be entered again

The program must be executed once with aministrator rights. Click with the

right mouse button in the program menu on CoCut Professional XT and

select "Execute as administrator".

Note: Don't change anything on the given activation data resp. license
data.

Tip 1

8.2 Buffer Overflow Serial Port

The cutter cuts the first characters neatly and then starts to draw
indefinable curves. 

With serial activation of the cutter, this is a typical buffer overflow problem

and occurs if the protocol for the serial transfer is not set correctly. Most

cutters are activated with the following parameters with a serial data

transfer: bits per second: 9600, data bits: 8, parity: none, stop bits: 1,

protocol resp. flow control: hardware

Tip 2

8.3 Output Size Mimaki

The output size on a Mimaki cutter does not correspond with the
configured size but is more than twice as big.

The Mimaki cutter of the CG series is delivered ex works with a plot
resolution of 0.025 mm even if they can work with a resolution of 0.01 mm

and do so internally. The drivers of CoCut are set to these
„device”-resolution because the cutters can be activated faster and more

accurate.

For the adjustment of this plot resolution you switch on the cutter, press the
< button at the control panel and after the cutter has measured the roll you

press the function key until "interface" appears in the display. Then, you

press the ENTER key until you reach the menu item "Stepsize" and then the
^-button. The display now shows „0.01”. Confirm the selection with ENTER

and END.

Tip 3
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8.4 Output Size Graphtec

The output size on my Graphtec cutter does not correspond with the
configured size but is more than twice as big.

Setting the step size:

In the GP-GL mode it is possible to set the minimal distance of the cutting

knife's path to one of the following widths: 0.01 mm, 0.025 mm, 0.05 mm or

0.1 mm. The default setting is 0.1 mm. This value must be changed, if your

program's driver uses another step size.

Step 1: Switch into the command mode "GP-GL".

Step 2: Press the enter key; the menu step size appears.

Step 3: Press , key to select the desired value (0.100 mm, 0.050 mm, 0.025

mm, or 0.010 mm) and confirm with enter key. Press (NEXT) or (PREV.)

to undo your selection.

Step 4: Press (PAUSE) key in order to cancel the PAUSE mode.

In the case of controlling the plotter from CoCut, the value of the step

size must be set to 0.025. This is the resolution which is preconfigured in the

drivers.

Tip 4

8.5 Calibration of the Output Size

Problem: The size entered in the software and the output size of the
objects do not match.

Solution: Calibration must be performed on the connected cutter.

Calibration means: checking and, if necessary, changing the values stored

in the driver to the values you have measured.

Method:

Activate the following dialog in the Settings / Standard Settings / Output

Devices... menu.

Tip 5

8.4 Output Size Graphtec
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Clicking the Calibrate button opens the Calibrate Device dialog.

8.5 Calibration of the Output Size
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Now carry out the calibration step by step.

Step 1: Specify the size of the rectangle to be output. Get the cutter ready

for output. Start the output by clicking on the Rectangle button.

Step 2: Weed the rectangle and measure it with a ruler. Enter the measured
values in the Length (X) and Width (Y) fields under Measure (Step 2). Then

click on the Calibrate button. The new values are now entered into the
driver.

Note: You can repeat this process. The maximum accuracy to be
achieved depends only on the connected device. Low-cost devices
often only achieve an accuracy of +/- 0.5 mm. Professional vinyl
cutters achieve an accuracy of ≥ +/- 0.1 mm.

8.6 Computer without serial COM port

My computer provides no serial COM port, but a USB port. How can I
connect my cutting plotter, which provides only a serial interface?

In this case there is a computer accessory called - USB serial adapter-  that

provides one or more serial COM ports on one USB port.

Tip 6

8.6 Computer without serial COM port
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Note: Not all adapters offered work properly, especially the use on
64-bit operating systems is sometimes not free from errors. It may be
that different adapters must be tried.

8.7 Cutter Does Not Respond!

a. First check if you have selected the correct cutter driver and the correct

port: for example <device name> at COM2 in the CoCut cutting dialog

b. COM connection: Check if the parameters of the port are set correctly. To

do so, call up the system control of Windows. In the device manager, select

the corresponding connection, for example: COM.

Popular standard parameter are: Baud: 9600, data bits: 8, parity: none, stop

bit: 1, protocol / flow control: hardware

The settings in the system control and at the cutter must be identical

otherwise no or only faulty data transfer will take place.

c. USB connection: Check if the correct USB driver is installed for the

device. The settings are in the Windows device manager under USB

controller. The USB driver for the cutting cutter must be entered in this list

otherwise no activation is possible.

If the USB driver does not appear there, install it from the delivered data

carrier of your device.

d. Original cable: Check if you use the original cable recommended by the

manufacturer. If this is not the case, there might be bigger problems during

the data transfer. CoCut „communicates” during the data transfer with the

cutter so that missing or faulty connected data cable with the cutter lead to

input or output errors.

Tip 7

8.8 Buffer Overflow

The cutter reports „buffer overflow” or does not cut the whole job

This is often because of an incorrect setting of the used protocol of the serial

(COM) port. In most cases it is sufficient to set the protocol respective the
flow control of the port to hardware.

Tip 8

8.9 Script Font Welding

The automatic welding of script fonts does not work as expected

The success rate with the automatic welding increases clearly if the letter
spacing is reduced from 100% to 99.9% or even 99%. This results in the fact

that two nodes that lie mathematically exactly on top of the other can be
slightly moved so that they can be "identified" as two dots.

Tip 9

8.7 Cutter Does Not Respond!
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Indication: Another possibility is the modification of the kerning in the
Fontmanager for Adobe fonts with which problematic kerning pairs
can be edited.

8.10 Generate Circle Segments

With the construction of logos or signets often circle segments are needed.

They can be created as follows with the help of node editing function.

draw a circle with the wanted radius or diameter•   

mark all nodes with the node tool•   

double click on the origin•   

select separate•   

Afterwards, all circle segments are available and can be selected with the

arrow tool. 

Tip 10

8.11 Data Import From Apple Computers

Data import from Apple computers in CoCut

When exporting Apple data you have to pay attention to some settings to

have a perfect data export. All popular Apple compatible illustration and

graphic applications can export EPS data. (Illustrator, …)

For the contours, as line width only hairline (0.01 mm) must be

entered.

1. 

No fillings should be transferred.2. 

All texts must be converted to graphical objects. (text in curves)3. 

Grouped or combined objects must not be available. (break up

before)

4. 

As file name extension *.EPS should be used and you should not
use umlauts as ä, ö, ü.

5. 

Tip 11

8.12 Typical Sources of Errors When Cutting

a) The foil is clamped too loose

Consequence: the knive moves the foil during the cutting and the contour is
not closed completely.

Remedy: when inserting the foil pay attention that the foil is clamped evenly

and does not undulate.

b) The speed is too high

Consequence: small foil parts especially serifs and counters are
unscrewed.

Tip 12

8.9 Script Font Welding
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Remedy: reduce speed and lower the pressure.

c) The tool pressure is too high

Consequence: the release paper is also carved, character parts are

unscrewed and parts of the release material get stuck at the characters. The

weeding of the foil gets more difficult.

Remedy: reduce pressure and correct the depth of the knife if necessary.

d) The tool pressure is too low

Consequence: foil and adhesive were only partly cut through. The weeding

is possible only with difficulty or not at all.

Remedy: increase the pressure and correct the depth of the knife if

necessary.

e) The knife is set too deep

Consequence: foil, adhesive and release material were cut. Foil cannot be

used any more.

Remedy: correct the setting of the depth of your cutting knife.

f) The knife is used up

Consequence: only the foil and not the adhesive is cut through.

Indication: when using standard foil the using up of the knife is little.
When using reflection or sandblast foil the using up is much higher.

Remedy: use new original knife.

g) The characters were unscrewed

Consequence: The weeding border is possible only with difficulty. The

unscrewed parts stick to the foil and cannot be detached any more.

Generally is presumed: the smaller the font size the thinner the foil must be;

the adhesive force of the gluten is higher.

Remedy: reduce the speed and if necessary the tool pressure until this

effect does not occur any more.

h) The release paper is also cut

Consequence: the release material sticks to the foil. The weeding is
possible only with difficulty or not at all.

8.12 Typical Sources of Errors When Cutting
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Remedy: correct the setting of the depths of the cutting knife and also
reduce if necessary the tool pressure.

8.13 Plotter Via USB Is Not Working!

Error message: Cannot open interface!

Check first, if your cutter is listed in the Device Manager (Control Panel /

System / Device Manager). If not, reinstall the device driver as described in

the plotter manual.

Check then, if the USB port for your cutter is selected in the CoCut Device
Settings. You'll find the Device Settings window in the Settings / Common
Settings / Devices menu.

Note: A USB cable should be no longer than 5 m without booster.

Tip 13

8.14 Summa Plotter Does Not Read Out!

Error message: Waiting for response... Cannot open interface...

Check, if your plotter is set on the device language DMPL. If the cutter is set

to HPGL, read out via cable is not possible.

Tip 14

8.15 The Values for Cutting Pressure And Speed Are Not
Saved

After changing the values it is often forgottten to confirm the values. Please

press the  button beside the Enter Material field and enable the Save
Material Data option.

Tip 15

8.16 Error Message While Output into File

Error message: "Error for CreateFile"

This error message is given out, if the access right Write for the program

folder of CoCut is not set.

Relief: Enable write rights for the program folder.

Tip 16

8.13 Plotter Via USB Is Not Working!
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A Driver List

New or updated drivers can be downloaded from

www.eurosystems.lu/driver/index.dml?sprache=eng.

Allen Datagraph
824 830 836

848 936

Anagraph
ANA Express AE-101 ANA Express AE-101e ANA Express

AE-120

ANA Express AE-120e ANA Express AE-60 ANA Express

AE-60e

ANA Express AE-70 ANA Express AE-75e

Aristo
AG 130 Signline AG 50 Offline AG 50 Signline

AG 600 AG 75 Signline AG 75 Signline

ABS

GL_TL ARISTOMAT 1310 ARISTOMAT 1317

ARISTOMAT 1617 ARISTOMAT 1625 ARISTOMAT

20x/30x/40x

Artsign
Artsign

ASC365
ASC365

Automated Cutting Systems
ACS Design Studio Eagle

Calcomp
Classic

Cogi
CA 1300 CA 730 CP 630
CT 1200 CT 630 E 1360

E 720 E 870

Cole
CL1100 CL1350 CL720
CL870

COPAM
CP-2500 CP-3050 CP-3500

CP-4050 CP-4500
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Creation
PCUT CR1080 PCUT CR1200 PCUT CR630

PCUT CR900 PCUT CS1080 PCUT CS1200

PCUT CS630 PCUT CS900 PCUT CT1000

PCUT CT1200 PCUT CT1300 PCUT CT1600

PCUT CT630 PCUT CT635 PCUT CT900

PCUT CTN1080E PCUT CTN1200E PCUT CTN1500

PCUT CTN630 PCUT CTN630E PCUT CTN900

PCUT CTN900E

Creation HK
King Cut KCUT A1200 King Cut KCUT A24 King Cut KCUT

A36

King Cut KCUT A48 King Cut KCUT A900 King Cut KCUT

B24

King Cut KCUT B48 King Cut KCUT B900 King Cut KCUT

CT1200

King Cut KCUT CT24 King Cut KCUT CT36 King Cut KCUT

CT48

King Cut KCUT CT630 King Cut KCUT CT760 King Cut KCUT

CT900

DAS
SmartCutter 12 SmartCutter 24

DCS
DCS-F300

Desay
XP-300P XP-380P XP-450P

XP-540P XP-660P

DGI
Omega OM-100 Omega OM-130 Omega OM-150

Omega OM-40 Omega OM-60 Omega OM-70

Omega OM-80

Emblem
EC 120 EC 60

Encad
NovaCut Series

Foison
C12 C24 C48

CT-1200 CT-630 FS-24
FS-48 S24
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GCC
AR 24 Bengal BN-60 Bobcat BI-60

Expert 24 Expert 24 LX Expert 52

Expert 52 LX Expert II 24 Expert II 24 LX

Expert II 52 Expert II 52 LX Expert Pro-132S

Expert Pro-60 i-Craft Jaguar II 101

Jaguar II 132 Jaguar II 61 Jaguar III 101

Jaguar III 132 Jaguar III 183 Jaguar III 61

Jaguar IV 101 Jaguar IV 132 Jaguar IV 183

Jaguar IV 61 Jaguar JG 101S Jaguar JG 132S

Jaguar JG 61 Jaguar JG 76S Jaguar V 101

Jaguar V 101 LX Jaguar V 132 Jaguar V 132 LX

Jaguar V 160 Jaguar V 160 LX Jaguar V 183

Jaguar V 183 LX Jaguar V 61 Jaguar V 61 LX

Puma II 132 Puma II 60 Puma III 132

Puma III 60 Puma IV 132 Puma IV 132 LX

Puma IV 60 Puma IV 60 LX Puma SP 132S

Puma SP 30 Puma SP 60 RX II-101S

RX II-132S RX II-183S RX II-61

RX II-61-CR RX-101S RX-132S

RX-183S RX-61 Sable SB-60

SignPal GRC Series SignPal LYNX S-132S SignPal LYNX

S-30

SignPal LYNX S-60 Ultra GRC-101S Ultra GRC-132S

Ultra GRC-50 Ultra GRC-61 Ultra GRC-76S

Gerber
EmbossTrack Envision 375 Envision 750

FasTrack FasTrack 1300 FasTrack 550

FasTrack 650 GS15 HS 15 /750

Odyssey P2C 1200 P2C 1400

P2C 1400 Tangential P2C 1600 P2C 1600

Tangential

P2C 600 Sprint/4B old Sprint/4B

Fastboard

Sprint/4B new

Grafityp
CSR CSR Ecom 92 CSRTurboDMPL
Flatbed

Graphtec
(HPGL) old CE 1000-60 (HPGL) CE 3000-120

(+USB)
CE 3000-40 (+USB) CE 3000-60 (+USB) CE 3000Mk2

CE 5000-120 CE 5000-40 CE 5000-60

CE 6000-120 CE 6000-40 CE 6000-60
CE 7000-130 CE 7000-160 CE 7000-40

CE 7000-60 Craft ROBO Craft ROBO PRO
II
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FC Series (GPGL) FC4100-100 (HPGL) FC4100-130
(HPGL)

FC4100-75 (HPGL) FC5100-100 (HPGL) FC5100-130

(HPGL)

FC5100-75 (HPGL) FC7000-100 FC7000-130

FC7000-160 FC7000-60 FC7000-75

FC8000-100 FC8000-130 FC8000-160

FC8000-60 FC8000-75 FC8600-100

FC8600-130 FC8600-160 FC8600-60

FC8600-75 FC9000-100 FC9000-140

FC9000-160 FC9000-75 JX 1060 (HPGL)

JX 1130 (HPGL) w/o perforation old Sign Jet Series

Gravograph
IS6000

Helo
HSP 1360 HSP 360 HSP 720

Hengxing
Rabbit HX-1000 Rabbit HX-1120 Rabbit HX-1360

Rabbit HX-630 Rabbit HX-720 Rabbit HX-800

Rabbit HX-960

HobbyCut
ABH-1351 ABH-361 ABH-721

Houston
100C DMPL 69C DMPL

HP
Latex 54 Latex 54B Latex 64

Ioline
Ioline Artpro 3500 Artpro 3700

Artpro 4000 Classic Signmaker 5000

SmarTrac I/S 110 SmarTrac I/S 130 SmarTrac I/S 60

SmarTrac I/S 85 Studio 7 Studio 8

Super 88

Jiachen
JC-1100DS JC-1100E JC-1100H

JC-1350DS JC-1350E JC-1350H

JC-720DS JC-720E JC-850DS

JC-850E JC-850H

Kierner
KS 90 (DCS)
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Kimoto
Freecut 130 Freecut 150 Freecut 60

Freecut 75

LG Palopoli
MLP-24

Liyu
HC 1201 HC 751 HC 901

MC 631 MC 801 SC 1261

SC 631 SC 801

Master
XP-300P XP-380P XP-450P

XP-540P XP-660P

Masterplot
Masterplot

MAX
CM-200

Mimaki
CG-100 CG-100AR CG-100EX

CG-100Lx CG-100SR II CG-100SR III

CG-101 CG-12 CG-121

CG-130 FX II CG-130AR CG-130EX

CG-130FX CG-130Lx CG-130SR II

CG-130SR III CG-160 FX CG-160 FX II

CG-45 CG-5 CG-50

CG-51 CG-6 CG-60AR

CG-60EX CG-60i CG-60SR

CG-60SR II CG-60SR III CG-60st

CG-61 CG-75 FX CG-75 FX II
CG-9 CG-90i CG-90SD

CJV-30-100 CJV-30-130 CJV-30-160
CJV-30-60 ME 500 ME 650

MY CUT

Mutoh
Junior 24 Kona 1400 Kona 1650

Kona 760 MC-1000 MC-1000S

MC-1300 MC-1300S MC-1650
MC-650S MC-750S SC Series

SC-1000E SC-1300E SC-550

SC-650E SC-750E TC-1000
TC-1300 TC-650 TC-750

Ultima SC 1400D ValueCut VC-1300 ValueCut VC-1800
ValueCut VC-600 XP-1251C XP-521C
XP-621C XP-941C
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New Star
Omega OM-100 Omega OM-130 Omega OM-150

Omega OM-40 Omega OM-60 Omega OM-70

Omega OM-80

ORXYZ
Elite HX-Series JML-Series

LX-Series OR-Series

Pericut
1000 1000/1300 IT (Transfer) 1300

901 901/1000/1300

PERITEC
1000/1200

Redsail
RS1120C RS1360C RS720C

RS800C

Refine
PixMax PME 720 EH-1101 EH-1351

EH-721 EH-871 MH-1101

MH-1351 MH-721 MH-871

Roland
CJ-500 CM 12 CM 24

CM 300 CM 400 CM 500

CX 12 CX 24 CX-300

CX-400 CX-500 EGX-350

GR-420 GR-540 GR-640

GR2-540 GR2-640 GS-24

GX-24 GX-300 GX-400

GX-500 GX-640 PC 50
PC 60 PNC 1000 PNC 1100

PNC 1200 PNC 1210 PNC 1410
PNC 1800 PNC 1850 PNC 1860

PNC 2100 PNC 2300 PNC 2700
PNC 5000 PNC 900 PNC 910

PNC 950 PNC 960 SP-300 (USB)

SP-300 (USB) Print & Cut SP-540 SP-540 Print & Cut

Secabo
C120 C40 C60

C60 II S120 S160

S60
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Seiki Tech
SK-1100H SK-1100T SK-1350H

SK-1350T SK-720H SK-720T

SK-850H SK-850T SK-870T

Silhouette
Cameo

Summa
S One D120 S One D140 S One D140 FX

S One D160 S One D60 S One D75

S-Class 2 S120 D S-Class 2 S120 T S-Class 2 S120

TA

S-Class 2 S140 D S-Class 2 S140 T S-Class 2 S140

TA

S-Class 2 S160 D S-Class 2 S160 T S-Class 2 S160

TA

S-Class 2 S75 D S-Class 2 S75 T S-Class 2 S75 TA

S-Class 3 S120 D S-Class 3 S120 T S-Class 3 S140 D

S-Class 3 S140 T S-Class 3 S160 D S-Class 3 S160 T

S-Class 3 S160 TC S-Class 3 S75 D S-Class 3 S75 T

S-Class 3 S75 TC S-Class S120 D S-Class S120 T

S-Class S120 TA S-Class S140 D S-Class S140 T

S-Class S140 TA S-Class S160 D S-Class S160 T

S-Class S160 TA S-Class S75 D S-Class S75 T

S-Class S75 TA SummaCut D1020 SummaCut D120 /

D120 SE

SummaCut D120R SummaCut D1220 SummaCut D140

SummaCut D140R SummaCut D15 SummaCut D160R

SummaCut D500 SummaCut D520 SummaCut D60 /

D60 SE

SummaCut D60R SummaCut D60R FX SummaCut D620

SummaCut D75R SummaCut D760 SummaSign Pro

D-Series
SummaSign Pro D1010 SummaSign Pro D1300 SummaSign Pro

D1400
SummaSign Pro D1600 SL SummaSign Pro D610 SummaSign Pro

D750
SummaSign Pro T 750 SummaSign Pro T-Series SummaSign Pro

T1010

SummaSign Pro T1300 SummaSign Pro T610 SummaSign T

1400 Pro
SummaSign T 1600 Pro SL SummaSign T1010A SummaSign T600

Summagraphics
D1000 T1000
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Technoplot
Millennium T 610 Pro Millennium T 750 Pro

Universal Drivers
DMPL 0.025 HPGL 0.01 HPGL 0.025

HPGL 0.05 HPGL/2

USCutter
MH-1101 MH-1351 MH-721

Vinyl Express
Bobcat Lynx Panther I 24

Panther I 30 Panther I 40 Panther I 50

Panther II 24 Panther II 30 Panther II 40

Panther II 50 Panther III 24 Panther III 30

Panther III 40 Panther III 50 Puma I

Puma II Q Series 100 Q Series 130

Q Series 160 Q Series 24 Q Series 30

Q Series 42 Q Series 54 Q Series 60

Q Series 64 Q Series 75 Qe60

Qe60+ R Series 19 R Series 24

R Series 31 R Series 39 R Series 44

R Series 53 ULTRA 24 ULTRA 30

ULTRA 40 ULTRA 50

VULCAN
FC-500VC

VyTek
GEM40 GEM54

Wild-Leica
TA 10 TA 10 BL TA 10 BXL

TA 10 S TA 100 TA 100 BL

TA 100 BXL TA 100 S TA 2

TA 2L TA 30 TA 30 w/o Mat. Tr.

TA 40 TA 40 TP TA 400

TA 400 (Stop bef. Tr.) TA 400 G TA 400 G (Stop

bef. Tr.)
TA 400 MC TA 400 MC (Stop bef. Tr.) TA 400 TP

TA 400 TP (Stop bef. Tr.) TA 41 TA 410 E / ES
TA 410 with suction bar TA 500 TA 500 MC
TA 510 TA 510 S

Zünd
2XL-3000 2XL-3000cv 3XL-3000

3XL-3000cv L-1200 L-1200cv
L-1600 L-1600cv L-2500
L-2500cv L-3000 L-3000cv

L-800 L-800cv LH-1600
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LR-1600 M-1200 M-1200cv
M-1200s M-1600 M-1600cv

M-800 M-800cv P-1200

P-1600 P-2000 P-700

S-800 S-800cv XL-1200

XL-1200cv XL-1600 XL-1600cv

XL-2500 XL-2500cv XL-3000

XL-3000cv XL-800 XL-800cv

Drivers marked with  are for flatbed milling and engraving machines and are only basis

drivers.
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Active and Passive Jobs Active jobs are those that are being cut. Passive jobs are

waiting in the queue for output.

Additional Programs Additional programs are program modules or stand-alone

programs that are part of the delivery.

Auto Import Plug-Ins Auto import plug-ins are used to automatically import

data from other programs - without intermediate steps.

Automatic Contour Pen
Conversion

This feature means that before the data is transferred the

software 'looks' for objects with the attribute 'contour'. If

so, the user can decide whether the contour is to be

converted or not. If the contour should be converted, then

a vector object with the width of the contour is

automatically generated!

Bitmap Functions Bitmaps are pixel images or photos. Bitmap

functions means all functions which are not vector tools

like node editing, and which are only applicable on

bitmaps.

By Color This is a welding function, which deletes all

surfaces, which are covered by overlying colors.

Bypass Cutting Direct cutting - without window - before output on the

cutter

CMX Data Transfer CMX data transfer means the handing over of data using
CorelDRAW's CMX data format. CorelDRAW had

created this format in order to ensure the exchange of
data within the Corel program families. CMX is a public

data format and is used for the exchange of data. This
has the advantage compared to EPS, that Corel specific

types of data can be copied 1:1, without making a
conversion of the format.

Cap Height Setting Cap height is the typographical correct unit of capital

letters. The text editor uses this unit by default when

calculating the font size.

Circular Text Is a special feature of the text editor with that text

blocks can be placed on or in a circle.

Clipart Tab Cliparts are job-similar files - often logos or patterns -
which are useful for the design of an output job. The

clipart tab is a sub-tab of the Sidebar, with that the
cliparts can be managed.
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Clone This function is usually used when creating labels and

series. Changes at the control object are transferred to

all clone objects.

Close
Objects (Automatically)

When importing DXF or HPGL data, many or all objects

are not closed. On a cutter only closed objects can be

processed reasonable. This function will automatically

close all vector objects. In the basic settings the

threshold for the closing of objects can be changed.

Contour Line (Print & Cut) Unlike the outline / inline bitmaps are here provided with

a vector contour. This function is regularly needed in the

creation of labels and stickers.

Create / Edit Text Block Text blocks are blocks of text that can be used more

frequently because they appear identical or similar in

many jobs - such as your address. With the PhraseWriter

arbitrary blocks of text can be created and modified as

needed.

Cut Out Region Is a bitmap function which provides the tracing of parts of

a bitmap. You can cut out any vector form out of a

bitmap.

Device Control This section deals with device control functions on the

output side.

Digitize Mode This feature means a drawing tool, that  similar
to digitizing tablet with a magnifier, draws nodes on the

working sheet.

Dongle Protection A dongle is a hardware copy protection that is stuck on

the USB port of the computer to make run the software.

The dongle protects producers against unauthorized

copying of its software and at the same time it protects

the investment of the buyer, since its competitors do not

get the software free of charge. Thus from dongle

protection both sides benefit - producers and buyers.

Drill Holes Drill holes is a special drawing tool, that marks the
position of a drill hole, using a crosshair cursor. If the

connected machine is capable of producing drill holes,
then the position is transmitted to the device driver.
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Files Tab Is a sub-element of the Sidebar, with that Jobs can be

managed. Job is the file extension, which is used from

EuroCUT.

Flatbed Cutter All cutters that have a flatbed as a cutting surface.

Folder Monitoring This function means that the software monitors a

selected folder on hard disk or network. Every time when

a change in the monitored folder occurs - by saving or

deleting of jobs -  the thumbnail gets updated.

Fontmanager The Fontmanager manages fonts in databases. The

advantage of this method is that the database can be

copied from one computer to another and thus the same

set of fonts is available on both computers.

Full Surface Is a welding function, which underfills objects in one

color, whose surfaces overlap another. The partially

hidden objects are treated in a way, that they are

underlaying all overlying objects.

Hatching In this milling method the area, which should be

removed, is provided with a hatching. The area gets

removed along the hatching using the milling tool.

Hotfolder Management A folder can be defined as a so-called hot folder. All

output jobs that are stored in this directory are supplied

to the output.

Job Calculation The Job Calculation means a function with that
preliminary costing can be done easily. This function is

particularly well suited for calculating charges of material
costs.

Job Info The Job Info can - referring to each job - save additional

information such as order number, customer address,

material, time spent, a. s. o..

Job Rerun Any job that is still in the job history can be cut again

identically. The actual to the machine transmitted data is
stored. All parameters are given out into the output file.

Laser Engraver Name for all devices which don't use an engraving

needle but a laser unit.

 - This device type is supported by the software suite
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OptiScout. Full info at: www.optiscout.com

Layer Tab Is a sub-element of the Sidebar, with that layers can be

managed. Layers are color levels which determine and

control output order and tool parameters - besides object

position.

Material Display Each color layer can be assigned a specific material with

an exact material description. The assigned material is

displayed before the output in the Job Calculation, Job

Info and the layer itself.

Milling & Engraving This rubric lists the specific functions and tools which

were implemented for milling and engraving.

Monitor Output Process With monitoring, we mean that the output process can be

suspended, stopped and continued. Active jobs can be

switched to passive and if necessary be re-activated.

Multi Inline In this milling method the area, which should be

removed, is provided with multiple Inlines. The area gets

removed along the inlines - from outside to inside.

Multi Port Support With this we mean that all ports on a given computer -

which are suitable for the issue - can be used. Typically,

these are all COM and USB ports.

Multi User Versions
Available

For every main license multi-user version can be

purchased. The additional versions here have the same
serial number as the main license.

Multi-functional Cutter Multi-functional cutters are devices which can use

various tool heads beside a cutting tool head. They are,

for example, oscillating knives, spindles, and hemming

tools.

 - This device type is supported by the software suite

OptiScout. Full info at: www.optiscout.com

Multiple Cutting Option to cut easier thick and resistant materials

Node Editing Main tool for the creation and editing of vector objects.

Objects Tab Is an sub-element of the Sidebar with that objects can be

managed. A large number of object attributes such as
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visible / invisible, do not output, do not print, can be
individually defined for each object.

Open Trimming Is a welding function, which creates open vector objects,

after they were separated at their intersections.

Optimization Targets of the optimization are: diminishing of rejection

rate, material saving, time saving, optimization and

shortening of job preparation. The optimizing of objects

can be done on the working sheet or in the output

preview. The objects are sorted so that the material

consumption, without nesting of objects, is minimized.

Outline / Inline Outline is a special function, where vector object is

contoured automatically with a contour in a predefined

distance. In contrast to the contour line, the outline

creates - in case of internal objects - so called Inlines.

Parallel Device Output This function can simultaneously provide data on multiple

machines, which are connected to a computer, if

sufficient computing power on the PC is given.

PhotoCUT PhotoCUT is a program module which can convert

halftone drafts into vector stripes. The so generated

vector stripes can be cutted on each usual cutting plotter

and, generate - with the appropriate viewing distance -

one photo-like effect.

PhraseWriter The PhraseWriter is a program module for the
management and use of text blocks. It is automatically

started at startup and is accessible at any time using the
right mouse button context menu. The specified text

block is selected and then inserted and displayed on the
desktop.

Plot Manager The Plot Manager is a separate program module, which

'background' controls and monitors the output of the data

on the selected device.

Plot Server Function
(TCP/IP)

A computer at which multiple output devices are

connected can act as a plot server. The data transfer can
take place via the network using TCP / IP. Assuming the

appropriate licenses, any number of client computers can

give out on the plot server devices.

Plot to File The output of the plot data can be redirected to a file.
The user only has to activate the appropriate option in

the output dialog.
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Posterize Posterize is a bitmap function which performs a reduction

on any number of color hues per color layer.

Preview *.CDR and *.CMX The files tab can display besides *.JOB also contents of

*.CDR and *.CMX files (CorelDRAW formats).

Productivity Tools Productivity tools are special tools, which - because of

their workings - enhance the productivity of sign making

processes. These are usually such tools, which

distinguish a cutting software from illustration programs

such as Illustrator and CorelDRAW.

Program Type This section summarizes certain criteria which

characterize the use of the program.

Reference Job (*.JRF) In a so-called Reference Job the environment, the tool

parameters and the device drivers are stored. In this

way, it is possible to output the job in an identical manner

as many times as wished.

Register Mark Is a special drawing tool, with that marks, for the making

of multi-colored foil signages, are drawn. This register

marks can consist of a cut-through or a filled square and

are positioned by the user to the desired position on the

output job. While the output these registration marks are

always cutted at the same position on the vinyl

(layer independently), so then the precise assembly of

various colors is possible.

Roll Cutter Roll cutter means all cutting plotters, which can only
handle material rolls.

Screen Printing Is a welding function, which allows the changing of the

color stack. Thus, the order of the colored vinyls can be

re-sorted - interactively - from light to dark.

Segmentation with Overlap Segmentation is always necessary when the job is larger
i.e. longer or wider than the connected device is able to

plot. The overlap is necessary when the individual
segments are to be completed to a whole again. Joining

otherwise would lead to undesired white gaps.

Sidebar Sidebar means a movable control element that can be

made visible on the desktop. The individual sub-elements
are activated by clicking so-called 'tabs'.

Sort with Simulation In this function, all objects are sorted according to a

certain criterion. For some output devices such as lasers
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or milling machines the sequential processing of the
objects is important. Therefore, the output can be

simulated and the collation can be adapted to the

requirements of the output device.

Space (1/1, 1/2, 1/4, 1/8) Special function with that micro-typographical-correct

spaces (keyword: em quad) and thus word / letter

spacing can be generated. These special spaces can be

directly entered via the keyboard.

Spool Function When the Plot Manager is activated with the parameter

!SPOOL!, it runs independently without starting the main

program. Output data can be activated and given out via

Drag & Drop.

Spot Colors Definable Spot colors are color layers, which are defined in a way

that color values are additionally given out. Some hybrid

devices and RIPs use spot color values for the control of

output processes. When printing the corresponding color

plates are given out.

Stacking Stacking means that at first as many objects are

positioned adjacent as will fit on the material. The

following objects are then positioned above it. This

process is repeated until all objects are positioned on the

material.

Stand-alone Software "Stand-alone" means that this program can be used

without any other so-called host program. It has all the

tools that are needed for the design, layout, and the

output of jobs.

Start Tool Paths When milling and laser engraving it often happens that
immersion traces are visible at the start point of an

object. To ensure that the quality of the objects which are
milled is not affected, the start point can be laid outside

the object. This task is performed by so-called start tool
paths.

Status Display Material
Consumption

In the output preview at the bottom of the window is a

status line where the material consumption of the job is

displayed in square meters. Since this happens before

the output, this feature can also be used to order exactly
as much of a material as is required currently for the job.

Symmetrical Object This is a tool that can create stars and polygons. With it
the initial shape (circle, ellipse) and the number of edges

can be specified. With its own drawing tool then the
symmetric objects on the desktop are drawn.
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Templates (*.JTP) Templates or patterns are jobs which have no

name (untitled) when opened. Templates can always be

created if they can serve as an example for other similar

jobs. The advantage is that the working sheet and layout

are predefined.

Test Run Before the actual output a so-called test drive can be

carried out to examine whether, for example, the material

is sufficient. During the test run the raised tool head

moves along the vectors.

Text Editor Text editor means program functions that include all the

tools necessary for professional capturing and editing

texts. Typographic special tools that are essential for

signmaking were implemented.

Text Import (*.TXT, *.RTF,
*.ECT)

External texts can be imported directly into the so-called

text box, with the above formats being used. For

formatted text the RTF format must be used. It can be

saved from every professional word processing program.

Thumbnail Preview Thumbnails are small low-resolution pixel previews of file

contents. All in the selected folder located files will be -

by means of the thumbnail preview - visible and

manageable.

Tool Parametrization Means that specific settings for a tool can be done by the

user. This can be values for speed, drive, depth, angle,

pressure, acceleration or other parameters. The device

driver provides the parameter fields. The user can edit

corresponding parameter values before the output on the

device.

Tool Assignment To each color layer a specific tool can be assigned. This
makes creation and processing of jobs much easier. The

selected device driver provides all possible tools. The
assignment itself can be done by the user individually.

Track Logging For each tool the distance will be recorded. In addition,

the date, time and device names are stored.

Trimming Is a welding function, which separates closed vector

objects using lines or curves. The resulting partial objects

are re-closed then automatically.

TrueType, OpenType, Type
1, BE Fonts

These 4 font formats can be managed with the
Fontmanager i. e. add, enable and disable.
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URW BE Fonts The BE-type format was created by the company URW.

The BE-format is a vector font format that was shipped

with SIGNUS systems.

Vectorization, Tracing Vectorization means the conversion of bitmaps (pixel

images) to vector contours.

Video Marks (Print & Cut) Video marks are marks that can be detected by cutters

with optical sensors or cameras to compensate for

inaccuracies of the print result. In the print and cut

process they are used also for the contouring of print

objects.

Wait After Segment If a job has to be segmented, then the user receives this

option with the ability to re-equip the machine before the

next segment is processed. By means of a message

window the process can be continued at any time.

Weed-Ex Driver Option It is a specially laminated flex or flock material of Witpac

GmbH. First, the actual vector lines are cut. In the

second step, the components that need to be weeded,

are cut out in a way, that they 'fall out' automatically at

the end. So you have already reached the entire plot

result after peeling off the medium and you don't have

to weed manually.

Weeding Lines horiz. / vert. In addition to the global weeding frame, which is

generated around the entire output job, individual

weeding lines can be added horizontally or vertically in

the output preview. Large, bulky jobs can thus be

divided.

Welding Welding functions are needed for the treatment of

overlapping of layers or vinyls. These functions are in the
signmaking and screen printing department essential for

the processing of vinyls.
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C Glossary

Additive color system The ~ is based on mixing the additive, luminous spectral colors

red, green and blue (RGB), for example in color TVs or color

monitors

Adjustment Modification of the distance between two adjacent characters

so that a harmonic type face is being created. This is reached

by correcting the character - or word distance.  With distances

below 100% you speak of kerning and with values above 100%

of spacing out.

Adjustment handles ~ are the 9 black squares that are drawn around the object and

in the middle when marking objects.

Antialiasing Edge smoothing with bitmaps

Application tape Foil that is used to apply the cut foil after the weeding on the

lettering area. The adhesive force must be strong enough so

that the text - even the tiniest letters - can be released from the

substrate without problems. After application, the ~ must also

be released without problems. 

Ascender Term for the part of a character that extends above the middle

length.

Backup Data backup

Bit-depth also shade ~ is the mathematically possible number of colors with a

specific number of bits, for example:

1 bit color depth = 21 = 2 possible colors (black/white)

8 bit color depth = 28 = 256 possible colors/shades of gray

24 bit color depth = 224 = 16.8 millions possible colors

Bitmap Pixel-graphic

Bold Font that a bit thicker than the standard typeface.

Byte Smallest addressable unit in the computer memory, consisting

of 8 bits.

Calibration Adaptation of printer, monitor, cutter or adaptation to desired

values.

Cap height This is the height of the capital letters, the capitals. As
measurement usually the height of the letter „H” from the font

line to the top edge of the character is used.

Center justification A break justification where the text block is justified at the same

time on the left and on the right side. To do this, the word
space within a text line is varied (usually extended) so that on
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the left and right side a clean text edge is created. This is not
only applied for the the last line of a break.

compare also: forced block

Clipart(s) ~ are jobs or job parts that were added to the Clipart toolbar .

They are saved in a separate directory. (C:\Program

Files\EUROSYSTEMS\CoCut Professional XT\CLIP)

Clipboard ~ is used for temporary storage in Windows.

The ~ is used to exchange data fast between applications. 

CMYK Cyan, magenta, yellow, contrast (key, black) Standard colors

for the four-color printing.

CMYK-color area ~ is the total number of colors that can be displayed by the

colors used when printing (CMYK).

Color depth ~ is the number of possible color tones that can be recognized

by a scanner or reproduced on a color monitor.

Container A container - more exactly an image or text container - is a

vector object, that similar to a real container can take up

arbitrary image data or texts. In conjunction with macro scripts

contents can be exchanged semi-automatically or

automatically.

Context menu Context menus are called so because the structure adapts and

changes depending on the number and type of the selected

objects (context). Context menus are always activated with the

right mouse button. They serve for the faster access to

important functions and tools and also to those functions that

cannot be activated via the main menu.

Contrast Contrast; range of brightness between bright and dark parts of
a picture.

Cursor ~ is the blinking, vertical line in an editable field.

Decoration Accentuation of text parts by modification of the text attributes,
for example bold, italic.

Descender This is the part of a character that protrudes below the font line.

Desktop The area besides the working surface that can be used for the
draft. It is comparable to a desk on which are the tools.

Digitalization Conversion of a picture template into a digital form. The
capture is done point for point or line by line by means of a

digitalization tablet or by reading the template with a scanner.

Dongle
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Means the copyright that is part of the scope of delivery of
CoCut. It is inserted in the USB interface of your computer.

Without ~ the software cannot be started.

Download Downloading applications or files from the internet to your

computer.

DPI Acronym for Dots Per Inch; resolution fineness (1 inch = 2.54

cm)

EPS Acronym for „Encapsulated Postscript Format”. In this file

format the text and picture information is saved in the page

description language postscript. This format also contains

besides text and raster data also a preview bitmap which

allows displaying a copy of the data on the screen.

Foil Two production processes are common: calendaring and

casting. Cast foil is created without drawing frame and thus has

a lesser shrinking tendency. The costs are usually higher than

with calendared foil. Calendared is cheaper, has a shorter

period of usage and shrinks more.

Cutting foils are built in three layers:

1. Substrate; the lowest layer

2. Gluten layer; is between the foil and the substrate

3. the foil itself.

Font Type cut within a type face in digital form. Most type faces

have the fonts normal, bold, italic and bold-italic. Often, the font

is used for the same type face. Correct would be that each cut

is a separate font.

Font line ~ is a thought line on which the characters of a row are
standing. Even if different font types and font sizes are used

in a row, all characters must stand on a common font line.

Font size ~ is the size of a font. It corresponds to the block height, which

means it also comprises the ascender and descender as well

as a certain space above and below the characters. 

Forced justification Justification where all text lines - also the last- are adapted to

the width of the column or the working area. In CoCut this
justification is called „force justification”.

Gamma correction The ~ is a method for the correction of color graduation

considering the perception of the human eye if there are two

adjoining areas of different color.

Group Combination of arbitrarily many objects to a group. The
position of the objects itself does not change any more within
the group.
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Halftone image(s)  ~ are pictures which contain shades of gray or hues. The tonal
value between pure white and pure black is called halftone.

Hotfolder A Hotfolder is a directory monitored by the Plot-Manager. If a

file is copied into this directory, the Plot-Manager carries out

automatically specific configurable functions.

Inch Measurement unit for the length

1 Inch = 2.54 cm

Job File-ending of CoCut; name for CoCut file

Justification Alignment of a text block on the working area. CoCut offers

justification left-aligned, right-aligned, centered, center

justification, forced center justification and adjust cap height.

Kerning If two characters stand closer together than it would

correspond to their standard thickness, you speak of ~. With

character combinations as for example „Te” you have a

balanced type face.

Laminating Covering with transparent plastic films.

Live-Update Updating of software via the internet.

Macro A ~ automates program flows. The automation can thereby be

realized with the program's own commands or a macro

language.

Marking function ~ means marking objects by keeping pressed the left mouse
button, then drawing a frame around the objects to be marked

and letting go the mouse button only if all objects to be marked
are completely within the frame. 

Process colors Printing scale of colors for four-color-printing with cyan, yellow,

magenta and black (key). By mixing these colors, it is possible

to print all colors.

Profile The appearance of program surfaces is called ~. The shown
tools and menu items can be individually adjusted to the

user. Intention is to simplify the user interface.

Raster Image Processor short: RIP - Software that rasterizes vector data and controls

the printing on a large format printer.

Resolution Number of pixels per track unit. It is indicated in dpi (dots per
inch). Laser printers have a resolution from 600 to 1200 dpi.

Scan resolution Fineness of the resolution when scanning analogue images
Formula:
Resolution (in DPI) = printing length (L/cm) x 2 (quality factor) x
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enlargement factor x 2.54 (when converting from cm into inch)

Subsidiary line These are lines for the virtual alignment of objects on the

working area or the desktop. Subsidiary lines are only visible

on the monitor are neither plotted nor output on the printer.

Superscript The characters are set higher than the characters standing on

the baseline. They usually have a bit smaller font size than the

basic font.

Toolbar can be freely moved and positioned on the working area of an

application. Often, also the composition of the tools can be

defined.

Trapping A small overlapping zone at the limit of superposed colored

elements. This ~ guaranteed that no white gaps occur at the

color borders. The overlapping can happen through overfilling

or underfilling.

Upload Upload is the sending of files or applications to a networked

server

Weeding means the removal of unnecessary foil parts after the cutting

with a cutting plotter. 

White gaps ~ are the gaps on the edges of overlapping or abutting color or

foil areas. Disadvantageous especially with silk-screens or

when printing.

x-height Height of the lower case/character „x” respective the lower

case without the ascender of a font.
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Index

A

Access rights  62, 63

Active Jobs  139, 151, 189, 190, 191, 192, 195, 273, 276

Align  104, 117, 169

Always print black  87

Attributes tab  107, 241

Auto import plug-ins  273

AutoCAD  7, 31, 34, 35, 71

Automatic welding  68, 165, 178, 259

Automation  285

B

Backup  3, 5, 11, 282

BMP  41, 60, 111, 202

Break combination  101

Break group  100

Bridges  106, 241

Brightness  217, 283

C

Cap height  273, 282, 285

CDR  278

Character spacing  68, 178

Circular Text  273

Clipart  209, 244, 245, 246, 247, 248, 249, 250, 251, 252, 273, 283
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Clipart group  244, 247, 248, 249

Clipart tab  273

Clockwise  105, 170, 171, 174

Clone  71, 100, 158, 274

Close objects  106, 126, 154, 171

CMX  28, 60, 273, 278

CMYK  131, 217, 218, 283

Color graduation  52, 284

Color palette  124, 131, 132, 214, 218

Combine  100, 124, 154

Contour cutting  72, 243

Contour line  63, 66, 71, 73, 101, 111, 154, 163, 164, 165, 182, 183, 184, 274, 277

Contour pen  112, 273

Contrast  203, 208, 277, 283

CorelDRAW  7, 15, 26, 28, 32, 33, 71, 209, 273, 278

CoRUN  31, 32, 33, 34, 71, 140, 151, 152

Counterclockwise  105, 170, 171, 174
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